JSaS ‘ SAS Publishing H E N

SAS’ IT Charge Management 2.4

User’s Guide

The Power to Know,



The correct bibliographic citation for this manual is as follows: SAS Institute Inc. 2004.
SAS® IT Charge Management 2.4: User’s Guide. Cary, NC: SAS Institute Inc.

SAS® IT Charge Management 2.4: User’s Guide
Copyright © 2004, SAS Institute Inc., Cary, NC, USA

All rights reserved. Produced in the United States of America. No part of this publication
may be reproduced, stored in a retrieval system, or transmitted, in any form or by any
means, electronic, mechanical, photocopying, or otherwise, without the prior written
permission of the publisher, SAS Institute Inc.

U.S. Government Restricted Rights Notice. Use, duplication, or disclosure of this
software and related documentation by the U.S. government is subject to the Agreement
with SAS Institute and the restrictions set forth in FAR 52.227-19 Commercial Computer
Software-Restricted Rights (June 1987).

SAS Institute Inc., SAS Campus Drive, Cary, North Carolina 27513.

1st printing, July 2004

SAS Publishing provides a complete selection of books and electronic products to help
customers use SAS software to its fullest potential. For more information about our

e-books, e-learning products, CDs, and hard-copy books, visit the SAS Publishing Web site
at support.sas.com/pubs or call 1-800-727-3228.

SAS® and all other SAS Institute Inc. product or service names are registered trademarks
or trademarks of SAS Institute Inc. in the USA and other countries. ® indicates USA
registration.

Other brand and product names are registered trademarks or trademarks of their
respective companies.



Contents

Chapter 1 A Document Conventions i
About This Documentation

Using This Documentation
Technical Support

Chapter 2 A Introduction 3

SAS IT Charge Management: Overview

Relationships with SAS IT Resource Management Software E
Client/Server Components 5|

Target Audience |5

Chapter 3 A Getting Started 7]

Getting Started with SAS IT Charge Management: Overview E
Launch SAS IT Charge Management [

Run the SAS IT Charge Management Demonstration

Define a New Site in SAS IT Charge Management E

The ECEXITO0 Exit

The ECEXIT1 Exit

Change Site Properties

Customize SAS IT Charge Management

Chapter 4 A Site Administration [15]

Site Administration: Overview and Navigation
Site Administration Functions

Manage Site Defaults and Accounting Calendar
Execution Controls

Accounting Calendar

Invoice Schedule [22]

Default Currency [23]

Manage Customer IDs and Profiles

Customer Name Key Structures [25]

Customer Identification Routine

Customer Profile Information

Edit an Existing Customer Invoice Profile
Create a New Customer Invoice Profile
Assign a Customer Profile Key

Edit a Budget [32]

Manage Charge Item Definitions @l

Charge Item Properties @

Charge Item Groups

Open Interface



Debits and Credits

Import/Export

Extract Data Setup

Define PDB Default Adjustments

Common Shift Charges

Common Device Charges [53]

Common Processor Charges

Common Prorate Routine [55]

PDB Selection [55]

Manage PDBs

Define Rate Models, Charges, and Assignments
Activate Chargeback - Charge Items
Customer Assignment

Database Definition

Define Surcharges, Discounts and Prorating
PDB Shift Charges

PDB Device Charges

PDB Processor Charges

PDB Prorate Charges

Chapter 5 A Operation

Operation: Overview

Daily Processing

DATECHK Global Macro Variable
Update the Process and Reduce Tasks
Run the Process and Reduce Job
Detailed Status

Daily SAS IT Charge Management Administrator Tasks
Invoice Period End Processing
Manual Adjustments

Import Data

Consolidate Data

Edit Charges

Currency Exchange

Run Standard Invoices

Export Data
Extract File Download

Chapter 6 A Data Exploration and Reporting
Data Exploration and Reporting: Overview
Report Access

Data Selection

Data Exploration

Batch Reports

Execution Definitions and Destinations



Simple Invoices

Standard Invoices

To-Date Reporting

Site Configuration Report

Ad hoc Reporting

Use SAS IT Charge Management Data with Enterprise Reporter [100
Create Reports Using SAS IT Resource Management |105

Access Your Data with AccountView (106

Chapter 7 A Administrative Status
Administrative Status: Overview
Use SAS IT Charge Management Administrative Status [109

Chapter 8 A Maintenance [111]
Maintenance: Overview

Periodic Maintenance Application |111
Related Software Maintenance Effects |112
User Modifications |113

Appendix 1 A File Structures |117

File Structures: Overview

Site Common Libraries [118

Variables in EC_SC (Debit and Credit File) (119
Variables in the Consolidation Files [120
Variables in the PDB "E" Tables Files |120
CHGFMT

CIDESC

CUSFMT
CUSTCURR [122

CUSTORG

CUSTOCHG
CUST1CHG
CUST2CHG
DATETIME [125

DCDESC
DCEDATE

EOAUDID [126

EOCCURR [128

EOCHRGE

EOCITEM

E0CQTY

EOCQTY_S

EOCRATE

EOCTYPE

EOCUSTn (where n=1 to @)
EODAY



Vi

EOENDTM [134
EOINVSD
EOMONTH
EORMDL
EOSTRTM [136
EOYEAR [137
E1CHRGE
E1CRATE
E2CHRGE [138
E2CRATE
MACHINE
SHIFT

SWIT
PDB-unique Libraries [141

User-unique Libraries [141

Appendix 2 A Interface to CA-MICS
Interface to CA-MICS: Overview

Define the Variable(s) to the Data Dictionary
Convert Your CA-MICS

Run the %CPDDUTL Task

Glossary
Index [153]



CHAPTER

Document GConventions

About This Documentation 1
Using This Documentation 2

Conventions 2

Window Images in Documentation 2
Technical Support 2

Ahout This Documentation
The SAS IT Charge Management User’s Guide is a usage and reference text for the
SAS IT Charge Management product.
SECTION DESCRIPTION

Introduction provides an overview of the basic elements of SAS IT Charge
Management, its relationships with SAS IT Resource Management
software and MXG software, and a description of the intended
audiences for the SAS IT Charge Management User’s Guide.

Getting Started  describes how to launch SAS IT Charge Management.

with SAS IT

Charge

Management

Site describes administration functions.

Administration

Operation explains the operational processing methods.

Data covers data exploration and reporting.

Exploration and

Reporting

Administrative explains the use of SAS IT Charge Management Administrative
Status Status.

Maintenance provides maintenance instructions.

Appendix 1 describes File/Library Structures in detail.

Appendix 2 shows how to set up accounting codes in the style of CA-MICS in

SAS IT Resource Management to input into SAS IT Charge
Management key fields.

Glossary is a dictionary of terms used with SAS IT Charge Management.
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Using This Documentation

Conventions
The following conventions are used to display information in this guide:

Bold type identifies window items. Window titles appear in bold with initial
letters in uppercase type. SAS and SAS IT Charge Management
keywords appear in uppercase bold type.

Italic type is the style used for special terms defined in the text or the
appendices and to emphasize important information.

Monospace is used for SAS Code, scripting and JCL examples. Monospace is
also used to show the values of character variables in the text.

Window Images in Documentation

Window images are manipulated to fit the text of this user’s guide. The images on
your window can appear different from the ones in the user’s guide.

Technical Support

Please be sure you include the following information when you contact us:
O the version and release of SAS IT Charge Management you are using
0 the name and version of your operating system on the client and server
O the version and release of the following SAS products:
0 Base SAS software on client
Base SAS software on server
SAS/CONNECT software
SAS IT Resource Management MXG

O o o

O any error messages or output related to the problem.
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SAS IT Charge Management: Overview

The challenge of a chargeback system is to keep pace with the constantly changing
work environment, for example:

O multiple platforms

0 new technologies

0O distributed applications

O services

0 dedicated equipment.

A chargeback system must track and bill for these new resources while supporting
production procedures for all the traditional chargeback resources. New chargeback
methodologies need to be added quickly and without increased staffing.

SAS IT Charge Management software provides an open architecture to quickly
implement accounting for any measurement. With IT Charge Management’s interactive
client/server interface, administration is reduced to a fraction of the effort required with
traditional chargeback software.

Open Architecture

IT Charge Management enables you to implement whatever accounting methodology
best fits your environment. Features can be selected individually. Chargeback
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methodologies can be mixed. Chargeback items can be selected at your discretion and
identified based upon site-specific standards. And if your applications produce
measurement data, you can implement activity-based costing.

SAS IT Charge Management is a usage-based chargeback application that generates
charges by applying billing rates to selected resource consumption quantities. IT
Charge Management provides an intuitive and straightforward mechanism for
specifying which customers are billed, which resources they will be billed for, and which
billing exception conditions (charging qualifications) will be applied. IT Charge
Management lets you audit the origination and calculation of all charges and use a
primary currency other than the US dollar.

Extensive Data Sources for z/0S

SAS IT Charge Management for z/OS functions with SAS IT Resource Management
for z/OS. IT Resource Management invokes Merrill Consultants’ MXG macros to read
mainframe data.

Note: MXG currently supports more than 120 sources, essentially every data source
available. A

Extensive Data Sources for Open Systems

SAS IT Charge Management uses SAS IT Resource Management for Open Systems
to access UNIX and distributed network measurement data from HP-OVPA (HP
OpenView Performance Agent); Sun SunNet Management and Solstice; Aprisma
Spectrum; and IBM NetView for AIX.

The SAS IT Resource Management Generate Source Facility and Generic Collector
Facility are simple yet flexible mechanisms that can be used to add any other data
source to the system.

Data Sources for Windows

SAS IT Charge Management uses SAS IT Resource Management for Windows to
process data from data sources such as NTSMF.

Integration with Other SAS Software

SAS IT Charge Management utilizes a suite of SAS software solutions to provide a
seamless multi-platform data warehouse. The integration of IT Charge Management
with IT Resource Management software provides a superior computer measurement
repository, which includes an extensive list of data sources. The IT Charge
Management user interface functions as a single point of control for all supported
platforms by exploiting the power of SAS/CONNECT software.

The power of SAS/EIS is used by IT Charge Management AccountView to generate
interactive reporting. Several graphs and multidimensional reports are available for
exploration. Enterprise Reporter sample reports and data are distributed with IT
Charge Management. The sample reports show how IT Charge Management data can
be used to address data center management and customer needs.
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Relationships with SAS IT Resource Management Software

SAS IT Charge Management augments SAS IT Resource Management. SAS IT
Charge Management uses existing IT Resource Management utilities and exit points.
IT Charge Management adds new data tables to existing SAS IT Resource Management
Performance Data Warehouse data structures, making it seamlessly integrated into
existing IT Resource Management functionality.

Client/Server Components

SAS IT Charge Management has a user interface that significantly reduces system
administration time. Software maintenance is simple and straightforward. You can
tailor the system by means of window panels, which link to a relational structure of
system tables. Syntax errors are identified immediately upon entry, rather than at
some later point in processing.

The maintenance and administration of SAS IT Charge Management are handled
through a point and click GUI located on a personal computer running Microsoft
Windows. Server library updates are performed automatically by means of a SAS/
CONNECT session.

SAS IT Charge Management for Open Systems

SAS IT Charge Management for Open Systems utilizes a personal computer running
Windows as the client and the UNIX host system as the server.

SAS IT Charge Management for z/0S

SAS IT Charge Management for z/OS utilizes a personal computer running Windows
as the client and the z/OS host system as the server.

SAS IT Charge Management for Windows

SAS IT Charge Management for Windows utilizes a personal computer running
Windows as the client and a Windows Server platform as the server.

Target Audience

SAS IT Charge Management was designed primarily for the chargeback
administrator who has to "do it all". This means collect the data, apply the charges,
maintain customer information, know who to charge what and how much, generate
invoices and reports, enter supplemental charges, administer discounts, and so on.
However, at some sites these tasks can be distributed among several individuals. This
section describes how these tasks can be broken down and which sections of this user’s
guide are pertinent to each task group.
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Installation and Maintenance

The tasks performed for this function include the initial installation of SAS IT
Charge Management, the verification that the client runs properly on the personal
computer, and the verification that batch jobs or scripts run properly on the server.
Additionally, the individual or group performing these tasks can be responsible for the
application and verification of periodic maintenance.

The SAS IT Charge Management user’s guide sections that are appropriate for these
tasks are:

0 Introduction. Start with “SAS IT Charge Management: Overview” on page 3.

0 Getting Started. Start with “Getting Started with SAS IT Charge Management:
Overview” on page 7.

0 Maintenance. Start with “Maintenance: Overview” on page 111.

Chargeback Administration

The chargeback administrator is the primary user of SAS IT Charge Management.
The administrator selects the resources to charge for, defines new resources,
implements rates and rate modes, assigns profiles to customers, defines the accounting
calendar and invoicing schedule, and verifies the invoice and reports before they are
turned over to the end users.

The chargeback administrator should review the entire user’s guide.

Operations/Data Entry

The person or group that performs this function is responsible for running batch jobs
or scripts and for verifying that each job or script completed successfully. Additionally
this individual or group can be responsible for entering supplemental charges (debits
and credits).

The user’s guide sections appropriate for these tasks are:

0 Introduction. Start with “SAS IT Charge Management: Overview” on page 3.
0 Operation. Start with “Operation: Overview” on page 67.

End User Functions

The individuals who perform these functions are usually those being charged (data
center customers) or those in control of the resources (data center management). They
are interested in exploring the data and reviewing the reports.

Direct the end users to the following sections of the user’s guide:

0 Introduction. Start with “SAS IT Charge Management: Overview” on page 3.

o Data Exploration and Reporting. Start with “Data Exploration and Reporting:
Overview” on page 89.
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Getting Started with SAS IT Charge Management: Overview

Note: We are in the process of changing how we refer to the mainframe operating
system. During the changeover, you may see references to MVS, or 0S/390, or z/OS. A
The following sections cover these topics:
0 “Launch SAS IT Charge Management” on page 7
“Run the SAS IT Charge Management Demonstration” on page 9
“Define a New Site in SAS IT Charge Management” on page 9
“The ECEXITO Exit” on page 11
“The ECEXIT1 Exit” on page 13
0 “Change Site Properties” on page 14.

O o o o

A customization checklist is included in the “Customize SAS IT Charge
Management” on page 14 topic at the end of this section. It will walk you through the
steps required for SAS IT Charge Management to be operational.

Launch SAS IT Charge Management

Launching SAS IT Charge Management involves connecting to the server host
defined for the site you want to administer. You define the server location to SAS IT
Charge Management by means of the Site Selection dialog window in SAS IT Charge
Management. After the site is defined, follow the steps below:

1 If the server is on zOS, log off the server host to free any allocated data sets.

2 From the list in the Site Selection box as shown below, choose the site that you
want to work with. Then select to connect to that site. If you want to use a
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TCP/IP connection, you can connect to the server with SAS/CONNECT script. (For
more information about this, see the documentation for SAS/CONNECT in the
online SAS Help and Documentation.) If you want to set up a new site, see “Define
a New Site in SAS IT Charge Management” on page 9.

I
Site Selection 3| 5
MIMI-Help: To execute the IT Charge Management Demo,

IT Charge Management Demo double click it inthe list to your left. Single click any
test spawner other line to select that site to modify o administer. Click
(Unused, available to assion) the Open button to open a selected site for administration,
(Unused, available to assign) o doukle click & stte to open it for administration immecistely

(Unused, available to as=sign)
(Unused, available to as=sign)
(Unused, available to assign)
(Unused, available to assian) =l

Site Properties:

Open | Exit | Help |

3 You will be prompted for a logon userid and password for the site you selected. For
z/OS, the userid is the one for your TSO application that is specified in the SAS/
CONNECT script. For UNIX, the userid is the one for your UNIX machine that is
specified in the SAS/CONNECT script.

4 The first time a SAS IT Resource Management server host is selected for use with
SAS IT Charge Management (by selecting Site Selection), a new set of libraries
is created and populated on the server. These libraries contain the server specific
code and data for SAS IT Charge Management. The libraries are created and
loaded automatically. You will see boxes pop up on the client window showing file
transfer messages between the server and the client.

5 After the logon is complete, the SAS IT Charge Management main menu is

presented.
i
;I IT Charge Management Demo ilﬁl

EI fd~ Swloot P ne PH seiive]
User: sasmoh

Site Administration Manasge FOBs ] Operation Reports Administrative Status 1

Manage Site Defaults and Accounting Galendar

. Manage Site Defaults
and fAccounting Calendar Execution Controls: Parameters
for batch execution

MHanage Customer IDs
EIanl:l Profiles

regCalendar Definitions: Accounting
Ee=¥calendar and invoice schedule

Definitions

Currency: Select the default
currency for the site, now USD
i‘FﬂManagE Open

Interface Features

Define PDB

E\_ﬂﬂanage Charge |tem |
Default fidjustments |

Close Help
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6 If the server is on z/OS, the TSO userid that you use to log on determines where
your PDBs are stored. When a SAS IT Resource Management administrator
defines a PDB on z/0S, SAS IT Resource Management creates an entry identifying
that PDB in an internal table. IT Resource Management stores this table in the
SASUSER library. There is a unique SASUSER library for each userid. Thus, if
you use SAS IT Charge Management with a userid that has never accessed certain
PDBs, then those PDBs will not be listed in the Manage PDBs window in SAS IT
Charge Management.

Run the SAS IT Charge Management Demonstration

SAS IT Charge Management software includes a sample site. This site uses Windows
as the server and has a PDB with data from Windows servers. To access this
demonstration,

1 launch SAS IT Charge Management

2 on the Site Selection window, select the site called SAS IT Charge Management

Demonstration

3 select in the lower right corner of the window.

This enables you to explore all of the features and functions of SAS IT Charge
Management without having to load your data first.

Define a New Site in SAS IT Charge Management

Site Properties are only displayed after a site is selected from Select Site to
Administer or Define.

Note: However, if you select the SAS IT Charge Management demonstration site, no
site properties will be displayed. A

On the bottom half of the Site Selection window, you can specify the Site Properties.
Site Properties identify the server to the client. The Site Properties include the
following information on the server: SAS IT Resource Management data set high-level
qualifier, path or root directory, and the location of the site library you want to use. Site
properties for the client include your TCP/IP node name and SAS/CONNECT logon
script name for use with the site specified. After the prefix and site library are
specified, use to save the site information for use with SAS IT Charge
Management.

O Select Site: In the Select Site to Administer or Define selection box,
select an unassigned site name to identify a new site in SAS IT Charge
Management. [Unassigned sites are identified by the comment Unused,
available to assign.] The Site Properties section of the window shows the
Platform field.

A description of each of the fields in site Properties follows. The list of fields
differs depending on the platform you choose. The descriptions of two exit points
(ECEXITO0 and ECEXIT1) in the client/server connection are included in this list
as well.

0O Platform Field: If you select an unassigned site name, under Site Properties,
the Platform field appears. By selecting the Platform field, you are presented
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with a pull-down menu of the platform and connection-type combinations that are
available. Select the platform desired. That platform name will be used to fill in
the field. Depending on the platform you choose, you must specify different
information based on your server’s requirements. You might be requested to
provide a TCP/IP name or an IP address for your server in the TCP/IP Node field
or to specify an emulator short session name.

If you select MVS via Spawner, you are prompted to enter the Remote Host
Name and Port and the Logon Script Name fields.

JT=TEY
Site Selection 3 5

0 Mir-Help: To define a site, select the platform on which
IT Charge Management Demo = its IT Service Yision is located. Fields that describe the site's
test spawner properties will sppest. Fill inthose fields and click Save
Properties to store the defintion. Then you can administer or
(Unused, available to assign) examine the site by clicking the "Open Site” button.
[(Unused, available to assign)
{Unused, available to assign)
(Unused, available to assign)
(Unused, available to assian) =
Site Properties:

]j Bave Propetties |

Platform: [ x|

Open Exit Help

O Site Description: After the platform is specified, additional fields are displayed,

including Site Description. This name uniquely identifies the SAS IT Resource
Management data from a particular server installation that you want to use as
input to SAS IT Charge Management. The Site Description must be between 1
and 32 characters in length. It can contain embedded blanks. Leading and trailing
blanks are ignored.

O Remote Host Name and Port: You must specify the name of your remote host

along with the alias of the port for the spawner connection to MVS. The format for
this field is: remotehostname:port. This is an example of an entry for this field:
8390deva.mvs.company.com:5478.

Note: This field is only available if you selected a platform of MVS via
Spawner. A

O Logon Script File: You can specify the path and filename of your SAS/

CONNECT logon script. The SAS/CONNECT logon script sets up the SAS/
CONNECT environment for SAS IT Charge Management. You can use one of the
default logon scripts that are provided with SAS IT Charge Management or a
user-provided script. When you select this field, an Open File dialog box appears.
Use this dialog box to provide the location of your script, then select [OK].

If you selected the MVS via Spawner platform in the earlier step, the Logon
Script File field is optional. If you choose to use the script file, do not specify
the “nosasuser” option after issuing the command that executes SAS in your
remote system. This is an example:

type ‘‘ex ’'sasjtr.tso.clist(ads3)’ ‘‘; /* executeSAS in the remote system */
type ’* ' ' o(’‘dmr,comamid=TCP,noterminal,no$syntaxcheck’’)’ ' LF;

O IT Charge Mgmt Site Prefix: Specify the SAS IT Charge Management prefix

that you want to use on the server in the SAS IT Charge Management Site
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Prefix field. SAS IT Resource Management has two groups of libraries: libraries
common to the entire site and libraries specific to a PDB. If the server is on z/OS,
each of these groups of libraries has its own high-level qualifier. If the server is on
Open Systems or Windows, each has its own path. There is one Site group of
libraries per server installation of SAS IT Resource Management and one PDB
group of libraries for each PDB. The SAS IT Charge Management Site Prefix can
be the same as the SAS IT Resource Management prefix, but SAS IT Charge
Management does not require it to be the same as SAS IT Resource Management.

For example, if the server is on z/OS and the name of the SAS IT Resource
Management PDB that you want to use for chargeback has data set names that
begin with SASPROD.CPE.SMFPDB and your SITELIB is SASPROD.CPE.SITELIB,
then you specify the prefix as SASPROD.CPE.

Note: Neither quotes nor a trailing period is required. 2o

Press or select [OK]. The SITELIB line is filled in with the
prefix.SITELIB, for example, SASPROD.CPE.SITELIB. If you have trouble
determining your site prefix, please contact SAS Technical Support.

O IT Resource Mgmt Sitelib: After you specify the SAS IT Charge Management
Site Prefix, the SITELIB field is automatically filled in for you as prefix.SITELIB or
prefixpath / sitelib. If you have a different SAS IT Resource Management site
library that you want to use, you can overwrite the library name with the one you
want to use.

O Save Properties: After you are satisfied with your specifications, select
[Save Properties|. The list box in the upper left corner of the window shows the site
Description of the newly defined site.

o0 To specify additional sites, select another unused, available to assign line in
the list box and repeat the above steps.

The ECEXITO Exit

ECEXITO: The ECEXITO exit enables the SAS IT Charge Management administrator
to change any previously defined global macro variables. This exit is included before the
SAS/CONNECT signon. The most common use of the exit is to assign z/OS allocation
parameters to the global macro variables called ECLIBNEW and ECLIBMOD.

Here are some of the global macro variables that can be changed or tested in this exit.

0 The value of ECLIBNEW is the disposition parameter appended to LIBNAME and
FILENAME statements that allocate all new SAS IT Charge Management
libraries on the server machine (z/OS host). You can use it to add UNIT=,
VOLSER=, STORCLAS=, and DISP= parameters to the FILENAME and
LIBNAME statements that allocate SAS IT Charge Management libraries on the
server machine. You cannot use it to change the following: RECFM=, BLKSIZE=,
LRECL=, SPACE=. ECLIBNEW is a macro variable that is usually changed in
this exit by using a macro assignment statement, such as:

$LET ECLIBNEW=value;

0 The value of ECLIBMOD is the allocation parameter appended to FILENAME
statements that allocate temporary SAS IT Charge Management work files on the
server machine (z/OS host). ECLIBMOD is a macro variable that is usually
changed in this exit by using a macro assignment statement, such as:

$LET ECLIBMOD=value;

0 The value of ECS_P is the platform type that can be APPC, MVSEHLL, MVSTCP,
UNIXTCP, WINSC, or DEMO. The value comes from the pull-down menu for the
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Platform field on the Site Properties area of the Site Selection window. ECS_P
can be used in ECEXITO to limit the changes to a particular platform. ECS_P is a
macro variable that is usually tested in this exit by using a macro comparison,
such as:

$IF X&ECS P EQ XMVSEHLL %THEN %DO;..... ;
$END;

0 The value of ECS_SNAM is the site name that is exactly the name of the site as
listed in the Select Site list box (specified in Site Description under Site
Properties on the Site Selection window). ECS_SNAM can be used in ECEXITO0
to limit the changes to a particular site. This is a macro variable that is usually
tested in this exit by using a macro comparison, such as:

$IF X&ECS_SNAM EQ XCARY $THEN %DO;..... ;
$END;

o EC_DFMT is another global macro variable. The value of EC_DFMT is the SAS
date format you want SAS IT Charge Management to use. This format is used to
display date values throughout SAS IT Charge Management. Always specify the
complete format name (including the period). The default value of EC_DFMT is
DATE9. This global macro variable is directly assigned to a SAS date format, such
as:

$LET EC_DFMT=DATED.;

Since ECEXITO is included prior to the SAS/CONNECT signon, it can also be used to
set any necessary SAS/CONNECT options. Some sample option settings that might be
required for connections that use the APPC access method are:

options comamid=appc set appc_secure_prompt
set=appc_lu62mode mappc=32 remote=remotelu
set=luprefix sascon set=lufirst 01 set=lulast 30;

The default location of the exit is: drive:\[SAS Install
Path]\cpe\chm\ec\ecsite\ecexit0O.sas

Use the SAS editor or another text editor to update the contents of ECEXITO0.SAS.
The contents of ECEXITO0.SAS as shipped are:

/* ecexit0 point */
/* placement before connect signon */

The above code means that the default values are to be used. The default allocations
use no VOLSER, and the default UNIT is the same as the one that would be used by
default in any SAS FILENAME statement.

The example below assumes the server is on z/OS. In this example, the default value
of ECLIBNEW sets the disposition of the new libraries to NEW,CATLG, and the default
value of ECLIBMOD sets the disposition of the sequential work files to
MOD,DELETE,DELETE:

%let eclibnew=%STR(DISP=(NEW,CATLG));
%let eclibmod=%STR(DISP=(MOD,DELETE,DELETE));

Member ECEXITO0.SAS can be coded and placed in the ECSITE directory on the SAS
IT Charge Management client. The ECSITE directory default path is: drive:\[SAS
Install Path]\cpe\chm\ec\ecsite

Code parameters as they would be specified on a SAS FILENAME or LIBNAME
statement.

Here are examples of what ECEXITO0.SAS can be altered to contain:
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1 Adjusting z/0S Allocations for All Sites

This first example can be used for a SAS IT Charge Management installation
that either has only one defined z/OS site, or that has multiple z/OS sites defined,
which will all use the same values for ECLIBNEW and ECLIBMOD.

UNIT and VOLSER are added to the FILENAME and LIBNAME statements
for allocating SAS IT Charge Management libraries on the z/OS host.

/* ecexit0 point */
%let eclibnew=%STR(DISP=(NEW,CATLG)
UNIT=MYDISK VOLSER=DISK97);
%let eclibmod=%STR( UNIT=MYDISK VOLSER=DISK97 );
/* placement before connect signon */

2 Adjusting z/0S Allocations for Selected Sites

This second example can be used for a SAS IT Charge Management installation
that has multiple defined sites that are not all z/OS sites.

In this example, the macro variable ECS_P is tested to limit the changes to z/
OS sites only. z/OS sites at this installation use STORCLAS for file allocations.

/* ecexit0 point */

SIF X&ECS_P EQ: XMVS STHEN %DO;

%let eclibnew=%STR(DISP=(NEW,CATLG) STORCLAS=X);
%let eclibmod=%STR( STORCLAS=X);

3END;

/* placement before connect signon */

The ECEXIT1 Exit

The ECEXIT1 exit enables the SAS IT Charge Management administrator to send
commands to the server immediately after the connection is completed. This exit is
included after the SAS/CONNECT signon. The most common use of the exit is to
perform remote submits.

The default location of the exit is: drive:\SAS\cpe\chm\ec\ecsite\ecexitl.sas

Use the SAS editor or another text editor to update the contents of ECEXIT1.SAS.
The contents of ECEXIT1.SAS as shipped ares:

/* ecexitl point */
/* placement after connect signon, before first executable */

The above code means that the default is to do nothing.

Member ECEXIT1.SAS can be coded and placed in the ECSITE directory on the SAS
IT Charge Management client. The ECSITE directory default path is: drive:\[SAS
Install Path]\cpe\chm\ec\ecsite

Code that is to be sent to the server must be surrounded by RSUBMIT; and
ENDRSUBMIT; statements.

Here is an example of what ECEXIT1.SAS can be altered to contain:

Using Exits to Submit Code to the Server

This example can be used for a SAS IT Charge Management installation that
wants to send SAS system options to SAS running under the APPC server. The
options are passed immediately after signon.

/* ecexitl point */
rsubmit;
options noerrorabend s=0;



14 Change Site Properties A Chapter 3

endrsubmit;
/* placement after connect signon, before first executable */

Change Site Properties

Sometimes you need to change where a site’s libraries are to be stored or to update a
high-level qualifier part of a library. To make the changes:

1 launch SAS IT Charge Management

2 select the site you want to modify from the Select Site window’s list box and press

3 when the lower half of the window displays the Ssite Properties for the selected
site, move your cursor to the field that you want to change and make your changes

4 Select [Save Properties).

Customize SAS IT Charge Management

This customization section provides an overview of customizing SAS IT Charge
Management. The length of time that it will take you to complete this checklist
depends on the complexity of your environment and on the number of SAS IT Charge
Management features that you choose to exercise. Many features are optional or have
the most commonly used value specified as the default.

Steps for Customization are:

1 Complete the tasks under the Site Administration tab. (Start with “Site
Administration: Overview and Navigation” on page 16.)

2 Complete the tasks under the Manage PDBs tab. (See “Manage PDBs” on page 56.)

3 Execute one or more daily process and reduce steps. (For more information on this
topic, see “Update the Process and Reduce Tasks” on page 69.)

4 Execute a partial Invoice Period Consolidation using the steps under the
Operation tab. (Start with the “Operation: Overview” on page 67.)

5 Assign any charges that are currently unassigned. See the topic on Unassigned
Charges and Suspend Processing in the Operation section called “Daily SAS IT
Charge Management Administrator Tasks” on page 77.

6 Set up and run reports using the Data Exploration and reporting tab. (Start with
the “Data Exploration and Reporting: Overview” on page 89.)

7 Analyze results.
8 Repeat these steps until satisfied.
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Site Administration: Overview and Navigation

This section describes in detail how to administer SAS IT Charge Management by
using the Site Administration and Manage PDBs tabs on the SAS IT Charge
Management main menu. The order of this section follows the menu flow of the SAS IT
Charge Management client GUIL. Each tab is discussed in turn, along with tasks and

action items.

Navigation

The SAS IT Charge Management GUI has tab menus that reflect the major
functional areas of Site Administration, PDB Management, Operations, and Reporting.
Additionally, the Administrative Status tab displays a dynamic list of the activities
completed for each Site and PDB selected. The following functions are available on
many of the dialog boxes in SAS IT Charge Management:

Site Selection

PDB Selection

Display Status

About

Maintenance
Information

on the top left of the window enables you to change
the site you are working with. (See “Getting Started with SAS IT
Charge Management: Overview” on page 7.) Next to the button is
the name of the active site.

—
—

G

on the top left of the window (just below
Site Selection]) enables you to change or close the PDB you are
working with. (See “PDB Selection” on page 55.) Next to the button

is the name of the active PDB. If no PDB is active, No Active PDB is
displayed in gray.

This button takes you directly to the Detailed Status section. (For
more information, see “Detailed Status” on page 77.)

2|

The button with a scroll shows the "About" information for SAS
IT Charge Management.

B

The button with tools shows the latest maintenance status for
this SAS IT Charge Management client.



Close Site or
PDB

Help

OK

Cancel

Apply

Reset

Functional Area
Tabs

Menu

Sub-window
Task’s Action
Items
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Close

This button either closes the Site and disconnects you from the
server, or it enables you to deactivate the active PDB, after which
you can choose to activate another PDB or leave all PDBs
deactivated.

Help

This button displays a window from which you select information
specific to the SAS IT Charge Management topic you are looking at,
the About information, or topics from the SAS IT Charge
Management User’s Guide.

Ol |

accepts your changes and returns to the previous window.

Cancel |

[Cancel]removes your changes and returns the fields to the
previous values.

Apply

i

accepts your changes but does not return to the previous
window. This enables you to make multiple changes and see their
effects without leaving the dialog box.

FHeset

H

removes all changes and returns all fields to their default
values.

Site Adminiztration Manage PDBz

Functional Area tabs enable you to select the main operational
areas of SAS IT Charge Management. Selecting a tab moves that
tab and its menu to the front of the window.

. Manage Site Defaults
and Accounting Calendar

Menu buttons are on the left side of the Site Administration, and
Manage PDBs tab. Selecting a menu button causes the sub-window
on the right side of the current tab to be updated.

z =*Customer Name Key Structure:

=== 8pecify lengths and label=s of fields
|
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The sub-window is the right side of the Site Administration and
Manage PDBs tabs. The sub-window lists the action items for the
menu button that you selected. Selecting one of the task’s action
items takes you to a dialog box for that action item.

Site Administration Functions

The Site Administration tab is the first tab on the SAS IT Charge Management main
menu. If its contents are not visible, select the tab.

The Site Administration functional area is where you define and maintain all
operations and parameters that are either site-level defaults or that never vary across
the PDB environment. When you open a site for the first time, Site Administration
opens. (The Site Administration window follows the rules discussed in the Navigation

section.)
0¥ SAS IT Charge Management 1Ol x|
ﬂl IT Charge Management Demo zl@l
il e Swient PO, no PO aotived
User: sasmoh
Site Administration Manage PDBs I Cperation Repaorts Administrative Status ]

Manage Site Defaults and Accounting Calendar

. Hanage Site Defaults
and Accounting Calendar Execution Controls: Parameters
for batch execution

Manage Customer [Ds
EIand Profiles

fmajCalendar Definitions: Accounting
Ei=lcalendar and invoice schedule

E\_ﬂl‘lanage Charge ltem
) P
GBI (0G0t Currency: Select the default

currency for the site, now USD

i‘;ﬂl‘lanage Open
#| Interface Features

= Define PDB
f=iDefault Adjustments

Close Help

Manage Site Defaults and Accounting Calendar

[Manage Site Defaults and Accounting Calendar] is the top button on the left side of the
Site Administration tab. This area is used to specify parameters common to all PDBs in
the site (server installation of SAS IT Resource Management). The types of parameters
you can specify here are execution controls, JCL (z/OS only), fiscal calendars, and
invoicing dates.

Selecting [Manage Site Defaults and Accounting Calendar| changes the right side of the
tab to show a list of the action items you can perform. Selecting the menu selection
area for an action item takes you to the dialog box for that action item.

Execution Controls

Execution Controls is the first task under Manage Site Defaults and Accounting
Calendar. This task enables you to specify the location of the program that executes
SAS that you want to use on the server. If the server is on z/OS, the Execution Controls
window provides space for the additional information that is required for setting up JCL.
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If the server is on UNIX or a Windows platform, the Global Script Statements dialog
window displays:

i Eil_ SAS IT Charge Management Global Script Stateme o ] |

Host SAS Name: [li:isasisas.exe |

|' Ok Cancel Help |

Specify the name of the SAS program on the server (UNIX or Windows machine) that
you want SAS IT Charge Management to use. You do not need to specify an extension
or a path. If you do not want to save your changes, select [Cancel]. If you make a
change and want to save it, select [OK].

If the server is on the z/OS platform, the Global Script Statements dialog window
displays:

C® SAS [T Charge Management Global MYS JCL Parameters

Specify Global Default Parameters

Default Job Statement: Other Job
;;JDBNM’IE JOB (ACCOUNTING) Statements:
"
Fr% Report Job
FLH
£r¥ Caonsolidate Job ‘
SAS PAOC Name:  SAS SYS0UT= *
Work sPACE=( CYL ~| ,( 5§ .. 5 )

ITAMH Root Prefix: SAS.ITAN.
MXG Format Library: MYGUURR.LIBRARY
MXG User Source Lib MXGUWRR.USERID.SOURCL IB
MXG Source Library: MXGWAR.SOURCL IB
8A5 Macro Library: 5A5.5ASAUTOS

Specify Optional Data Set Allocation Parameters

Permanent Data Bets:

NGTCLASS= <- OR ->» UNIT= VOL=SER=
Tenporary Data Sets
MGTCLASS= <= 0R => UNIT= VOL=SER=
Ok | Cancel ‘ Help |

The purpose of this dialog window is to gather information about your z/OS
environment so that the JCL can be generated for various SAS IT Charge Management
jobs. The upper-right corner of the window shows the jobs for which the JCL parameter
values apply. If you want to specify parameters for a different job, select the button for
that job. When you are finished with your specifications, select [OK]. If you want to
return to the parameters that were displayed when you entered the dialog, select
[Cancel]. The following table shows each of the parameters on the window, descriptions
of these parameters, and the default values:
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Table 4.1 Table of Parameters

Field Description Defaults
Default Job Specify the job control cards exactly as No valid default.
Statement you want them to appear in the JCL.

CAUTION:
If the Job Statement is not valid
according to your site’s
standards, SAS IT Charge
Management will be unable to
proceed, often without a message
to that effect. ~

SAS PROC Name

The SAS procedure that you want the
job to use in the EXEC statement.

Defaults to SAS.

SYSOUT=

Output class for print.

Defaults to *.

Work SPACE=

Type and amount of primary and
secondary storage for work area.
Depending on the amount of data to be
processed, you can increase these values
from the default.

Defaults to CYL,5,5.

SAS IT Resource
Management Root
Prefix

The high-level qualifiers of the SAS IT
Resource Management software that you
want to use with SAS IT Charge
Management. Do not put quotes around
the value.

Defaults to SAS.

MXG Format
Library

Fully qualified data set name for the
library that contains the MXG SAS
formats. Do not put quotes around the
value.

Defaults to MXGuvrr. LIBRARY

where vv is the MXG version
number and rr is the MXG
release number.

MXG User Source
Library

Fully qualified data set name for the
PDS that contains your changes to MXG
source modules. Do not put quotes
around the value.

Defaults to
MXGuvvrr.USERID.SOURCLIB
where vv is the MXG version
number and rr is the MXG
release number.
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Field Description Defaults
MXG Source Fully qualified data set name for the Defaults to MXGuurr.SOURCLIB
Library library that contains the distributed where vo is the MXG version

MXG source modules. Do not put quotes
around the value.

number and rr is the MXG
release number.

SAS Macro Library

Fully qualified data set name for the file
that contains your SAS System macros.
Do not put quotes around the value.

Defaults to SAS.SASAUTOS.

MGTCLASS=

SMS Management Class specification. If
you specify this parameter, you can
neither specify UNIT= nor VOL=SER=.
If the value is specified, then the
parameter and its value are included in
the JCL.

The default is a null value (do
not specify).

UNIT=

Storage unit specification. If you specify
this parameter, you cannot specify
MGTCLASS=. If the value is specified,
the parameter and its value are included
in the JCL.

The default is a null value (do
not specify).

VOL=SER=

Volume serial specification. If you
specify this parameter, you cannot
specify MGTCLASS=. If the value is
specified, the parameter and its value
are included in the JCL.

The default is a null value (do
not specify).

Accounting Calendar

Calendar Defiitions is the second task under Manage Site Defaults and
Accounting Calendar. This window enables you to define a fiscal calendar that differs
from the Gregorian calendar. The derived fields of EODAY, EOMONTH, and EOYEAR
are stored as CLASS variables in the SAS IT Charge Management output files. An
additional variable, the Invoice Period Start Date, is added to the summarized files.

Note:

The Gregorian calendar is the default calendar. Similarly, by default, invoices

are produced monthly. Use the SAS IT Charge Management Accounting Calendar
window to adjust the accounting periods and invoicing schedules to the needs of your

organization. A

Define the fiscal calendar

1 Select Site Administration » Manage Site Defaults and Accounting
Calendar » Calendar Definitions

2 The following dialog window appears:
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I‘_;!'r SAS IT Charge Management Calendar Management - |E| 1[
4| fccounting Year 2004 || Mode: Set or Clear
Invoice Date
4| fccounting Period 4 || 1 2 3[4 5 6 7 8 9101112 13 14 15 Click on a date in
the areato
- March 2004 | April 2004 | May 2004 |m| set or reset that

day as an invoice
start date.

#u Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa Su Mo Tu He Th Fr Sa

Invoice start dates

Il 2 3 4 5 6 2 3 1] are highlighted in
7 B 910 11 12 13 4 5 6 7 8 910 2 3 45 6 7 8 reverse video, with
14 15 16 17 18 19 20 11 1213 14 15 16 17 910 11 12 13 14 15 an orange hackground
21 22 23 24 25 26 27 18 19 20 21 22 23 24 16 17 18 19 20 21 22 if inthe current
28 29 30 3 25 26 27 28 29 30 23 24 25 26 27 28 29 account period, or
30 31 with red background
if not.

Other days in the
account period named

inthe select button
Edit Periods and Years are highlighted with
black text on vellow

I Set Invoice Dates packground,

Set Invoice Pattern |

Ok Cancel Help

Use the left and right arrow keys to select the Accounting Year and Accounting
Period. If you plan to backload data from previous years, contact SAS Technical
Support to learn about additional considerations.

Select [Edit Periods and Years] to define the Accounting Calendar. After the
Accounting Calendar is selected, other buttons display that enable you to specify
the accounting calendar by specific dates or to select a predefined pattern.

If you want to use a predefined pattern, select [Set Year Pattern|. If any of the
standard year patterns are suitable, select the pattern name in the list. The
calendar updates automatically.

Otherwise, click in order to specify each period’s start and end dates
on the calendar that is provided. For more information, see the mini-help box on
the right side of the window.

Invoice Schedule

This facility enables the user to define an Invoice Schedule. The accounting calendar
dialog box is used to set the anticipated schedule for invoice generation. The schedule is
referenced as charges accumulate.

The invoice period variables are used to subset data for invoicing and reporting.

Tip: The dates specified in the Invoice Schedule are the dates that the invoice
periods end - not the dates on which the invoices are issued.

Note: By default, invoices are produced monthly. Use the SAS IT Charge
Management Accounting Calendar window to adjust the accounting periods and
invoicing schedules to the needs of your organization. A

Set the Invoice Schedule

1 Select Site Administration » Manage Site Defaults and Accounting

Calendar to display the following window:
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¥ Calendar Management = =] E3
4| Accounting Year 2002 |p| Mode: Set or Clear
Ivoice Date
| fccounting Period 1 [m| [l 2 2 4 5 6 7 8 91011 1235 34 3% Click on a date in
the calendar areato
set or reset that
4| December 2001 | January 2002 February 2002 Ibl day as an invoice
SuMo TulMe Th Fr Sa  Su Mo Tu Me Th Fr Sa  Su Mo Tu We Th Fr Sa gLy
Invoice start dates
1] Il 2 3 4 5 I 2 are highlighted in
2 3 45 6 7 8 6 7 8 910 11 12 3 4 5 6 7 8 13 reverse video, with
910 11 12 13 14 15 13 14 15 16 17 18 19 10 11 12 13 14 15 16 an orange background
16 17 18 19 20 21 22 20 21 22 23 24 25 26 17 18 19 20 21 22 23 if in the current
23 24 25 26 27 28 29 27 28 29 30 31 24 25 26 27 28 account period, or
30 31 with red background
if not.

Other days in the
it period named

- . in the select button

Edit Periods and Years are highlighted with

black text on yellow
background.

Set Invoice Pattern |

QK Cancel Help

2 Use the left and right arrow buttons to select the Accounting Year and
Accounting Period that you want to use.

Select [Set Invoice Dates] at the bottom of the window.

You can use [Set Invoice Pattern] to select an invoice schedule from a predefined
pattern list.

Default Currency

Description:

The currency task item enables you to choose a site-level currency. This
currency will be used to display initial currency values in various windows in the
SAS IT Charge Management client. It is used on all reports and data exploration
areas in SAS IT Charge Management, unless you override it in an invoice profile
or in a rate model. See “Customer Profile Information” on page 29 to specify the
currency at the profile level.

Default:
The default value is the U.S. dollar.
Location:

Select Site Administration » Manage Site Defaults and Accounting
Calendar » Currency

Activation:

1 Select the currency Default option. A scrollable list appears with all
currencies that are recognized by SAS IT Charge Management.
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=]
Select Currency

MYR - Malaysia, Ringgit =

HLG - Holland (The Netherlands), Guilder

HOK - Norway, Krone

HZD - New Zealand, Dollar

PHP - Philippines, Peso

PKR - Pakistan, Bupee

PLZ - Poland, Z2loty

PTE - Portugal, Escudo

ROL - Romania, Leu

RUR - Russia, Buble

S5AR - Saudi Arabia, Rival

5DD - Sudan, Dinar

SEK - Sweden, Krona

56D - Singapore, Dollar

SIT - Slovenia, Tolar

SKK - Slovakia. Koruna

THB - Thailand, Baht -

TRL = Turkey, Lira

TTD - Trinidad and Tobago, Dollar

TUD - Taiwan, Dollar =]
oK Cancel

2 Select the desired default currency from the list by clicking it. This highlights
the selected currency.

3 Select to accept the selection, or to keep the previously selected
default currency. Selecting either button returns you to the Site Administration
tab. The default currency is listed in the Currency option area on the right side
of the window.

Manage Customer IDs and Profiles

This functional area lets you maintain information that identifies customers. Select
Site Administration » Manage Customer IDs and Profiles to list the customer
definition tasks. The sub-window on the right side of the Site Administration tab
changes to list the action items for this area:

I® SAS IT Charge Management _I_I- jm] ll
ﬂl IT Charge Management Demo zlﬁl
il {4~ Seiset PUR. nu PEB avtivel

User: sasmoh

Site Administration Manage PDBs ] Operation Reports Administretive Status I

Manage Customer IDs and Profiles g Calendar

‘ Hanage Site Defaults
and ficcounting Calendar

Customer Name Key Structure:
pecify lengths and labels of fields

Elﬂanage Customer |Ds
and Profiles Customer ldentification Routine:

% Edit 8AS logic

E\ﬂﬂanage Charge |tem |
@%

Definitions

Customer Profile Information:
EIﬁdd . change or delete profiles
(Fﬂﬂanage Open |

Inter face Features

Define PDB
Default Adjustments

Close Help
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Customer Name Key Structures

Description:

SAS IT Charge Management maintains up to nine variables of character data
that can be used collectively as the primary component of the variable list on the
CLASS statement during table summarization. Each of these "customer keys"
(EOCUST1 - EOCUSTY) is a separate and distinct variable in the table
summarization key and helps to identify the customer. You can customize the
LENGTH and DESCRIPTION attributes of the customer keys. The AuDID field is
available for storing any values that might help in an audit trail. The AuDID
variable is kept on the SAS IT Charge Management files in the SAS IT Resource
Management Detail level only.

On the right side of the dialog box is a box labeled Number of Keys for
Invoicing. This box must contain a number from 0 though 9. The customer key
fields have a hierarchy. The higher the number on customer key field names, the
deeper the level of the hierarchy. For example, Key 1 is the highest level in the
hierarchy, and Key 9 is the deepest level of the hierarchy. Specify the level that
should be issued the invoices. Zero (0) in the box indicates that you do not want to
use the following standard features: customer profiles, budgets, invoice formats, or
charge item groups.

Note: The number specified in the box is used to build the key file which
contains all the values of all the keys encountered in the data processed. It is used
to populate the “assign keys” window when creating a new customer profile. A

Default:
The defaults are as follows:

Table 4.2 Default Table for Customer Name Keys

Field Length Description
Key 1 1 (undefined)
Key 2 1 (undefined)
Key 3 1 (undefined)
Key 4 1 (undefined)
Key 5 1 (undefined)
Key 6 1 (undefined)
Key 7 1 (undefined)
Key 8 1 (undefined)
Key 9 1 (undefined)
AUDID 1 Audit ID

Location:

Select Site Administration » Manage Customer IDs and Profiles »
Customer Profile Information

Activation:

1 Select Manage Customer IDs and Profiles » Customer Name Key
StructureThe Customer Name Key Structure window opens:
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~iaix]
Specify Customer Name Key Length and Description
Field Length Description Humber of keys
to use for
Key 1: e Division profile assignment: 2
Key 2: 12 Department
Key 3: 1 (undefined)
Key 4: 1 (undefined)
Key 5: 1 (undefined)
Key 6: 1 (undefined)
Key 7: 1 (undefined)
Key 8: 1 (undefined)
Key 9: 1 (undefined)
AUD 1D : 32 fAudit 1D

Ok | Cancel | Help |

2 For each key, enter the desired values for the length and description attributes.
(The key can contain up to 70 characters.)

3 Select to save your changes or to delete your changes.

Note: When you change a customer’s key structure (length or description), SAS IT
Charge Management only updates the data dictionary definitions for the “E” tables; it
does not delete any data from those tables. For example, if you were charging for table
SAPR3S, the EAPR3S table dictionary information would be updated, but the charge
data itself would remain intact in the dataset. SAS IT Charge Management will delete
all data and dictionary definitions for the ETRACK table and then will rebuild that table
to reflect any changes made to the customer name key structure by means of the GUI. A

Customer Identification Routine

Description:

Charge data comes from many sources and represents resources consumed by
data center customers. This task lets you specify how to assign chargeable
resources to those you bill. In some cases, the data center customers are internal
to the organization, while in other cases, such as with outsourcers, they are
external to the organization. Use of these resources must be mapped back to the
consumers in order that those identified can be billed. The key identification
routine is invoked during the generation of charges, which applies site-dependent
logic to populate the EOCUST1 - EOCUST9 customer key variables.

EOCUST1 - EOCUST?9 contents vary in length according to what is specified in
the Customer Name Key Structure window. The contents of each of these
variables also vary according to the data source. The macro variable CPTABLE
can be useful here because it enables you to determine the variables that can be
used to map resources back to their consumer. For example, “SMF type 30” data
on z/OS can contain information about TSO usage. CPU resources consumed can
be matched to the consumer by means of a TSO logon id. However, in a network
file, you need to map a terminal identifier back to the consumer by means of a
user-defined lookup table. If you have user-defined lookup tables or formats, refer
to the sample process and reduce jobs in the Operation section. (See “Update the
Process and Reduce Tasks” on page 69.)

Default:

The default routine contains comments only.

Location:

Select Site Administration » Manage Customer IDs and Profiles »
Customer Identification Routine



Activation:

Customer Name Key assignments are made by using SAS code. Assignments
can differ based on the SAS IT Resource Management table data that is being
used as input. You can test a macro variable called CPTABLE to determine the
SAS IT Resource Management table name. By default, the routine contains only
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comments. Within the comments is a sample routine. You can enter any valid SAS
code that can be placed within a DATA step. Cut and paste functions are available

while editing the routine.

Define the Identification Routine
1 Select Customer Identification Routine from the Manage Customer IDs

and Profiles task list. An Identification Routine Edit window appears:

Customer |dentification Routine Edit
00008 F*

00009
00010
00011
00012
00013
00014
00015
00016
00017
00018
00019
00020
00021
00022
00023
00024
00025
00026
00027
00028
00029
00030
00031
00032
00033
00034
00035
00036
00037
00038
00039
00040
00041
00042
00043
00044
00045
00046

Note:

£*

You may also set the walue of the SUSPEND variable to 0

or 1 in thie routine.

If vou set it to 1 then the

current observation will be put in the suspend file. If
the SUSPEND variable iz set to 0 then the record will be
processed normally.

The charge summarization wvariables have different names
depending on where the variables are referenced.

Location

Administration Panels
Charge Modification Exits

Name
Keyl=Key9
E_CUST1-E_CUSTY

Consolidation File and

Report Programs

EOCUST1-EOCUSTYI

Since the logic will vary with each SAS/ITSV file being
costed, the wvalue of the ITSV wvariable CPTABLE must be
tezted prior to applying identification logic.
the value being tested is converted to upper case.

Example:

%IF RCPTABLE EQ ZUPCASE(XJOBS) %THEN Z%DO;
PUT(SUBSTR(JOB,1,2),5CMPFMT.
PUT(SUBSTR(JOB,1,2),$DIVFMT.

E_CUSTI
E_CUST2
E_AUDID

SUSPEND=0;

ZEND ;

= 'JoB=" i 1JoB
*JESHUM=" | |JESNHR

Note that

ZELSE %IF ZCPTABLE EQ XUPCASE(XDASD) XTHEN %DO;
E_CUST1 = PUT(SUBSTR(DSNHLQ,1,2),$CHPFMT. );
PUT(SUBSTR(DSNHLA,1,2),$DIVFMT. );

E_CUST2
E_AUDID

ZEND;
RELSE %DO;
E_CUSTI
E_CUST2

= 'HLQ=" | IDSNHLQ
'VOLSER=" ! IVOLSER
'UNASS IGNED* ;
-UNASS IGNED  ;

functions and commands are available. A

2 Edit the identification routine. Add code here to assign values to the
Customer Name Key variables from the data in the SAS IT Resource

The SAS Notepad screen is displayed. All Preview Edit window

Management tables. If Suspend Processing is to be used, code the criteria for
setting the value of the EC_SUSP variable.

3 When you close the Identification Routine Edit window, the changes you

made to the routine are saved.

Data Suspend Processing

Suspend Processing is optional. The default is that Suspend Processing is
turned off.

The resource use identification logic can assign appropriate values to the
customer keys based only on known data values in SAS IT Resource

Management.

In many customer sites, the information that is used to assign values to the
customer keys is somewhat dynamic. This makes it highly probable that some
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customer keys cannot be correctly assigned. Thus, Data Suspend Processing
makes it possible for these unassigned values to be reviewed and correctly
assigned.

The suspend mechanism sets the variable EC_SUSP to zero immediately
prior to the macro call for E_IDRTE (identification routine). Immediately
following the identification routine and prior to entering the rate model test, a
check is made for EC_SUSP not equal to zero. If EC_SUSP is not zero, the
current SAS IT Resource Management observation is written to the suspend
file. The observation includes the additional field ECS_DSUS (date of
suspension). This field is automatically populated by SAS IT Charge
Management. If an observation is written to the suspend file, it is not written to
the SAS IT Charge Management revenue tables.

When the process and reduce job is run, data that goes into the suspend file
is placed into special tables. Tables that are parallel to all SAS IT Resource
Management tables being charged for are created. These tables are in the
ECSUSP library with the same name as the SAS IT Resource Management
table. They contain all of the same variables as the SAS IT Resource
Management table with the addition of two new variables: SU_INFO and
SU_DSUS. The variable SU_DSUS is the date the data went into the suspend
file. The variable SU_INFO is an audit character field. This field can be
populated in the identification routine. SAS IT Charge Management standard
reporting does not currently use it. The field exists for ad hoc reporting and
auditing purposes only. It defaults to a null value.

Currently, SAS IT Charge Management does not delete observations from the
suspend file that do not have matching criteria. The suspend file can become
very large and require cleaning. If suspend processing is turned on but
%ECPROCES is not run (after updating the identification routine), all the data
remains in the tables in the suspend file. Cleaning must be performed manually
outside of SAS IT Charge Management by means of a SAS session or batch job.
SAS IT Charge Management reports on suspend data by date. Data Suspend
Processing writes reports in the process and reduce job SASLOG. Samples of
these reports can be found in the examples of Suspend Reports located in “Daily
SAS IT Charge Management Administrator Tasks” on page 77. A macro is
provided to reprocess the suspended data into SAS IT Charge Management.
The macro is called ECPROCES. This macro is used in place of a job or script.

Example (z/0S)
e Sample ECPROCES Job for z/0S -——-—-————- ;
* This job reprocesses suspended data so that it can be ;
* added to the chargeback tables. ;
OPTIONS SASAUTOS=('SASCPE.MXG.V1409.USERID.SOURCLIB’
'SASCPE.MXG.V1409.SOURCLIB’
USRSRCE
SASAUTOS)

MAUTOSOURCE NOIMPLMAC ERRORABEND DQUOTE;
%INCLUDE ECSCNTL(ECSTART);
%CPSTART(MODE=BATCH,SYSTEM=Z/OS,

ROOT=SAS.R6V09.CPE,

PDB=SASCPE.PDBSMF.,

DISP=0OLD,

MXGLIB=SASCPE.MXG.V1409.LIBRARY,

SITELIB=SASCPE.SITELIB,

SITEACC=SHR,

MXGSRC=('SASCPE.MXG.V1409.USERID.SOURCLIB'
'SASCPE.MXG.V1409.SOURCLIB’));



Site Administration /. Customer Profile Information 29

¥ECSTART (SITEPFX=SASCPE,

PDBPFX=SASCPE.PDBSMF,
PROCESS=SUSPEND) ;

%ECSPROC; * Suspend data reprocessing;
%CMPROCES ( ,EXITSRC=ECSITE.ECEXITS2,

COLLECTR=GENERIC,
TOOLNM=SASDS,
GENLIB=ECWORK) ;

$CPREDUCE( ) ;

Data Suspend Administration

During each process task (%CxPROCES), data that meets the suspend
criteria is placed in a separate file. The list below explains how to administer
the suspended data.

1

Update the identification routine to activate Data Suspend Processing. The
resource use identification logic can indicate to SAS IT Charge
Management that a particular observation that was input from SAS IT
Resource Management must be "suspended" for later processing. This can
be accomplished by using criteria to set EC_SUSP=1 (or some other
nonzero value) when customer keys are not assigned correctly.

Run the SAS IT Resource Management process and reduce tasks
(%CxPROCES and %CPREDUCE). Verify that the job finished without
errors.

Review the suspend reports. If they indicate that 0 records were
suspended, no further action is required.

Review the suspend tables. View the tables in the ECSUSP library. (You
can use SAS procedures or other tools of your choice to view these tables.)
Look at the variables that were used to assign the customer key name
structure. Compare these values to formats and other criteria specified in
the identification routine.

Find out who the data should be assigned to. This can mean consulting
with another person or group to determine the proper assignment.

Update the identification logic (or SAS format) used in the identification
routine to recognize the new information so that it can appropriately assign
values to the customer keys. Launch SAS IT Charge Management and
then select Site Administration » Customer Information » Edit the
Identification RoutineMake the appropriate changes and select [OK].

Run %ECPROCES. This is a SAS IT Charge Management macro that
reprocesses the suspended data and enables the identification logic to
correctly assign values to the customer keys.

Steps 3 through 7 can be repeated as needed until the suspend reports
show 0 records suspended.

Customer Profile Information

A customer profile lists billing attributes for a given customer.
Select Site Administration » Manage Customer IDs and Profiles » Customer
Profile Information » Customer Invoice Profile Entry
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" SAS IT Charge Management Customer Invoic: o |EI|5|

.Specify Customer Invoice Profile Properties

Charge Item Group: [ SCH002: Chart of ficcounts by Platform x|

;| fredidemail .com
Phone:| 919-555-1212x3456
Fax:| 919-555-2121

Profile H 8 S O ti q
rofile Hame: [ [IS Operations ] Assign

Contact:| Fred Smith Keys

Email:

Address: [ Mega Corporation Edit

| US Operations Department Budget
| Building 7 Room 60398
i.d|

[Raleigh, NC 27603
ush

Currency: [ USD |

Format: [ Single Key

oK | Cancel | Help

The following functions are discussed below:

1
2

Edit an Existing Customer Invoice Profile
Create a New Customer Invoice Profile

3 Assign a Customer Profile Key

4

Edit a Budget.

Edit an Existing Customer Invoice Profile

To edit an existing customer invoice profile, complete the following steps:

1

Sl AW N

Select Manage Customer IDs and Profiles » Customer Profile
InformationA list of existing profiles is presented.

Select the customer whose profile you want to change.
Click to open the Invoice Profile Entry window for the selected customer.
Modify the customer information as desired.

Select to accept the changes, or to return to the previous settings.
The customer profile is updated and you return to the Select Invoice Profile.

Create a New Gustomer Invoice Profile

To create a customer invoice profile, complete the following steps:

1

Select Manage Customer IDs and Profiles » Customer Profile
InformationThe Invoice Profile Selection window opens which lists existing
profiles.

Note: If there are no existing profiles, SAS IT Charge Management opens an
empty Customer Invoice Profile Entry window immediately. You do not have to
click as in the following step. A

Click to open an empty Customer Invoice Profile Entry window.

3 Enter the customer information: Profile Name, Contact Name, Email Address,

Phone Number, Fax Information, Address, Currency, Invoice Format, and Charge
Item Group. At this point, you can:
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assign customer profile keys by clicking and
create or edit the budget by clicking [Edit Budget|.
Click or to return to the Customer Invoice Profile Entry window.

4 Then, click to accept the changes, or to return to the previous
settings. The new customer invoice profile is created, and you return to the Invoice
Profile Selection window.

Assign a Customer Profile Key

The SAS IT Charge Management Customer Profile Key Assignment dialog assigns
customer key values to a customer invoice profile. The values of the customer keys are
taken from a table built during the consolidation process. [For more information about
this, see “Consolidate Data” on page 80.] Thus, you must complete at least one process
and reduce and a partial consolidation before you can assign customer key values to a
profile. If this window does not have key values, make sure that the Number of Keys
to Use for Profile Assignment on the Customer Name Key Structure window is
not set to zero. [For more information about this, see “Customer Name Key Structures”
on page 25.]

Access the Customer Profile Key Assignment window from the Site Administration
tab by selecting: Manage Customer Ids and Profiles » Customer Profile
InformationSelect a profile that you want to work with and click on [Edit]. You can
also click on New to create a new profile. The SAS IT Charge Management Customer

Invoice Profile Entry window opens. Click [Assign Keys| to open:
=lolx|

Current Profile: US Dperations

Actions

Select Custome " For Current Pro

{availahle :loeneric. assionment.) i
T¢<blank> .| Assign
+=<blank> = pvailable
:ADVANCED TECHNOLOGY

(available
::2?3 | Unassign |

(available
SADVANCED VISUAL I2ATION

(Solution Lines
(available
(available
(available

(available T+=AVD

(available :APD-AS IA/PACIFIC DPERATIO For fAny Profile
(available T+=AP0

(Solution Lines APPL ICAT IONS .,IFDrl:e
(available 1 +=APP a\Unassign
(available t+=-APT

(available 1+-ETS

(available +=IPD

(available t+-LMR

(available +=MLD

(available 1 +-MNR

(available s+=NAP

(available 1 +-0RD

(available 1 +=8QC

A A et e e e A e At M At At A A et e A ot At o ot Mt b et

(available 1+-8ThA

(Solution Lines :BUSINESS SOLUTIONS DIVISI

(available +-AD

(available +-AS5

(available +-BSD

(available +-BST

(available +-CCD

(IT Service Vision and Charge Man):+-CPD

(available +-FAD

(available :+-HRS 1=

Ok | Cancel | Help

The top of the window shows the name of the Current Profile that is being used for
assigning keys. The current profile is the profile that you selected for Edit on the prior
window. A scrollable area displays a list of customer profile keys found in the
consolidated data. The left side of the area shows profiles currently assigned the key
value or the word "available", which indicates that the key value has not yet been
assigned to a profile. The right side of the area shows the key values in a hierarchical
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form. Customer Key 1 is represented by values that begin immediately after the "):"
while Customer Key 2 values are represented by values that begin after the string "):+-"
and so on. The number of Customer Key levels displayed here is determined by the
number specified in the box labeled Number of Keys to Use for Profile
Assignment in “Customer Name Key Structures” on page 25.

The right side of the window displays three actions items: [Assign Available| and
(both of which apply to the current profile), and which can
apply to any profile. Click to select one or more key values in the window. Selected
values are highlighted.

Note: To select multiple key values that are not listed sequentially, hold down the
key and click on the values you want to use. To select keys that are in a contiguous
group, hold down the key and click the first and last key values of that group. A

0O Assign Available

If you click on [Assign Available] without selecting at least one key value, nothing
happens. If you use the [Shift] key to select a group where one or more key values
are already assigned to another profile, those key values will retain the
already-assigned profile. They will not be changed to the new profile.

To force these key values to be changed, select the value and click on

[Force Unassign|. The key values will change from the existing (non-current) profile

to available.
o Unassign

The button enables you to change any key value from the current
profile value to available. You can select multiple profiles and click [unassign]|. If
there are key values that are assigned to a profile other than the current profile,
they will not be unassigned. These key values will keep the existing profile
assignment.

o Force Unassign

When you click [Force Unassign|, SAS IT Charge Management forces the
highlighted key value to be unassigned from the profile, whether or not it is the

current profile. The profile changes from its current value to available. If you
select a block of key values before you click this button, all selected key values will
have a profile key value of available.

Note: Changes made in this window are not saved until you click on the
Invoice Profile Selection window. This causes the table EC_PR in the library ECSITEH
(on the server) to be saved. A

Edit a Budget

To create a new budget or edit an existing budget, select on the Invoice
Profile Entry window.
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I'_‘il_ SA5 IT Charge Management Profile Budget E o =] |

Profile: US Operations [" Show active items

Budoet for Year: j

USD - United States of fAmerica, US Dollars

001001 Total page-ins XC | TRAN | 0| =
001002 Elapsed UDR cpu time for thread XC 1 TRAN | 0
001003 Database ifo-s XC | TRAN | 0
001004 Dedb calls XC |1 TRAN | 0
001005 Dedb read operations XC | TRAN | 0
001006 Data base deletes issued XC 1 TRAN | 0
001007 Data base inserts issued XC 1 TRAN | 0
001008 Data base replaces issued XC | TRAN | 0
001009 Database i/o duration XC | TRAN | 0
001010 Total d1/i calls XC 1 TRAN | 0
001011 Task cpu tch count XC | TRAN | 0
001012 Task cpu tch time XC | TRAN | 0

5]

Ok | Cancel Help |

In each profile, there is one budget amount per charge item and currency. All budget
amounts are annual amounts. Use the arrows to increment (or decrement) the year.
Budgets for current and future years are specified by means of the slider. Data entry is
manual only. Budget amounts appearing on invoices are year-to-date, with variances
reported against the year-to-date amounts. The way to tell SAS IT Charge
Management that a budget is not specified is to use a zero amount. The budget data is
kept in a separate table. Budget data is never permanently combined with
consolidation data. The files are combined temporarily for the generation of invoices
only. Keeping budget information is an optional feature of SAS IT Charge Management.

Before budget information is specified, the Accounting Calendar and the Invoice
schedule must be specified. The Show Active Items check box subsets the list of
charge items to those actively being charged for at this site. For the Show Active
Items check box to display the active charge items, you must select a PDB and that
PDB must have active charge items.

Note: Only the active charge items for the PDB are displayed. The active charge
items for the entire site, that is, for all PDBs, are not displayed. A

For more information on these topics, see “PDB Selection” on page 55 and “Activate
Chargeback - Charge Items” on page 57.

Manage Charge Item Definitions

The third menu button on the Site Administration tab displays the Manage Charge
Item Definitions tasks which enable you to update Charge Item Properties and
define Charge Item Groups.

The Charge Item Table contains the SAS IT Resource Management table name, SAS
IT Resource Management variable name, variable description, and default charge rate.
The table has a unique charge item identifier for each resource or service used for
billing.
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SAS IT Resource Management warehouses the data that it processes from various
sources that monitor, among other things, the workloads that take place on computer
systems. Many different kinds of activities are measured by the monitors that collect
data and input the data to SAS IT Resource Management, like batch, CICS, IMS, DB2,
UNIX accounting data, storage and so on. The data is stored in the SAS IT Resource
Management warehouse in conveniently sized packages called tables. Each SAS IT
Resource Management table contains measurements (or metrics) about the activity, and
many tables record the identification of the people or groups that submitted the
workload to the computer.

SAS IT Resource Management defines most of these data tables in a central location.
Then, operationally convenient groups of tables are allocated to be placed in the same
physical segments of the warehouse. These sets of tables are called PDBs (performance
databases), and the sum of all the PDBs is the SAS IT Resource Management
warehouse.

SAS IT Charge Management defines in a central location the set of all metrics in
SAS IT Resource Management tables for which it will permit charges to be
accumulated. SAS IT Charge Management calls each of these chargeable metric
definitions a charge item. In order to charge for a metric (or a function of one or more
metrics) in a SAS IT Resource Management table, you have to define a charge item in
the SAS IT Charge Management Site Administration tab.

To produce charges for the metrics you've defined as charge items, the tables
containing the metrics must be installed in a SAS IT Resource Management PDB. To
begin charging, the IT Charge Management administrator accesses IT Charge
Management PDBs, selects a PDB from the set of all PDBs that have been defined to
SAS IT Resource Management, and opens the Site Charge Item Definitions window. All
the charge items defined as having a source in the tables in the selected IT Resource
Management PDB are listed. The SAS IT Charge Management administrator selects
which items to charge for, and how much to charge per engineering unit of the metric
(per CPU second, per 1000 i/o operations, per track of storage, and the like).

Rate Models The rates applied to these metrics can change over time. The rates for a
common time period might vary according to the time of day, day of week, the processor
on which the work was done, or the user who requested the work to be done. For that
reason, SAS IT Charge Management enables rates to be applied by groups of
specifications called rate models. This is analogous to a hotel offering different rates for
rooms rented in different seasons, rates by the week, or giving different rates to the
general public, to groups like AARP, AAA, or to the hotel’s frequent visitor program.

Shift Differentials: SAS IT Charge Management enables shift differential charges or
discounts to be applied to selected charge item rates, so that rates might be varied by
time of day and by day of the week (according to the definitions of shift made to SAS IT
Resource Management). SAS IT Charge Management enables processor differential
charges or discounts to be applied according to which machine (for example, the batch
data MACHINE identifier) of a pool of processors of varying speed executed the work.
Finally, SAS IT Charge Management enables entire rate models to be defined such that
different rates might be charged for different groups of users, and the schedules of
those rates might advance on different dates.

Example 1

If there is no definition of a particular metric as a charge item, the SAS IT Charge
Management administrator must:

1 Add the table to a SAS IT Resource Management PDB.

2 Add the charge items for those metrics as a definition by means of the SAS IT
Charge Management Site Administration charge item edit function.
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3 Click [PDB Selection] to select the SAS IT Resource Management PDB in which the
table is installed. Click the Manage PDBs tab and select Charge Items from the
sub-window on the right.

Check the Act box to activate the new charge item.
Fill in a rate for which to charge.
Repeat 4-5 as many times as necessary if there are multiple charge items.

~N o o A&

Run the database definition utility job.

Example 2
If the charge item is already defined to the site, do items 1 and 3-7 of Example 1.

Example 3

If a charge item is active and charged for in a SAS IT Resource Management PDB,
and then the user installs another PDB with the same table and wants to produce
charges for the second PDB, do items 3-7 of Example 1.

Example 4

If new rates are to take effect on a given day, the SAS IT Charge Management
administrator has to:
1 Click [PDB Selection] to select the SAS IT Resource Management PDB in which the
table is installed. Click the Manage PDBs tab and select Charge Items from the
sub-window on the right.

2 Select the rate model that you want to change, and the latest effective date of that
rate model (for example, DEFAULT 25JAN1999).

3 Add a new rate model of the same name and a new effective date (for example,
DEFAULT 25APR1999).

4 Select additional charge items to be active as necessary, or select the charge items
whose status or rate changes.

5 Fill in the new rates that you want to charge.

6 Repeat steps as many times as necessary if there are multiple rate models or
charge items.

Charge Item Properties

Select Site Administration » Manage Charge Item Definitions
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E"!.— SAS IT Charge Management =lOl x|
ﬂl IT Charge Management Demo ﬂ g
EI £~ Swiect PO, no POE aciivel

User: sasmoh

Site Administration Manzage PDB= ] Operation Reports Administrative Status 1

Manage Charge ltem Definitions

. Hanage Site Defaults
and Accounting Calendar

$Charge Item Properties: fAdd, change
or delete charge items

Manage Customer IDs
EIant:l Profiles |

[z} Charge ltem Groups: Define groups
= of charge items for reporting

E\(ﬂﬂanage Charge ltem
v JDefinitions

ﬁ;ﬂﬂanage Open
“l Interface Features

Define PDB
iDefault Adjustments

Close Help

Select the Charge Item Properties task action item to display:

II'EI_ SAS IT Charge Management Site Charge |tem Definitio =1olx|
Table Entry Format: Click to Sort
tem # Table Variable I Description
Last Update Time | byuser
Click the Action Button to Edit/insert/Delste =
Action I 001001 XC I TRAN PAGE INS Total page-ins O
1BAUGT1996:22:21:13 42946289
Action | 001002 XC 1 TRAN STTCTMI Elapsed UOR cpu time for thread
20AUG1936:10:36:38 42328201
Action I 001003 XC I TRAN STTDEID Database i/o0-s
010CT1996:14.:00:54 42947341
Action I 001004 XC I TRAN STTDECL Dedb calls
{INIT)
Action I 001005 XC I TRAN STTDERD Dedb read operations
(MIT)
Action I 001006 XC I TRAN STTDLET Data base deletes issued
(INIT)
Action | 001007 XC I TRAN STTISRT Data base inserts issued
(INIT)
I |
Ok Cancell Help |

From the Site Charge Item Definitions window, you can perform these functions:
1 edit a charge item

2 modify the computation for a computed charge item (a variable whose name is
preceded by a C_or an X_)

3 delete an entry
4 clone an entry (non-computed items only)

5 insert a new entry.

Descriptions of these functions follow the Table of Charge Item Entries.
Charge Item Definition Table
Charge Item Definition table entries contain the following fields:
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Table 4.3 Charge Item Definition Table Entries

Field Description

ITtem # Unique numeric identifier called: Charge Item

Table SAS IT Resource Management Table this Charge Item is
derived from

Variable SAS IT Resource Management or user-defined variable name

Description SAS IT Resource Management or user-defined variable
description

Last update Date of last update to this Charge Item definition

By user Name of user who performed the last update

Note: Charge items whose names start with ¢_ are calculated in the normal course
of processing charges. X_ elements are calculated in the same way, but only after all
other data elements, including ¢_s have been assigned or calculated, and the totals for
all charges are available to the X_ charge items. Because of the way X_ charge items
are processed, they can be used to calculate maximum charges, minimum charges, or

volume discounts. A

Edit a Charge Item Definition

You can change the definition of any user-defined charge item. A charge item
whose definition is supplied by SAS IT Charge Management cannot be changed.
However, you can make a copy of a supplied charge item, then edit the copy.

1 From the Site Charge Item Definitions window, click the action button of the
charge item you want to edit. A pull-down menu of operations appears.

2 Select [Edit This Entry|. The fields that you can edit are highlighted.
3 Edit the fields as desired.

4 Click to accept the changes or to return to the previous definition.
The Charge Item table is updated.

Delete a Charge Item Definition

1 From the Site Charge Item Definitions window, click the action button of the
charge item you want to delete. A pull-down menu of operations appears.

2 Select [Delete This Entry]|. If the item is user defined, the item is immediately
deleted from the Charge Item table.

Copy a Charge Item

If you want to change calculations for supplied calculated charge items, you
must first copy the charge item to make a charge item with a different Charge
Item Number, and then overwrite the calculations that were supplied.

1 From the Site Charge Item Definitions window, click the action button of the
charge item that you want to copy. A pull-down menu of operations appears.

2 Select Clone This Entry from the pull-down menu. A duplicate of the entry
appears. The fields you can edit are highlighted.

Note: A Charge Item Number will be assigned. You can change the Charge
Item Number as long as the new number is unique. A

3 Edit the fields as desired and click [Enter].
4 Select to save the changes. The Charge Item table is updated.
Modify the Computation Routine



38

Charge Item Properties A Chapter 4

Sometimes there are charge items for which your site has particular
calculations. An example is to charge per 60 lines of print or per 100 pages of
print. These calculations require altering the Computation Routine. Variables
whose names are preceded by a C_ or an X_ are computed.

For computed charge items, you must specify code that puts a value in the
quantity variable. We recommend that code entered into SAS IT Charge
Management for computed charge items or for any routine be kept to a minimum.
Code can be entered into SAS IT Charge Management by means of macro
invocations or %INCLUDE statements which will access code from other locations
on the host (server) system. By using a INCLUDE, you can enter and maintain
such code using tools you are familiar with. The code that is to be included using
%INCLUDE statements or the autocall macro definition can be placed on the
server. If the server is z/OS, place the code in siteprefix.EC.AUTOS for z/OS. If
the server is on UNIX or Windows, place it in !sasroot/chm/EC/AUTOS or
SAS\CPE\chm\ec\autos, respectively.

1 From the Site Charge Item Definitions window, select the action button of the
computed charge item whose Computation Routine you want to change. A
pull-down menu of operations appears.

2 Select Edit Computation. A Computation Routine panel appears.

Note: The Edit Computation selection is available only when the selected
charge item is a computed charge item, that is, it begins with C_or X_. A
3 Edit the Computation Routine.

4 Select (close window) in the upper-right corner to close the window. The
Computation Routine for the selected Charge Item is updated.

Insert a New Charge Item Definition

Although SAS IT Charge Management provides many supplied charge item
definitions, there can be an occasion when the charge item that you require is not
supplied. Additional charge items can be added to SAS IT Charge Management
using any variable (or by using a formula based on any variable) that is available
in the SAS IT Resource Management table.

Additionally charge items can be defined for use with the SAS IT Charge
Management Import feature and for use with Supplemental Charges feature,
which enables the addition of debits and credits. In both of these cases, use a
meaningful table name and variable name for your charge item.

When you add charge items, they are automatically assigned Charge Item
Numbers beginning at 500,000. Each item that you add will have a number
incremented from this number. If you delete user-defined charge items, the Charge
Item Number is not reused.

You can change the Charge Item Number to any combination of six characters,
numbers, or national characters, except for the following: &,%,’, and ”. Leading
and trailing blanks are preserved.

1 From the Site Charge Item Definitions window, click any action button. A
pull-down menu of operations appears.

2 From the pull-down menu, select Insert A New Entry. A blank charge item
entry appears. The fields that you can enter are highlighted.

3 Fill in the fields as desired. If you specify a variable name with a prefix of C_ or
X_, you also need to enter the Computation Routine.

4 Click the (close window) in the upper-right hand corner to close the window.
The Charge Item table is updated.
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Charge Item Groups

Charge Item Groups enable you to add a hierarchical layer to the charge items for
rate model qualification and reporting. Usually groups are defined for functional areas
such as Network, TSO, or Storage. They can also be used to define a group of all the
charge items that constitute a unit of work.

Ii'il_ SAS IT Charge Management ;IEIEI

Select Arrow to Add, Delete or Edit an Entry
[ |SEI | |I'u'|udel | |Descriptiun |

|

[ = SCHO0Z Chart of fAccounts by Platform |

[ = SCHOO1 Default Charge |tem Group |

[ ==  SCHOO03 | XXX Group Hodel |

)24 Cancel Help |

When you select an entry on the Charge Item Group Model Selection window, a
pop-up menu opens that enables you to add a new entry or edit or delete an existing
entry. If you select Insert a New Entry and enter the description of the new group
model, the Charge Item Grouping window opens.

Note: By clicking on the group, you can choose any item from the pull-down menu
in order to edit the entry. A

I'_fil_ SAS IT Charge Management Charge ltem Grouping

Plldl-Help: Click & group or model line to add & group under that
structure. You will then be asked to azsign items to the new: graup.

Click To Add or Define Groups
[ECH002: Chart of Accounts by Platform] =

[+]-[GRPOOI(GROUF): CICS Charges]
[+]-GRP00Z(GROUP): DBZ Charges
[+]-[GRP003(GROUP): IDMS Charges
[+]-GRPOO4(GROUP): NS Charges
---|BFIP00?(BHI]UP): Batch Processing Chargel!
[+}-[GAPO1 1(GROUP): MUS Task Charges ange !
B TXJOBS __:C_CPUMIN: CPU Time Used| CAtAssignmentsFor This Entry

£..[500001:XJOBS __:C_EXCPK : DASD EXCPs in ‘9% Group UnderThis Entry
Expand Thiz Entry

Change Thiz Description

oK Cancel Help
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Open Interface

SAS IT Charge Management has an open architecture. Data can be imported or
exported, existing SAS formats can be used, or new user-defined SAS formats can be
created. ODBC compliance ensures an easy import from or export to all other ODBC
compliant applications, such as Microsoft Excel.

The [Manage Open Interface Features| button on the Site Administration tab of the SAS
IT Charge Management GUI has three action items. They are:

1 Debits and Credits
2 Import/Export
3 AccountView Data Extract.

The following sections discuss each of these action items.

Dehits and Credits

Description:

Debits and Credits provide the facility to make adjustments to your existing
charges, add one time discounts or surcharges, and supply data entry charges. If
you have recurring charges that require more than five to ten entries, consider
using the SAS IT Resource Management Generic Collector facility to create a table
to be used with SAS IT Charge Management.

Each Debit and Credit must be associated with a Charge Item Number. If the
supplied Charge Item Definitions are not sufficient to cover your Debits and
Credits, add new charge item definitions under Site Administration. In the
consolidation file, you can tell which charges were added as Debits and Credits by
testing the EOTYPE field. This facility is for manual data entry only. It is not
intended for recurring adjustments.

Note: For a list of variables that can be used with Debits and Credits, see
“Variables in EC_SC (Debit and Credit File)” on page 119. A

Default:

No debits or credits are defined.

Location:

You can access Debits and Credits by selecting the Site Administration tab from
the SAS IT Charge Management main menu, and selecting
[Manage Open Interface Features|. The first feature on the right is Debits and Credits.

Activation:

1 Access the Debits and Credits Entry window as described immediately above,
in Location to open:
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™= SAS IT Charge Management Debit and Credit Entiy - ||:| 5]

Specify Debit or Credit Information

& Credit
Amount:| . | Currency: [ USD ¥
+BFill Keys Effective Date:| 13nPR2004 Charge ltem: [ 999999 hd

Last modified by sasmoh at 13APR2004:11:32:08

Division: 00000000000000000000000000000000
Department: 000000000000

Ok Cancel Help

2 In this window, you can specify the following items: whether this will be a
debit or credit, a description and Charge Item Number for the debit or credit,
the amount (do not specify a negative amount), the currency (it will default to
the common currency selection), a date to which this debit or credit should be
posted, and the customers to whom this debit or credit applies.

Note: If you select credit, the amount you enter will automatically be
made negative by SAS IT Charge Management. You can see this on the Debit
and Credit selection window. An example of this window is included in Item
7 of this list. A

3 If you are unsure of the Customer Name Key values, select [Fill Keys]. The
Fill Keys function is available only after at least one process and reduce job
and one consolidation job have successfully completed. The Customer Key
Selection window opens which displays an interactive expandable and
collapsible listing of all known Customer Name Key values:

SAS IT Charge Management Debit/Credit Custd 5'

Left Click the Box to Expand or Collapse, Right Click to Select
O, a
IEHCustnmer keys for Site SAS PROD]

GO

E]—Iﬁ[:)UﬁNCED TECHNOLOGY |

:
[} /ADVANCED VISUAL IZATION]

[+HAPO-ASTA/PACIFIC OPERATID]
[+}{APPL ICATIDNS

[+}{COMP ILERS & TODLS]

[+}/[COMPUTER GRAPHICS]
[+}{CORE_DEVELOFHENT

[+}DATA CENTER
-|DﬁTﬁ WAREHOUSE TECHNDLOGY |

[+HD1SPLAY PRODUCTS DEVELOFM]

[+}EDUCAT 10N

[+}{EDUCAT 10N TECHNOLOG IES]

[+HEXECUTIVE

[+HFACILITIES

i JCTRI_C IRIAKMCT | I,:I
5

il

Cancel Help |
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Selecting any entry in this window causes a pull-down list to appear. The list
enables you to select the entry, expand or collapse the selection, or examine
another key. Right click on a value to select it. After you select a key value,
you return to the Debit and Credit Entry window.

When you are satisfied with your entries, select to save your changes.
Alternatively, you can select to remove your changes.

The debits and credits for the invoice period are automatically combined with
all other SAS IT Charge Management data when the consolidation job runs.

After adding debits and credits and leaving the data entry window, return
visits to the Debits and Credits window show another summary window. The
summary window lists all of the debits and credits. For each debit or credit,
the summary window lists the date posted, description, and amount:

_ioix
Select firrow to fidd, Delete or Edit a Debit or Credit
[ |Post Date | |Description | |nmount | |
[=—= 12APR2004 finother System Loop $12.95 | =
[ = 126PR2004 Printer Problem Caused Rerun $13.95 |
[ 12APR2004 Sy=tem Loop $-12.95 |
|

[[= 13APR2004 Z0T Printer Problem Caused Rerun $=-13.95

Ok Cancel Help |

From this window, you can select an entry to copy, edit, or delete, or you can
insert a new entry. Inserting a new entry takes you to the Debit and Credit
Entry window (shown above). After you are satisfied with your changes,
select to save your work. If you do not want to save your changes, select

[Cancel].

Import/Export

Import Data Definitions

Description:

This is an exit at which you can use the SAS System to import additional data
such as profile information. Any valid SAS code can be specified here. You can
code a data import exit or deactivate an existing data import exit.

Specifying an exit will activate the creation of a utility batch job or script. You
must submit the batch job or script for execution or add it to your scheduling
package.

Default:

No exits are specified.

Location:
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From the SAS IT Charge Management main menu, select Site Administration
» Manage Open Interface Features » Import/Export Definitions

Activation:
1 Select Import/Export Definitions as described above, in Location.
2 Select Code a Data Import Exit from the pull-down list.

3 The SAS Notepad screen is displayed. Enter your SAS code to import your
data.

4 When you are finished, select from the pull-down menu to save

your updates.

See also “Invoice Period End Processing” on page 79.

Import Template

Purpose

The purpose of this template is to help you code a data import routine for SAS IT
Charge Management. Most data is processed into SAS IT Charge Management from
SAS IT Resource Management. Occasionally, there is a need to process data into SAS
IT Charge Management on an infrequent basis or in very small quantities. In these
situations it might not be practical to load this data into the SAS IT Resource
Management data warehouse. In order to accommodate this need, SAS IT Charge
Management offers two features: data import (see “Import/Export” on page 42 and
“Import Data” on page 80) and supplemental charges (see “Debits and Credits” on page
40).

Both features add observations in the server SAS IT Charge Management library
ECDATAH. When z/OS is the server, this library is siteprefix. EC.DATA. On UNIX, this
library is /cperoot!/ec/data. On Windows NT, this library is
c:\sas\cpepathprefix\ec\data. In the ECDATAH library, the table, EC_SC, is used.
Supplemental charges are added manually through the SAS IT Charge Management
Client. When there is too much data to enter manually, the import feature can be used
in batch to load the data.

The import routine adds observations to the EC_SC table. The import routine reads
the input file, creates observations for EC_SC containing the variables listed below, and
populates those variables using the data in the input file as well as any necessary logic.
For a list of variables in the EC_SC table, see “Variables in EC_SC (Debit and Credit
File)” on page 119.

o DEBUG=Y or DEBUG=YES is available on the invocation of macro ECSTART to

turn on source for debugging.

SAS formats in ECSITEH.ECUSER are available.
Entries are made in Detail Status at the start and end of the Import process.
Old observations must be removed manually.

O o o o

Summarization occurs in the consolidation file. The EC_SC data set is not

summarized.

0 Currency and Charge Item Numbers are not validated. If the Charge Item
Number is not defined in Site Charge Item Definitions, it will not have a
description associated with it. Nor can it be assigned to charge item groups.

0 ECTYPE variable (charge type) is set to 0500 for imported data.

o Calculations for computed charge items are available as macros named according
to the following convention: The macros can be named %CXnnnnnn, where
nnnnnn is the 6-character name of the charge item. This formerly was restricted to
6-digit numbers in the range of 500000-599999, but now can be any alphanumeric.

o Consolidation takes input from all "ready" status PDBs and EC_SC to build the

consolidation file. The consolidation file is summarized but import data will have



44

Import Data Definitions A Chapter 4

ECTYPE=0500 and the ECTYPE variable is part of the summarization sequence.
Thus, summarized imported data can be viewed in the consolidation file.

Because quantity times rate equals charge, and rate is part of the key structure of
the consolidation files, supplemental charge and imported data should set rate to 1
and should set quantity to the charge in the appropriate currency. This will enable
mass-loaded data to summarize. If you set quantity to 1 and vary rate, you get

only slight benefit of summarization if you have large numbers of different charges.

The import template includes a PROC SORT with the NODUP option. This
procedure step is recommended to guard against the accidental inclusion of the
same data multiple times.

Steps to implement an Import routine:

1
2

[ IS ) B — N ]

17
8
9

Review your raw data.

Determine which of the above variables can be directly assigned and which need to
be derived.

Determine charge items.
Update Charge Item Definitions in the GUI. Update this section for import feature.
Make a copy of the import template.

Update the parameters for the ECSTART macro call. Use IMPORT for the process
parameter and leave the PDBPREFIX parameter as a null value.

Code the data input section to read the raw data file.
Assign values to all variables in the EC_SC table.

Generate the import job.

10 Ensure that you have a good current backup of SAS IT Charge Management site

data library. This library is called [siteprefix].EC.DATA on the z/OS server.
The library is called cperoot ! \EC\DATA on the Windows server and cperoot!/
EC/DATA on the UNIX server.

11 Run the import job.

12 Review the log for errors and review the output of the frequency procedures.

13 Review the contents of EC_SC. If the contents do not contain what you expect,

modify the import code and repeat steps 11 and 12.

14 Once you are satisfied with the results, move the generated import job to your

production scheduler so that it executes before the consolidation job.

Example

The IS department is providing service to verify a department’s Y2K compliance.
This is single occurrence billing. Time sheet data is kept in simple SAS data set. The
SAS IT Charge Management Administrator has defined a new charge item in the SAS
IT Charge Management client. The definition is as follows:

Item Table Variable Description

500005 IMPORT RESOURC Hours Worked

The input file looks as follows (only the first 5 observations are printed):

Div Depart Datetime Sysid Resourc Qty Rate
1 Corporate TSUP 14DEC1999:08:00 PROD HOURS 5 50.00
2 Corporate TSUP 14DEC1999:08:00 TEST HOURS 8 40.00
3 Corporate TSUP 15DEC1999:08:00 PROD HOURS 7.5 50.00

4 Corporate TSUP 15DEC1999:08:00 TEST HOURS 6 40.00
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Import Routine:

This sample import routine has *IN DATA** in the comments of all variables that
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come from the data input file. Other variables are assigned values in the import routine.
The SYSPARM value of AUTOINYV is used to place the data in the correct invoice period.

libname import 'e:\data\import’; /* input data */
filename ecscntl ‘c:\itsv\itcm23\ec\scntl’; /* server control lib */
libname ecsiteh ‘c:\itsv\itcm23\ec\site’; /* server site lib */
libname ecdata 'c:\itsv\itcm23\ec\data’; /* server site data */
/* Copyright 2000 SAS Institute Inc. */
/* Function: Template for Import routine */
/* (Puts the data into the same file as the debits and credits) */
/* Created: 08 Nov 1999 */
/* Changes: */
/* 2.30.0 00 Jan 2000 New */
options nodsnferr nobyerr novnferr yearcutoff=1950 sysparm=AUTOINVC;
%include ECSCNTL(ECSTART,ECLOG,ECGBLBAT,ECCFDT);
$ecstart (SITEPFX=c:\itsv\itcm23,
PDBPFX=, PROCESS=IMPORT, DEBUG=YES) ;
%global WRK_STDT WRK 2DT ecwork2;
data _null ;
if symget(’ecwork2’) eq ' ’ then call symput(’ecwork2’,’work’);
run;
%eclsgh;
/* loads site globals */
/* set invoice date from sysparm for subsetting */
geccfdt;
/* load data into SAS IT Charge Management work file */
DATA IMPORT (Keep=EOCCURR EOCHRGE EOCQTY EOCRATE E1CHRGE
E1CRATE E2CRATE E2CHRGE EOCITEM EOCTYPE
EQOCUST1 EOCUST2 EOCUST3 EOCUST4 EOCUSTS
EOCUST6 EOCUST7 EOCUSTS8 EOCUST9 EOINVSD
EOMONTH EOSTRTM EQOENDTM EORMDL EOYEAR
DCEDATE DCDESC MACHINE SHIFT DATETIME
SWIT )3

attrib
attrib
attrib
attrib
attrib
attrib
attrib
attrib
attrib
attrib

elOcustl
elOcust2
elOcust3
elOcust4
eOcust5
elOcust6
elOcust?
elOcust8
elOcust9
elinvsd

label="&ec_s_cdl"
label="&ec_s_cd2"
label="&ec_s_cd3"
label="&ec_s_cd4"
label="&ec_s_cd5"
label="&ec_s_cd6"
label="&ec_s_cd7"
label="&ec_s_cd8"
label="&ec_s_cd9"
label='Start Date

length=$&ec_s _cnl;
length=$&ec_s_cn2;
length=$&ec_s_cn3;
length=$&ec_s_cn4;
length=$&ec_s_cn5;
length=$&ec_s cné6;
length=$&ec_s_cn7;
length=$&ec_s_cn8;
length=$&ec_s_cn9;
of Invoice Period’
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length=8 format=date9.;
attrib eOccurr label=’'Charge Currency’ length=$3;

attrib eOcitem label=’'Charge Item’ length=$6;

attrib eOctype label=’'Charge Type’ length=$2;

attrib elcqgty label='Quantity’ length=8;

attrib elOcqty_ s label='SUM: Quantity’ length=8;

attrib eOcrate label='Charge Rate’ length=8;

attrib elcrate label='Modified Charge Rate’ length=8;
attrib e2crate label='Zero Balance Charge Rate’ length=8;
attrib eOchrge 1label='Primary Charge’ length=8;

attrib elchrge label='Modified Charge’ length=8;
attrib e2chrge label=’'Zero Bal Charge’ length=8;

attrib eOmonth label='Fiscal Month’ length=4 format=2.;
attrib eOyear label='Fiscal Year' length=5 format=4.;
attrib machine label='System id’ length=$8;
attrib shift label='Shift’ length=$1;
attrib datetime label='Timestamp’ length=8 format=datetimel9.;
attrib eOstrtm label=’'Start Time’ length=8 format=datetimel9.;
attrib eO0endtm label='End Time’ length=8 format=datetimel9.;
attrib eOrmdl label='Rate Model’ length=$16 format=$16.;
attrib dcdesc label='Description of Entry ’ length=$32;
attrib dcedate label='Effective Date’ length=7 format=date9.;
attrib swit label='Switch’ length=$1;
RETAIN SWIT ro

DCEDATE 0

DCDESC 'Import Data’

EOCUST1-EOCUSTY9 '

EOSTRTM 0

EQOENDTM 0

EOMONTH 0

EOYEAR 0

EQINVSD 0

EOCITEM r

EOCTYPE rr

EOCCURR rr

EOCRATE 0

EOCQTY 0

EOCQTY S 0

EOCHRGE 0

E1CRATE 0

E1CHRGE 0

E2CRATE 0

E2CHRGE 0

DATETIME 0

MACHINE r

SHIFT rr

WK_DTOPT 'DEFAULT '

WK_DOMSG 1
E_WKINV 0
WK_CHK "o’
doForce 0
i
/* bring in data using SET statement if input is a SAS dataset or using */
/* INFILE/INPUT statements if input is not a dataset that was generated by SAS.



SET import.impfile END=EOF;
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/* Assignment of SAS IT Charge Management variables from input

/* Your imported data or a derivation thereof must provide the values */
DCEDATE = today(); /* effective date for the data */
DCDESC = 'Hours for Y2K Project’; /* description of data imported */
MACHINE = systemid; /* Name of machine or cpu identifier *IN DATA**%*/
SHIFT =r1"; /* shift values */
DATETIME= datetime; /* date and time data was created *IN DATA***/
EOCUST1 = div; /* customer key 1 *IN DATA**%/
EOCUST2 = depart; /* customer key 2 *IN DATA**%/
EOCUST3 = ' ’; /* customer key 3 */
EOCUST4 = ' '; /* customer key 4 */
EOCUST5 = ' ’; /* customer key 5 */
EOCUST6 = ' '; /* customer key 6 */
EOCUST7 = ' ’'; /* customer key 7 */
EOCUST8 = ' ’; /* customer key 8 */
EOCUST9 = ' ’; /* customer key 9 */
EOCCURR = 'USD’; /* Currency name */
EORMDL = 'IMPORT ' !! PUT(EOINVSD,date9.); /* Rate model */
EOCTYPE = ’0500'; /* 0500 for imported data */

/* charge item must be in definition *IN DATA**%*/

if resourc = 'HOURS’ then EOCITEM='500005"';
EOCRATE = rate; /* rate to multiply against quantity*IN DATA**x/
EOCQTY = quantity; /* quantity for primary charge *IN DATA***/
EOCHRGE = EOCRATE*EOCQTY; /* charge calculation */
E1CRATE = EOCRATE; /* modified rate defaults to primary */
E1CQTY = EOCQTY; /* modified gty defaults to primary */
E1CHRGE = EOCHRGE; /* modified chrge defaults to primary*/
E2CRATE = EOCRATE; /* zero bal rate defaults to primary */
E2CQTY = EOCQTY; /* zero bal gty defaults to primary */
E2CHRGE = EOCHRGE; /* zero bal chrge defaults to primary*/

if n_ =1 then do; /* invoice date processing options */

E__WKDT="&sysdate"d;

E__ WKINV=input(put(E__WKDT,ECINVSD5.),5.);

end;
length E__WK20 $20;
E_ DATE=datepart (DATETIME)

’

E__ WK20=put(E__DATE,ECYRMN11l.);

if E_ WK20 eqg "G" then doj;
EOMONTH=month(E__DATE);
EOYEAR=year (E__ DATE);
EODAY=day (E__DATE);

end;

else if E__WK20 eq "*" then doj;

/* error */ end;
else do;

EOYEAR=input (substr(E_ WK20,1,4),4.);
EOMONTH=input (substr (E__WK20,5,2),2.);

EODAY=E__DATE-input(substr(E__WK20,7,5),5.);

end;

EOINVSD=input (put(E__ DATE,ECINVSD5.),5.);

*/
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if WK_DTOPT = "DEFAULT" then do;
if EOINVSD LT E__WKINV then do;
if WK_DOMSG then do;
WK_DOMSG=0;
put 50*"*"/

" Data has been processed for invoice period " EOINVSD DATE9.
" This data has been forced into period " E__ WKINV DATE9. /

50%"*",;
end;
EQOINVSD = E__ WKINV;
end;
end;

else if WK _DTOPT = "NATURAL" or WK_DTOPT = "FORCE" then do;

WK_CHK = PUT(EOINVSD, OCFMT.);
if WK_CHK = "C" and not doForce then doj;
EQINVSD = E__ WKINV;
end;
else do;
if WK_DOMSG then do;
WK_DOMSG=0;
put 50%"x"/
" Data has been forced into the invoice period "
" You must re-run consolidation for this period."
50%"*";
end;
end;
end;
else do;
ABORT ABEND 17; /* Invalid value for WK_DTOPT */
end;

/* the following code checks for a quantity - if there then

EOINVSD DATE9.

/

*/

/* write out the observation. If the rate or charge is zero the*/

/* observation is still written out. */
if EOCQTY ne 0 and EOCQTY ne . then DO;
output import ;
OCNT+1;
END;
ELSE DO;
CNT+1;
PUT '====> OBSERVATIONS WITH QUANTITY EQUAL TO 0 OR MISSING' _ALL_
END;
IF EOF THEN PUT ’'====> TOTAL RECORDS USED FOR APPENDING TO EC_SC: '
RUN;

%let conby = machine eOcustl eOcust2 eOcust3 eOcust4 eOcust5

elcust6 elOcust7 elOcust8 elOcust9 shift
e0citem e0rmdl eOctype elOccurr elcrate ;

proc sort data=import;
by &conby run;

/* create a new working copy of the EC_SC file */
DATA EC_SC;

/

OCNT=;
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SET ECDATA.EC_SC
IMPORT;

run;

/* sort combined file with nodup option to avoid duplicates if */

/* same data is added more than once. */
proc sort data=ec_sc nodup;

by &conby;

run;

/* show what the file looked like before the update */
Proc freq data=ecdata.ec_sc;
tables eOctype*elOcitem /* list missing;
title 'Frequency of ec_sc before Import’;

run;

/* show what the file looked like after the update */
Proc freq data=ec_sc;

tables eOctype*eOcitem / list missing;

title ’'Frequency after Import Data added’;

run;

/* uncomment below when happy with the code above */
Data ECDATA.ec_sc;
set ec_sc;

run;

$eclog(event=IMPORT: Data Import Complete,site=&ecs_spfx);

Export Data Definitions

Description:

This is an exit at which you can specify SAS code to export SAS IT Charge
Management data to other applications such as Microsoft Excel or a general ledger
package. Valid SAS code can be specified here. You can also code a data import
exit or deactivate an existing data import exit.

Specifying an exit activates the creation of a utility batch job or script. You must
submit the batch job or script for execution or add it to your scheduling package.

Default:
No exits are specified.
Location:

From the SAS IT Charge Management main menu, select Site Administration
» Manage Open Interface Features » Import/Export Definitions

Activation:

1 Select Import/Export Definitions as described immediately above, in
Location.

From the pull-down list, select Code a Data Export Exit.

3 The SAS Notepad screen is displayed. Enter your SAS code to export your
data.
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4 When you are finished, select from the pull-down menu bar to
keep your updates.

See also “Invoice Period End Processing” on page 79.

Extract Data Setup

Description:

This window enables you to create extract files to download to the client from
the server to pass to AccountView. It also enables you to create extract files to
download to the client from the server to pass to Enterprise Reporter. (This
information applies to Enterprise Reporter for SAS 8.2 only). In this window, you
can specify which variables you want to include on the AccountView extract file.

Note: If you specify only those variables that you need, you can reduce the file
size. A

CAUTION:
Do not download the extract files unless the consolidation job has run successfully. A

The extract files are not created until the consolidation completes. After the job
is complete, you can download the extract files from the Operations tab.

Date and currency formats used in AccountView are specified in
ECLIB.ECUSER.ECXTRCT.SOURCE. This SAS IT Charge Management client
source entry is used during the regeneration of the consolidation job. The source
entry contains ATTRIB statements assigning formats to various variables.
AccountView uses the formats assigned here. Update the formats on the ATTRIB
statements to reflect your choices.

Default:

The AccountView Data Extract and the Enterprise Reporter Extract are not
created.

Location:

From the SAS IT Charge Management main menu, select the Site
Administration tab. Then select Manage Open Interface Features. Next select
Extract Data Setup.

Activation:

1 Access the Extract Setup window as described immediately above, in
Location.
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Eir SAS IT Charge Management Extract - ||:||5|

Division x .ﬂ".h' Extract
Department Disabled
x ER Extract
Disabled
Ok Cancel Help

Select the keys that you want to include in the AccountView extract file. You
can select one key by clicking it. You can select multiple keys by holding
down the shift or control button on your keyboard while you are selecting the
keys with your mouse.

Click the button that is on the right side of the window to toggle between
Extract Enabled and Extract Disabled. If you want to create the extract
file, select the button so that it shows [Extract Enabled]. If you do not want to
create the extract file, select the button so that it shows [Extract Disabled].

Select to save your specifications, or to return to the previous
specifications.

For information about using AccountView for your reports, see

“AccountView” on page 94. A

Define PDB Default Adjustments

Define

PDB Default Adjustments is the menu button on the bottom left of the

Site Administration tab. It enables you to make charge adjustments common to all

PDBs in a
the left of

server installation. When you select it, the task list in the sub-window on
the Site Administration tab lists action items that describe the types of

adjustments you can make.
To adjust:

o Shift
CPU

Charges, select “Common Shift Charges” on page 51.
Processor Normalization, select “Common Processor Charges” on page 54.

o
O Proration, select “Common Prorate Routine” on page 55.
o

Device Definitions, select “Common Device Charges” on page 53.

Common Shift Charges

Description:

The Common Shift Charges action item enables you to define a shift discount or
surcharge for any shift identifier defined in SAS IT Resource Management. This
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kind of chargeback methodology serves to encourage or discourage the
consumption of a data center resource, based upon the shift during which the
resource is utilized.

To implement a charging methodology that includes shift discounts or
surcharges, you can enter charging factors for any applicable shifts. The charging
factor is called a shift multiplier.

The Common Shift Charges task enables you to define a Multiplier for any
charges that fall in a specified time period. The multiplier can generate an
additional charge or surcharge to, or an additional discount or reduction of a
regular charge.

Note: If the multiplier is less than 1, then when the charge is multiplied by the
multiplier, a discount is generated. For example, suppose the multiplier is 0.95
and the charge is then the value 0.95y. The resulting discount is (1-0.95y)=0.05y
or a 5% discount.

If the multiplier is greater than 1, then when the charge is multiplied by the
multiplier, a surcharge is generated.

If the multiplier is 1, which is the default, then neither a surcharge nor a
discount is generated. A

Shift charges are generated as additional observations in the detail “E” table
data. All variables are the same as the original observation with the exception of a
few variables: EOCTYPE, EORATE, and EOCHRGE. EOCTYPE is set to “0100”.
EORATE is the product of the original rate and the shift multiplier. EOCHRGE is
the product of the adjusted rate and the quantity. You can update the common
shift discount and surcharge specifications from the Site Administration menu,
[Define Default PDB Adjustments|. You can update the PDB-unique shift discount and
surcharge specifications from the Manage PDBs window,

[Define Surcharges, Discounts and Prorating].

Default:

All shift multipliers are set to 1.00, so they have no effect on the charges.

Location:

Select the Site Administration tab from the SAS IT Charge Management main
menu. Select [Define Default PDB Adjustments|. The sub-window on the right is
updated. Select the Common Shift Charges area. The resulting window enables
you to specify shift multipliers. Depending on your specifications, this button
changes to [Common Shift Charges: Currently Not Defined |or
[Common Shift Charges: Currently Defined|.

Activation:

The Common Shift Charges task enables you to select shift charges common to
all PDBs, or to indicate that you do not want shift charges. The two lists below
show in detail how to activate each choice.

Common Shift Charges
1 Select |Define Default PDB Adjustments| from the Site Administration tab.

2 Select Common Shift Charges. The Site Global Shift Charge Definitions
window appears:
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iBix
Specify Charge Multipliersz For Each Shift Code: 0 to 999.999
Multiplier:
1 1.500 Surcharge of 50.0%
2 1.000 Mo shift charge
3 0.800 Discount of 20,0%
4 1.000 Mo shift charge
5 1.000 Ho shift charge
B 1.000 Ho shift charge
7 1.000 Ho shift charge
g8 1.000 Ho =shift charge
9 1.000 Ho =shift charge
0 1.000 Ho =shift charge
Reset | (8124 | Cancel | Help |

3 The values are common to all PDBs, unless overridden by using the Manage
PDBs tab. Enter a charging factor in the Multiplier field. Factors greater
than 1.0 generate shift surcharges. Factors between 0 and 1.0 generate shift
discounts.

4 To accept the shift charging definition, select [OK]. To return to the
shift-charging implementation without accepting any changes, click [Cancel].

5 After you make your selection, you return to the Site Administration tab. Notice
that the functional menu area to the right now says Common Shift Charges:
Currently Defined.

6 For each PDB that uses the Common Shift Charges, activate the PDB. Then
select the Manage PDB tab. Select the [Define Surcharges, Discounts and Prorating)|
button and then the PDB Shift Charges action item. From the pop-up menu,
select Common Shift Charges.

Note: If you do not visit each PDB and make this selection, no proration
will occur. A

No Shift Charges

1 Select the Common Shift Charges option from the sub-window as described in
the Location section of the Common Shift Charges topic. (See “Common Shift
Charges” on page 51.)

2 Change all multipliers to 1.00 by selecting [Reset].

3 To accept the changes, select [OK]. To return to the shift charging
implementation without accepting any changes, select [Cancel].

4 After you make your selection, you return to the Site Administration tab. Notice
that the button text of the menu area to the right now says Common Shift
Charges: Currently Not Defined.

Common Device Charges

Description:

The Device Definitions option enables you to map various devices to a functional
group. For example, z/OS printer devices map to either a functional description
such as "LASER," "FICHE," "IMPACT", or a charging qualification value such as
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"BILLABLE" or "NON BILLABLE". This table is maintained as a Common Device
Definition or as a PDB Device Definition. (See “PDB Device Charges” on page 64.)
You can use any valid SAS code to group various devices. Within the comments is
a sample definition. This task does not generate adjustments. It only permits
groupings of character variables to be stored in the table.

Default:

There are no device definitions specified. As distributed, this routine contains
only comments.

Location:

Select Site Administration from the SAS IT Charge Management main menu.
Select [Define Default PDB Adjustments|. The sub-window on the right is updated.
Select the [Common Device Charges| area to specify a device definition exit.

Activation:

1 Select the Device Definitions option from the Site PDB Defaults menu.
The Device Definition Exit window opens.

2 This window enables you to use any valid SAS code to group your devices. By
default, this exit contains only comments. Within the comments is a sample
definition. You can use this routine to group devices such as printers, storage
devices, and network devices. Various SAS IT Resource Management tables
contain variables, such as device address or LU name, to test for grouping.

3 When you complete the definitions, select (window close) in the
upper-right corner. Notice that the button text of the menu area to the right
now says [Common Device Charges: Currently Defined|.

Common Processor Charges

Description:

The Common Processor Charges option enables you to specify a normalization
factor that is applied to accumulated CPU time statistics so that a normalized
CPU time quantity can be calculated. The normalization factors are
machine-specific and facilitate a billing methodology for CPU time that is
equitable across processor hardware configurations.

Note: For UNIX systems, the number of CPUs must also be considered. A
Default:
No processor normalization.

Location:

Select Site Administration » Define Default PDB AdjustmentsFrom the
sub-window on the right, select the Common Processor Charges action item. It
enables you to code a Processor Normalization exit that is used for all PDBs unless
it has been overridden by PDB-unique Processor Charges.

Activation:

1 Select the Common Processor Charges option as described, in Location. The
Processor Normalization Routine Edit window opens.

2 This window enables you to use any valid SAS code to normalize processor
time. By default, this exit contains only comments. Within the comments is a
sample definition. Enter your SAS code here. The MACHINE variable

contains the server identifier.
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3 When you complete the definitions, select (window close) in the
upper-right corner. Notice that the button text of the menu area to the right
now says [Common Processor Charges: Currently Defined|.

Common Prorate Routine

Description:

The Common Prorate Routine task enables you to apply and maintain control
parameters and proration specifications either at the Site level (common to all
PDBs) or at the PDB level (unique to the active PDB). The structure of the
proration specification table enables multiple output fields to be re-populated by
the proration process.

Default:
No proration.
Location:

Select Site Administration from the SAS IT Charge Management main menu.
Then select [Define Default PDB Adjustments|. From the sub-window on the right,
select the menu selection area called Common Prorate Routine. The Common
Prorate Routine enables you to specify a proration exit that is used for all PDBs
unless overridden by the PDB-unique Proration Routine. (For more information,
see “PDB Prorate Charges” on page 65.)

Activation:

1 Select the Common Prorate Routine option as described immediately above,
in Location. The Proration Routine Edit window opens.

2 This window enables you to use any valid SAS code to define the proration
routine. By default, this exit contains only comments. Within the comments
is a sample definition. Enter your SAS code here. This exit is called during
consolidation.

3 When you complete the definitions, select (window close) in the
upper-right corner. Notice that the button text of the menu area to the right
now says [Common Prorate Routine: Currently Defined].

PDB Selection

Each server installation of SAS IT Resource Management has one or more PDBs. In
SAS IT Charge Management, there is only one active PDB at a time. If there is no
active PDB, click and the PDB Selection window opens:

SAS IT Charge Manag

@ IT Charge Management Demo
LI c:litom 2.4\chm'ececdeno,

Uzer : sasmoh

Iiil_ SAS IT Charge Management PDB Selection =101l
Click Hame to Administer the PDB, Status to Change Status
{ PDB llame |
I=|
c:hitem 2.4chm'echecdeno, Ready ]

Cloze Help |
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A list is presented of PDBs accessed in SAS IT Resource Management by your user
id. The list shows the prefix of the PDB and its SAS IT Charge Management status. If
you select a PDB, by clicking the PDB prefix, SAS IT Charge Management assigns
librefs for that PDB.

When you select a PDB for which the SAS IT Charge Management Status is
Ready, the ECDICT and ECPDB librefs are assigned.

The librefs are automatically defined and assigned depending on the selected PDB’s
platform. Occasionally, you might see messages about files being transferred from one
platform to the other. The messages appear briefly, if at all, and indicate how many
bytes have been transferred and how many more need to be transferred. After all
assignments complete, SAS IT Charge Management displays the Manage PDBs tab.

Click the status area for your PDB to open a pull-down menu.

EEI_ 5A5 IT Charge Management PDB Selection =10l x|

Click Mame to Administer the PDB, Status to Change Status

[ PDB Hame |

c:hitem 2.4 chm\eclecdemo’, P-—d..
Set status to:

- Unprepared

- Neads Administration

- Test [will Mot Congalidate]
- Ready [will Conzolidate]

Close Help |

You can change the status of the PDB by selecting an entry from the pull-down
menu. The initial Status of any PDB in SAS IT Charge Management is Unprepared. If
you want to use the PDB with SAS IT Charge Management, selecting the PDB causes
the Status to be updated from Unprepared to Ready. After you have selected the PDB,
you can activate the chargeback feature for the selected PDB. To do this, you must
activate charge items (see “Activate Chargeback - Charge Items” on page 57.)

o If the PDB has a status of Ready, but no charge items are activated, no charges
will be incurred.

0 Needs Administration is a Status you set in order to make the PDB temporarily
unavailable for updating in SAS IT Charge Management.

0 A Status of Test enables you to use the PDB in SAS IT Charge Management in all
tasks on the graphical user interface except those that use consolidated data. A
PDB with a Status of Test does not get its data incorporated into the consolidation
file. However, at the various SAS IT Resource Management PDB levels, there is
data for this PDB in the SAS IT Charge Management files.

Manage PDBs

After you select the PDB that you want to work with, the menu on the Manage PDBs
tab opens:
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=il
ﬂl IT Charge Management Demo ﬂﬁl

il c:hitem 2.4%chm'\echecdenc’,
User: sasmoh

Site Administation Manage PDBS Cperstion Reports Acdministrative Status ]

Define Rate Models, Charges and Assignments

Charge ltems: Rate models

Define Rate Models,
I . $ for applying charges

Charges and fissignments

@ Def ine Surcharges,

B Cust Assi t: Assi
Discounts and Prorating ustomer nssignnen ssign

customers to rate models

§Eﬁxa.>€:az€z€3s'a Control ] Speoify HUE
=i noh owooudion sonbrais

~Data Base Definition: Submit
the batch dictionary update

Close | Help |

For the selected PDB, you can specify what resources you want to charge for, how
much to charge for each resource, and any criteria that affects charging for the
resource. If you specify at least one resource to charge for in a PDB table, you activate
chargeback for that PDB table in SAS IT Charge Management. Optionally, you can
define PDB-unique adjustments. If you defined Common Adjustments, you can override
those adjustments with a PDB-unique definition. (For information on defining Common
Adjustments, see “Define PDB Default Adjustments” on page 51.)

Define Rate Models, Charges, and Assignments

This is the top menu button on the Manage PDBs tab. Selecting this button updates
the sub-window on the right side of the tab with the actions items that you can perform.

Activate Chargeback - Charge ltems

Note: Before you run the daily data processing job, make sure that at least one
charge item has been activated in the rate model. Otherwise, the data processing job
will fail. A

A charge item entry includes the charge items that are qualified and uniquely named.
The unique name for a set of charge items that have been qualified is a Rate Model. In
SAS IT Charge Management, a Rate Model has a two-part identifier: a description and
an effective date.

1 Select [Define Rate Models, Charges, and Assignments| from the Manage PDBs
window. The action item list in the sub-window on the right is updated.

2 Select charge Items from the sub-window to open the Rate Model Charge Item
Selection window:
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I'_fil_ SAS5 IT Charge Management Hate Model C| = |EI|1|
FDB: ec:%item 2.4%chm'ec'\ecdemo®

Display Rate Model:  [DEFAULT-01JAN1960 | w| Display Table: | |
Set currency: LI

Entry Format, Click Header to Sort

ModelDate | temz |  Table |  varable |  currencymate |  sort Active First | ‘
=

DEFAULT 006009 XJOBS CPUTH usp ENEEIITIY T Normlz CPU
01JAN1960 |V Act Total cpu time captured v Shift Chg
DEFAULT 006012 XJOBS 10MDASD usp [ITTFEITY T Mormlz CPU
01JAN1960 |V Act Connect time dasd [V 8hift Chg
DEFAULT 007004 XPRINT TOL INES UsD [IIIIEETIY ™ Normiz CPU
01JAN1960 v Act Total print lines or print records ¥ Shift Chg
DEFAULT 006001 X.JOBS COSRBTH M oL ooooseos [ §

01JAN1960 [~ Act Task cpu srb time v

DEFAULT 006002 X.JOBS CI1TCBTH PR O OOOUOs0D
01JAN1960 [ Act Tazk cpu tcb time

<]

DEFAULT 006003 XJOBS CPHPTTH LM 0. ooouonos [
01JAN1960 [ Act Hiperspace processing cpu time v
DEFAULT 006004 XJOBS CPIIPTH G o ovooene [
01JANT969 [ Act /o interrupt cpu time v
=
ik Cancel Help |

3 By default, the table is in order by item number. To sort the table by another field,
select the desired field in the Entry Format portion of the window.

4 Activate or deactivate charge items for the active rate model by toggling the Act
check box. For each charge item that you activate, you can set the following
criteria to influence the generation of charges for that particular item:

Rate model

Shift charges

Rate

Normalization for CPUs

The following functions can be performed:
Apply Shift Charges to Selected Entries
Select the shift Chg check box to apply shift charges to (or clear shift charges

from) the selected charge item. Shift charges are defined in the Definitions areas
of “Common Shift Charges” on page 51 or “PDB Shift Charges” on page 62.

1 Scroll down to the charge item that you want to apply shift charges to.
2 Toggle the shift Chg check box in the charge item entry so that it displays a

check mark. The charges specified in the shift Charges action item are
applied to the charge item.

Normalize CPU for Selected Entries
Select the Normlz cPU check box to normalize charges for (or clear shift charges

from) the selected charge item. Shift charges are defined in the definitions areas of
“Common Shift Charges” on page 51 or “PDB Shift Charges” on page 62.

1 Scroll down to the charge item for which you want to normalize CPU charges.

2 Toggle the Normlz CPU check box in the charge item entry so that it displays
a check mark. The shift charges specified in the Shift Charges action item
are applied to the charge item.

Add a New Rate Model
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Click the button next to the Display Rate Model field near the top of the
window.

Select Add a New Rate Model/Effective Date from the pull-down selection
list.

In the Rate Model field, enter a name to identify the rate model. If you specify
the name of an existing rate model but give it a new (usually current) effective
date, the existing rate model with the most current effective date gets copied
into the new rate model. This is useful when you are updating rates.

In the Effective Date field, enter the date on which you want the rate model
to take effect.

To accept the new rate model, select [OK].

To reject the new rate model, select [Cancel]. You return to the Rate Model
Charge Item Selection window.

For information on how to define the rate model, see “Customer Assignment” on
page 59.

Delete a Rate Model

1

Click the button next to the Display Rate Model field near the top of the
window.

Select the rate model that you want to delete.

Select the pisplay Rate Model field again. If the active rate model is not
called befault”, the drop-down list will have another entry called Delete this
rate model. Select this entry to delete the rate model.

If the rate model is called pefault, you cannot delete it. In this case, the
entry Delete this rate model does not appear on the pull-down menu.

Select Delete Rate Model from the pull-down selection list. The Add/Delete
Rate Model window appears prompting you with the selected rate model.

To delete the rate model, select [OK].

To retain the rate model, select [Cancel]. You return to the Rate Model Charge
Item Selection window.

Apply Rates to the Active PDB

1
2

Scroll down to the charge item to which you want to apply a rate.

Adjust the rate in the Rate field on the charge item entry. The rate is applied to
the charge item.

Note: Use a minus sign in front of the number to indicate that a rate is
negative, for example, -1.2110000. A

Customer Assignment

The Customer Assignment option lets you define and apply customized rate models
to individual charge items.

Qualify a Rate Model

1

Select the selective Charging option from the Manage PDBs window. The
Rate Model Selection window appears:
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= SAS IT Charge Management Hate Model Selechion

[set| [ RateModel | [ Effective Date |

EXCLUDE .
DEFAULT 01JAN1960

JGPAGE 01.JANT9E60

_Close | telp |

2 Select the rate model that you want to customize. The Rate Model User
Assignment window opens:

= SAS IT Charge Management RHate Model Customer Aszsignment

JGPAGE 01JAN1969

Batch Jobs

3 Select a qualification you want to customize.

4 From the pull-down menu, you can edit, copy, insert, or delete the qualification
rate model. To edit the existing charging qualification rate model, select the
qualification name or a new entry from the list. A Rate Model Qualification
window for the selected charge item appears:
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II"!I_ SAS IT Charge Management R ate Model Customer Assi = Ellil
PDB: c:%itcm 2.4.chm'ec'ecdemo', MIMI-Help: This window contains the specifications to
determine that 3 unit of wark should be assigned to
Rate Model: [JGPAGE this rate model. Specify the operator and constant
Effective Date: [01JANTI60 value for comparing custommer name key structures, for
audit ar table name fields, andfor additional expressions
in a farm to fitinto an IF or WHERE statement.

Specify Assignment DQualification:
Qualification Name: [3atch Jobs

Key 1 EQ | ™ 00000000000000000000000000000000
Key 2 EQ | ™ 0000O000COOO

AUDID EQ | * [O0000000000000000000000000000000
Table = ' XJOBS ”

fAdditional 5AS Expressions: P
( JOB eq :'JGP® Describe Keys |

oK Cancel Help

5 Fill in all applicable fields with the values that you want to qualify. After you
have completed your qualification definition, select to save or to
close without saving.

Datahase Definition

Before populating the SAS IT Charge Management tables, you must run the
Database Definition job. This job defines the SAS IT Charge Management tables, which
begin with “E”, to SAS IT Resource Management. (The SAS IT Charge Management
tables begin with “E”.)

SAS IT Charge Management generates the following material you need to run the
Database Definition job: the batch file, script, or JCL and source.

Review the generated code and JCL or script. Select the appropriate item from the
menu bar depending on whether or not you want to keep a copy of the generated code
and JCL or script.

Note: The SAS IT Charge Management tables correspond to the SAS IT Resource
Management tables from which the SAS IT Charge Management data is derived. For
example, the SAS IT Resource Management table called XPRINT has a corresponding
table in SAS IT Charge Management that is called EPRINT.

Because they have different structures, the two tables do not have the same number
of observations.

SAS IT Resource Management tables tend to have many variables for each
observation. Variables in the SAS IT Resource Management tables change with
the data source.

The SAS IT Charge Management tables have exactly 28 variables per observation.
These tables always contain the same variables but the values of the variables
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change. There is one observation for each combination of customer key name
fields, date variables, charge item, rate model, and rate.

A
The Database Definition job uses the %CPDDUTL macro to update the tables.

For more information, see “Manage Charge Item Definitions” on page 33 and “Ad hoc
Reporting” on page 98.

Define Surcharges, Discounts and Prorating

[Define Surcharges, Discounts and Prorating]| is the last button on the Manage PDBs tab.
The task items for this sub-window include Shift Multipliers, CPU Normalization,
Proration, and Device Definitions.

Each of these task items is explained below.

=lolx)
3 IT Charge Management Demo ﬂ@l

E c:hitem 2.4%chm'echecdemo'

User: =asmoh

Site Administration Manage PDBs ] Operation Reparts Administrative Status 1

Define Surcharges, Discounts and Prorating nts

' Define Rate Models,
Charges and fAssignments

% PDB 5hift Charge=s: Using
No Shift Charges

E‘ Define Surcharges,

PDB Devi Chy : Usi
Discounts and Prorating i evice Lharges: Using

No Device Definitions

gPDB Processor Charges: Using
No Processor Normalization

PDB Prorate Routine: Using
Ho Prorating

Close Help

PDB Shift Charges

Description:

The PDB Shift Charges item lets you define shift discounts or surcharges for
any shift identifier defined in SAS IT Resource Management. This kind of
chargeback methodology serves to encourage or discourage the consumption of
data center resource based upon the shift during which the resource is utilized.

To implement a charging methodology that includes shift discounts and
surcharges, you can enter a charging factor for any applicable shift. The charging
factor is called a shift multiplier.

The Shift Charges option enables you to define a Multiplier for any charges
that fall in a specified shift. Factors greater than 1.0 generate shift surcharges.
Factors between 0 and 1.0 generate shift discounts. If the multiplier is less than 1,
then a discount is generated. If the multiplier is greater than 1, then a surcharge
is generated. If the multiplier is 1, also the default, then neither a surcharge nor a
discount is generated.

You can maintain site-level shift discount and surcharge specifications from the
Site Administration tab. You can maintain PDB-unique shift discount and
surcharge specifications from the Manage PDBs tab.
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Default:

No shift charges are specified. All shift multipliers are set to 1.00, so they have
no effect on the charges.

Location:

Select the Manage PDBs tab from the SAS IT Charge Management main menu.
Then select the PDB you want to use. Click
[Define Surcharges, Discounts and Prorating|. Select the PDB Shift Charges area to
specify shift multipliers.

Activation:
For PDB-unique Shift Charges:
1 Select [Define Surcharges, Discounts and Prorating] from the Manage PDBs tab.

2 Select the PDB Shift Charges area. A pull-down menu appears indicating
your choices: [PDB Unique Shift Charges|, [Common Shift Charges| or
[No Shift Charges|.

LT
ﬂl IT Charge Management Demo ilﬁl

il c:hitem 2.4%chmiechecdemo’
User: sasmoh

Site Administration Manage PDBs Operation Reports Administrative Status 1

Define Surcharges, Discounts and Prorating nts

Define Rate Models . .
. " PDB Shift Charges: Using
| Charges and fissignments % No Shift PDE Linique Shift Cherges

Common Shift Charges

Def ine Surcharges, PDB Devic
| EIDist:.t:nl.lni‘.s and Prorating No Device Mo Shift Charges

!PDB Processor Charges: Using
No Processor Normalization

PDB Prorate Routine: Using
Ho Prorating

Close Help

3 Select PDB Unique Shift Charges.

Ii'il_ SAS IT Charge Management PDE Unigue Shift

=lolx]

FDB: c:%item 2.4%chm'ectecdemo®
Specify Charge Multipliers For Each Shift Code: 0 to 999.993

Multiplier:
1 1.000 Ho =hift charge
2 1.000 Ho =hift charge
3 1.000 Ho =hift charge
4 1.000 Ho =hift charge
5 1.000 Ho =hift charge
6B 1.000 Ho =shift charge
T 1.000 Ho =shift charge
8 1.000 Ho shift charge
9 1.000 Ho shift charge
0 1.000 Ho shift charge

Reset (8124 Cancel Help
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For the active PDB, enter a charging factor in the Multiplier field. Factors
greater than 1.0 generate shift surcharges. Factors between 0 and 1.0
generate shift discounts. Negative values are not permitted.

To accept the shift charging definition, select [OK]. To return to the previous
shift-charging implementation, select [Cancel]. The PDB Shift Charges area
displays a message to reflect the shift charging changes you have performed:
either Using PDB-unique Definitions or Using No PDB-unique Definitions.

For Common Shift Charges:

1
2

Select [Define Surcharges, Discounts and Prorating|from the Manage PDBs tab.

Select the PDB Shift Charges action item. A pull-down menu appears
indicating your choices: PDB Unique Shift Charges, Common Shift
Charges, or No Shift Charges.

Select Common Shift Charges. The PDB Shift Charges area displays:
Using Common Definitions.

The common Shift Charges are defined on the Site Administration tab in the
Define PDB Defaults and Adjustments functional area.

For No Shift Charges:

1
2

Select the shift Charges option.

Select No shift Charges from the pull-down. [PDB Shift Charges| displays:
Using No Shift Charges.

PDB Device Charges

Description:

The Device Charges option lets you map various devices to a functional group.
For example, z/OS printer device names map to either a functional description
such as LASER, FICHE, IMPACT, or a charging qualification value such as
BILLABLE or NONBILLABLE. You can maintain this table as a Site-unique
definition or you can utilize a PDB-unique definition that is maintained from an
area under the Manage PDBs tab. This window enables you to use valid SAS code
in order to group various devices to a single definition. Within the comments is a
sample definition. Enter your SAS code here.

Default:

There are no device definitions specified. As distributed, this exit contains only
comments.

Location:

Select the Manage PDBs tab from the SAS IT Charge Management main menu.
Then select [Define Surcharges, Discounts and Prorating|. Select Site PDB defaults.
Select Device Definitions to specify a device definition exit.

Activation:

1 Select Device Definitions. The Device Definition Exit window opens.

2 This window enables you to use valid SAS code in order to group your devices.
By default, this exit contains only comments. Within the comments is a sample
definition. Commonly grouped devices are printers, storage devices, and
network devices. The SAS IT Resource Management table contains variables
that are to be tested to establish grouping by such fields as device address or
LU name. Enter your SAS code here. SAS Program Editor commands are
available while this window is open.
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3 When you have completed the definitions, select to close the window. Notice
that the button text of the menu area to the right now says
|[PDB Device Charges: Using Unique Definitions].

PDB Processor Charges

Description:

The Processor Charges action item enables you to specify a normalization
factor that will be applied to accumulated CPU time statistics so that a normalized
CPU time quantity can be calculated. The normalization factors are
machine-specific and facilitate a billing methodology for CPU time that is
equitable across processor hardware configurations.

Tip: For UNIX systems, take the number of CPUs into account as well.
Default:

No processor normalization.
Location:

From the SAS IT Charge Management main menu, select Manage PDBs »
Define Surcharges, Discounts and Prorating » PDB Processor Charges

This enables you to code a Processor Normalization exit.

Activation:

1 Select the [PDB Unique Processor Normalization| option as described immediately
above, in Location. The Processor Normalization Routine Edit window opens.

2 This window enables you to use valid SAS code in order to normalize your CPU
to a single definition. By default, this exit contains only comments. Within the
comments is a sample definition. The MACHINE variable contains the host
identifier. SAS Program Editor commands are available while this window is
open.

3 When you have completed the definitions, select to close the window. Notice

that the button text of the menu area to the right now says

Using No Processor Normalization|, or [Using Common Normalization|, or

Using Unique Processor Normalization)].

PDB Prorate Charges

Description:

The PDB Prorating Routine enables you to apply and maintain control
parameters and proration specifications either at the Site level or at the PDB
level. The structure of the proration specification table enables multiple output
fields to be re-populated by the proration process.

Default:
No proration.
Location:

Select the Manage PDBs tab from the SAS IT Charge Management main menu.
Select the PDB you want to work with. Then select
[Define Surcharges, Discounts and Prorating|. Select the PDB Prorating Routine
area to specify a proration exit, turn off prorating for this PDB, or use the common
definition (if one is specified).
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Activation:

1 Select the PDB Unique Proration option from the pull down menu as
described in Location. The Proration Routine Edit window opens.

2 This window enables you to use any valid SAS code to define the proration
routine. By default, this exit contains only comments. Within the comments
is a sample definition. Enter your SAS code here. This exit is called during
consolidation.

3 When you complete the definitions, select in the upper-right corner. The
button text of the menu area to the right now says
[PDB Prorate Routine: Using Unique Proration|. Depending on your
specifications, the button text can be [Using Unique Proration|,
[Using Common Proration|, or [Using No Proration].
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Operation: Overview

This section describes the daily and monthly tasks required to administer SAS IT
Charge Management. These topics are available:

Daily Processing

Daily processing for collection of charges complements the normal SAS IT Resource
Management process and reduce macros. SAS IT Charge Management uses the Generic
Collector facility in SAS IT Resource Management. After you have selected a charge
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item in a PDB and specified rate models, you need to update the IT Resource
Management process and reduce tasks to process IT Charge Management data. This
section discusses how to update the process and reduce tasks to specify the additional
parameters and macros needed for SAS IT Charge Management. It also discusses the
administrative tasks that should be performed on a daily basis.

DATECHK Global Macro Variable

The DATECHK global macro variable tells SAS IT Charge Management how to set
the value of the Start Date of Invoice Period variable (EOINVSD). The macro variable is
used during the execution of the %CxPROCES macro in your daily run. The default
value is "default". The DATECHK syntax follows:

%global datechk;
%$let datechk=default|force;

The EOINVSD class variable exists on all SAS IT Charge Management tables from the
detail through the consolidation files. By default, EOINVSD is assigned a value of the
start date of the current (open) invoice period during the execution of the %CxPROCES
macro. During consolidation, EOINVSD determines which consolidation file the
observation will be placed into.

DATECHK=DEFAULT
Internally in SAS IT Charge Management, DATECHK is set to default:

%global datechk;
%let datechk=default;

When DATECHK=DEFAULT, the EOINVSD variable is assigned the start date of the
invoice period that is open. During normal processing, the DATECHK macro variable
does not need to be specified.

Example 1:

Background: Assume today’s date is March 5 and a Gregorian calendar is used.
You are processing data for February 28. Invoice periods start on the 1st and 15th
day of each month. No Datechk macro variable is specified; therefore, DATECHK
is set to DEFAULT. The consolidation job has not run in March with a
SYSPARM=-1 or AUTOINVC.

Result: Data for February 28 has variable EOINVSD set to 15FEB1999. The data
for February 28 is accumulated into the invoice period that started on February 15.

Example 2:

Background: Assume today’s date is March 6 and a Gregorian calendar is used.
You are processing data for February 28. Invoice periods start on the 1st and 15th
day of each month. No Datechk macro variable is specified; therefore, DATECHK
is set to DEFAULT. The consolidation job ran on March 5 with
SYSPARM=AUTOINVC.

Result: Data for February 28 has variable EOINVSD set to 01MAR1999. The
data for February 28 is accumulated into the invoice period that started on March
1.

Example 3:

Background: This is an example for backloading data. Assume today’s date is
April 10 and a Gregorian calendar is used. You are processing data for February



Operation /A Update the Process and Reduce Tasks 69

28, backloading. Invoice periods start on the 1st and 15th day of each month. No
Datechk macro variable is specified; therefore, DATECHK is set to DEFAULT.
February was never consolidated. The invoice start date is 15FEB1999. After the
update job ends, you consolidate with SYSPARM value -3 (invoice period Feb 15 is
-3, Mar 1 is -2, Mar 15 is -1, and Apr 1 is 0), therefore closing the Feb 15 invoice
period. While processing data for Mar 1, additional data for Feb 28 slips in.
Result: Data for February 28 has variable EOINVSD set to 01APR1999. The

additional data for February 28 will be accumulated into the invoice period that
started on April 1, 1999 (the current open period).

DATECHK=FORCE

The use of DATECHK=FORCE should not often be necessary. It is an override
setting and must be specified before processing. FORCE causes the value of EOINVSD
to be determined by the variable DATETIME. SAS IT Charge Management looks at
DATETIME and determines which invoice period it falls into. Then it takes the first
day of that invoice period and puts that value into EOINVSD. Normal processing uses
the system date, determines which invoice period that system date falls into, and then
uses the first day of that invoice period to populate EOINVSD. The syntax is:

%global datechk;
%let datechk=force;

If you use DATECHK=FORCE, you must follow these additional steps. First, process
all the data that is to be forced into closed invoice periods. Then, re-consolidate those
closed invoice periods (specifying the appropriate SYSPARM values).

After you have made changes to an invoice period, you then need to rerun and
redistribute your invoices and other reports. Otherwise, the invoices that the customers
received earlier would no longer match your data. Finally, if you use AccountView, you
need to replace the extract file.

Example:

Background: Assume today’s date is January 5 and a Gregorian calendar is used.
You are processing data for January 4. Invoice periods start on the 1st and 15th
day of each month. Suppose that due to the holidays, the last 3 days’ data from
December was not processed. However, you did not find out about this until after
you ran a consolidation to close out December. You ran the consolidation
(SYSPARM = AUTOINVC) but you have not yet run the invoice job or distributed
any reports.

At this point, you have two options. You can force the data into December using
DATECHK=FORCE, and re-consolidate before running invoices. The other choice
is to process with the default and allow those three days’ data to fall into the
January invoice period.

Result: If you re-consolidate December, you specify:
%let datechk=force;

on the update of the daily run that processes the data from the 3 missing days
in December. Data for those days has variable EOINVSD set to 15DEC1999.

Update the Process and Reduce Tasks

Setting up a job to collect and process data starts with a copy of the current SAS IT
Resource Management process and reduce tasks, which are implemented through
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macros. On an Open Systems server, the tasks are in a shell script that calls a SAS
macro that loads the raw data into the PDB. On a z/OS server, the daily run consists of
the JCL and SAS statements that load the raw data into the PDB. For all servers, the
objective of the task is to process the raw data into the detail level of the PDB and then
reduce the data to the summary levels of the PDB.

If you are not the SAS IT Resource Management administrator, you need to work
with the SAS IT Resource Management administrator closely. Here is a summary of the
six additions you need to make to the existing tasks. After the summary, each change is
explained in detail; then examples are shown for each server platform.

1 Add the SAS IT Charge Management macro library to SASAUTOS.
2 Add a FILENAME statement for the SAS IT Charge Management site control file.

3 Add an INCLUDE statement for macro code that starts SAS IT Charge
Management.

4 Add a call to the macro that starts SAS IT Charge Management.

5 Add an EXITSRC= parameter to your current %CxPROCES macro call.

6 Add another %CxPROCES macro call after the existing %CxPROCES macro call.

Note: There can be many variations of the SAS IT Resource Management job or
script. If you have a special situation or need assistance in setting up the process and

reduce job or script for SAS IT Charge Management, please contact SAS Technical
Support. A

1. Add the Macro Library to SASAUTOS

Add the SAS IT Charge Management Macro Library to SASAUTOS.

The OPTIONS statement at the beginning of the job or script includes a parameter
called SASAUTOS=. This parameter usually contains several macro or source libraries
already. Add the SAS IT Charge Management autocall library to that list.

For z/0S, this library is created with the following convention:

siteprefix.EC.AUTO

where

siteprefix is the high-level qualifier that the SAS IT Charge Management
libraries have in common. Sometimes this high-level data set
qualifier is the same as the SAS IT Resource Management high-level
qualifier.

EC is a node added to all SAS IT Charge Management libraries during
the allocation and initialization process for a site definition.

AUTO is the z/OS name for SAS IT Charge Management autocall macro
code.

For Open Systems servers, assign a libref for the autocall directory like this:
libname ecautos ’/siteprefixpath/ec/auto’;
For Windows servers, assign a libref for the autocall directory like this:
libname ecautos ’\siteprefixpath\ec\auto’;

where

siteprefixpath is the part of the full path that the SAS IT Charge Management
modules have in common. This path should not be the same as a
SAS IT Resource Management PDB’s path.
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EC is a sub-directory added to all SAS IT Charge Management paths
during the allocation and initialization for a Site definition.
AUTO is the sub-directory name for the SAS IT Charge Management

autocall macro code.

2. Add a FILENAME Statement

Add a FILENAME Statement for the SAS IT Charge Management Site
Control Library.

This statement assigns the file containing common SAS IT Charge Management
code, including the %ECSTART macro’s code. The statement can be added anywhere
before the #INCLUDE ESCNTL(ECSTART) statement.

For z/0S servers, the FILENAME statement should look as follows:

FILENAME ECSCNTL ‘SITEPREFIX.EC.SCNTL’ DISP=SHR;
For Open Systems servers, it should look as follows:
filename ecscntl ’/siteprefixpath/ec/scntl’;

For Windows servers, it should look as follows:

filename ecscntl ’\siteprefixpath\ec\scntl’;

3. Add an INCLUDE Statement to %EGSTART

Add an INCLUDE Statement for the Macro Code That Starts SAS IT Charge
Management.

This statement pulls the %2ECSTART macro code into the jobstream or script.

For all platforms, the statement is coded as follows:

$INCLUDE ECSCNTL(ECSTART);

This statement must occur after the FILENAME statement and before the %2ECSTART
call that is discussed in the next step. The INCLUDE statement looks the same on all
platforms.

4. Add a Call to the %ECSTART Macro

Add a Call to the Macro That Starts SAS IT Charge Management.
This statement executes the %#ECSTART macro.

$ECSTART (SITEPFX=SITEPREFIX.,
PDBPFX=PDBPREFIX.,
PROCESS=COLLECT );

The purpose of the #ECSTART macro is to set up the proper environment for SAS IT
Charge Management processing. This macro has four parameters:

SITEPFX= specifies the location of the common SAS IT Charge Management
libraries.

For z/OS servers, this location is the high-level data set qualifier.

For Open Systems and Windows servers, this location is a fully
qualified path. SAS IT Charge Management appends the SAS IT
Charge Management sub-directory to this location.
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PDBPFX= specifies the location of the PDB-specific SAS IT Charge
Management libraries.

For z/OS servers, this location is the high-level data set qualifier.

For Open Systems and Windows servers, this location is a fully
qualified path. SAS IT Charge Management appends the SAS IT
Charge Management sub-directory to this location.

PROCESS= tells #ECSTART to include the SAS IT Charge Management code
required for processing newly collected data into the PDB.
DEBUG= is used to troubleshoot problems. It defaults to a null value. The

settings are DEBUG=YES, DEBUG=Y, or DEBUG= .

Y or YES turns debugging information on. To turn off debugging
information, specify DEBUG= (parameter without a value) or omit
the DEBUG= parameter.

5. Add an EXITSRC= Parameter

Add an EXITSRC= Parameter to the Current %CxPROCES Macro Call.

The EXITSRC= parameter of the %CxPROCES macro enables you to point to a
specific location where SAS IT Charge Management stores code for the SAS IT
Resource Management exits that it uses. SAS IT Charge Management makes use of
these standard exit points.

The additional parameter is as follows:

EXITSRC=ECSITE.ECEXITS

For z/0S servers, the following is an example of an updated %CMPROCES macro
call.

Note: If you or the SAS IT Resource Management administrator uses the SAS IT
Resource Management exit points, please review the section called “SAS IT Resource
Management Exit Points” on page 113. A

%CMPROCES ( , EXITSRC=ECSITE.ECEXITS,
COLLECTR=SMF,
TOOLNM=MXG) ;

For Open Systems, Windows, and z/0S servers, this is an example of an
updated %CPPROCES macro call.

$CPPROCES (COLLECTR=GENERIC,
TOOLNM=SASDS,
GENLIB=ECWORK,
EXITSRC=ECSITE.ECEXITS);

For UNIX servers, this is an example of an updated %CPPROCES macro call.

%$CPPROCES(, COLLECTR=ACCUNX,
RAWDATA=/datalLocation/,
TOOLNM=SASDS,
EXITSRC=ECSITE.ECEXITS);

Note: Never use %CSPROCES with SAS IT Charge Management. The purpose of
%CSPROCES is to list the files to process. This is not necessary in SAS IT Charge
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Management. An additional problem is that, after it finishes processing, %CSPROCES
deletes the contents of the work file. Ao

6. Add Another Call to the %CxPROCES Macro

Add Another Call to the %CxPROCES Macro after the Existing %CxPROCES
Call.

When the second call executes, it creates SAS IT Resource Management tables from
SAS IT Charge Management data created by the first macro call. It uses a standard
%CxPROCES macro, called with the Generic Collector Facility and a GENLIB of
ECWORK.

For z/0S servers, the following is an example of a second %2CMPROCES call:

$CMPROCES ( , COLLECTR=GENERIC,
TOOLNM=SASDS,
GENLIB=ECWORK,
EXITSRC=EXSITE.ECEXITS2);

For Open Systems and Windows servers, the following is an example of the
second %CPPROCES call:

$CPPROCES (COLLECTR=GENERIC,
TOOLNM=SASDS,
GENLIB=ECWORK,
EXITSRC=ECSITE.ECEXITS2);

For UNIX servers, this is an example of the second %CPPROCES macro call.

%$CPPROCES(, COLLECTR=ACCUNX,
RAWDATA=/datalLocation/,
TOOLNM=SASDS,
EXITSRC=ECSITE.ECEXITS2);

Sample Process and Update Jobs
This sample for a z/OS site includes the code added for SAS IT Charge Management.

Note: Code added or changed for SAS IT Charge Management is indicated by
comments. A

$CMPROCES(, EXITSRC=ECSITE.ECEXITS,

This sample job assumes that the only collector that has data in this PDB is SMF.
The site prefix is SITEPREFIX. The PDB prefix is PDBPREFIX. The SAS IT Resource
Management prefix is ITSV.TS45002 and MXG prefix is MXG.Vnnnn.

//ITSVEC01 JOB (,B66), 'COLLECT’,MSGLEVEL=(1,1),NOTIFY=ITSVEC,
// TIME=(19,59)

/*JOBPARM FETCH

//J3S001 EXEC SAS,REGION=32M,WORK='20500,2500",

// OPTIONS=’'SOURCE MEMSIZE=32M DMSBATCH BATCH TERMINAL

// $SNOSYNTAXCHECK’

//SMF DD DISP=SHR,DSN=SMF.INPUT.DATA(O0)

//SYSIN DD DATA,DLM='@Q@"
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OPTIONS MAUTOSOURCE NOIMPLMAC ERRORABEND DQUOTE NOOVP NOCENTER;

libname ECAUTOS

$CPSTART (
MODE=BATCH,
SYSTEM=z/0S,
ROOTSERV=, SHARE=N/A,
ROOT=ITSV.TS45002.,

'ITSV.EC.AUTO’ DISP=SHR; /* this code was added or

*/
/* changed to correspond to */
/* Update 1 described above. */

SITELIB=ITSV.SITELIB,SITEACC=0LD,

PDB=PDBPREFIX.,DISP=0OLD,
MXGLIB=MXG.Vnnnn.LIBRARY,
MXGSRC=('ITSV.SOURCLIB'

):

FILENAME ECSCNTL ’'SITEPREFIX.EC.SCNTL’

$INCLUDE ECSCNTL (ECSTART);
/*

$ECSTART (SITEPFX=SITEPREFIX.,
PDBPFX=PDBPREFIX.,

PROCESS=COLLECT )

’

/* this code was added or
to Update 3 described

'MXG.Vnnnn.SOURCLIB')

DISP=SHR; /* this code was added or
/* changed to correspond
/* to Update 2 described
/* above.

changed to correspond *

above. *

/* this code
/* to correspond to Update 4

was added or changed */
*/

/* described above. */

this code was added or changed */
*/
*/

to correspond to Update 5
described above.

/* this code was added or */
/* changed to correspond */
/* to Update 6 */
/* described above. */

This sample job for a UNIX server includes the code added for SAS IT Charge

$CMPROCES ( ,
EXITSRC=ECSITE.ECEXITS, /*
*/
/*
COLLECTR=SMF,
TOOLNM=MXG) ;
$CMPROCES (, EXITSRC=ECSITE.ECEXITS2,
COLLECTR=GENERIC,
TOOLNM=SASDS,
GENLIB=ECWORK) ;
$CPREDUCE () ;
ee
Management.
Note:

comments. A

Code added or changed for SAS IT Charge Management is indicated by

This example assumes that the only collector whose data is in this PDB is Aprisma
SPECTRUM. The site prefix is /path/to/your/site. The PDB prefix is: /path/to/
your/pdb. Note that the prefixes have trailing delimiters when they are referenced in

the ECSTART macro.

%cpstart (mode=batch

,sitelib=/path/to/your/sitelib

,siteacc=write

*/
*/
*/
*/

/
/
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,pdb=/path/to/your/pdb
,access=write )i

libname indata "/path/to/your/data";

filename ecscntl "/path/to/ec/scntl/"; /* this code was added or changed */

/* to correspond to Update 2 */
/* described above. */
$cscsifmt (modelds=indata.model);
%2include ecscntl(ecstart); /* this code was added or changed to */
/* correspond to Update 3 */
/* described above. */

%ecstart
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(sitepfx=/path/to/your/site/prefix/ /* this code was added or changed */

,pdbpfx=/path/to/your/pdb/ /* to correspond to Update 4
,process=collect ) /* described above.

%cpproces(indata.wa_link,
csiwal,
collectr=spectrum,

exitsrc=ecsite.ecexits ); /* this code was added */
%cpproces (,esiwal, /* or changed */
collectr=generic, /* to correspond to */
toolnm=sasds, /* Update 5 */
exitsrc=ecsite.ecexits2, /* described */
genlib=ecwork); /* above. */

%cpproces (indata.rtrcisco,
ccirot,
collectr=spectrum,

exitsrc=ecsite.ecexits /* this code was added */
)i
$cpproces(,ecirot, /* or changed */
collectr=generic, /* to correspond to */
toolnm=sasds, /* Update 6 */
exitsrc=ecsite.ecexits2, /* described */
genlib=ecwork); /* above. */
$cpreduce();

This sample job for a Windows site includes the code added for SAS IT Charge
Management.

Note: Code added or changed for SAS IT Charge Management is indicated by
comments. A

This sample assumes the only collector whose data is in this PDB is NTSMF. The site

prefix is: \path\to\your\site. The PDB prefix is: \path\to\your\pdb.

Note: The prefixes when referenced in the ECSTART macro have trailing
delimiters. A

*/
*/
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filename ecscntl "d:\SAS\cpe\chm\ec\scntl"; /* This code was added or changed */

/* to correspond to Update 2 */
/* described above. */
$include ecscntl(ecstart); /* This code was added or changed */
/* to correspond to Update 3 */
/* described above. */
%ecstart(sitepfx=\path\to\your\site), /* This code was added or changed */
pdbpfx=\path\to\your\pdb\, /* to correspond to Update 4 */
process=collect /* described above. */ );
gcpstart (pdb=\path\to\your\pdb
mode=batch,
access=write );
gcpproces(,collectr=WINNT,
toolnm=NTSMF,
rawdata=\path\to\raw\data\*.smf,
exitsrc=ecsite.ecexits, /* This code was added or changed */
/* to correspond to Update 5 */
/* described above. */
_rc=PROCRC )3
$cpproces(,collectr=generic, /* This code was */
toolnm=sasds, /* added or changed to */
genlib=ecwork, /* correspond to Update 6 */
exitsrc=ecsite.ecexits2); /* described above. */

gcpreduce();

Run the Process and Reduce Jobh

Ideally, the process and reduce job should be run on a daily basis with input data
from the prior day. The process and reduce job is the shell script and SAS IT Resource
Management macros that process the raw data into the PDB and reduce it. SAS IT
Charge Management currently does not have a facility to submit the process and reduce
job or script directly to the server host. Thus, you will need to use a host-based
scheduling package or cron_tab (see your vendor’s users manual for cron or at) to
ensure the process and reduce job runs daily.

Missed days can be input, but be sure the SAS IT Resource Management filtering
macros are being used to prevent duplicate data from being processed into the SAS IT
Resource Management tables whose data is being used as input to SAS IT Charge
Management. See the SAS IT Resource Management Macro Reference documentation
for more information on the duplicate checking macros.

If you have a requirement to backload data and process it into SAS IT Charge
Management, contact SAS Technical Support. Special considerations need to be
addressed, such as in which invoice periods the data belongs.
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Detailed Status

Click the icon located on the top right of many SAS IT Charge Management
windows. This opens the Detailed Status window.

E'Er SAS IT Charge Management Detailec o ] |
Status Table Event Format
Host Timestamp Status Event
{Descending Order) PDB Prefix {if applicable)
=
‘ 0BAPRZ2004:16:06:24 EC_BHINO ITCH Admin Entered by sasmoh |
‘ 08APR2004:15:49:23 IT_MAIN Site Admin Entered by sasmoh |
‘ 08APR2004:15:49:21 EC_BHINO ITCH Admin Entered by =sasmoh |
‘ 07APR2004:14:30:55 IT_MAIN Site Adnin Entered by 1ihywu |
‘ 07APR2004:14:30:53 EC_BHINO ITCH Admin Entered by 1ihywu |
‘ O7APR2004:14:26:32 IT_MAIN Site Admin Entered by 1ihywu |
‘ OFTAPRZ2004:14:26:30 EC_BHING ITCH Admin Entered by 1ihywu |
‘ 07TAPR2004:14:19:00 IT_HAIN Site Adnin Entered by 1ihywu |
‘ 07APR2004:14:18:59 EC_BUINO ITCH Aidmin Entered by 1ihywu |
=]

Close Help |

The fields in this window are read only. The window shows two columns of
information. The left window contains the Host Timestamp (server timestamp), which
gives the date and time of the event described in the right column. The right column
contains the Status Event, which gives a description of the actions performed by SAS
IT Charge Management administrators. If the event was performed on a particular
PDB, then the PDB name is included in the status Event column. These events are
sorted in reverse chronological order. Thus, the most recent events are displayed at the
top of the list.

You can use the scroll bar to view older events. Select to return to the
previous window.

Daily SAS

IT Charge Management Administrator Tasks

Each day, the SAS IT Charge Management Administrator needs to perform certain
tasks to ensure the accurate assignment of charges. Performing these tasks on a daily
basis is substantially less work than trying to make changes at the end of the invoice
period and attempting to make those changes retroactive.

Review Collection Job/Script Listing
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Verify that there were no errors in the SASLOG from the process and reduce job
(or script) listing. Any ERROR: messages should be investigated immediately. Be
sure to have the exact wording of error messages if you contact SAS Technical
Support. Look at the data input report in the SAS output and ensure that records
were processed into all expected tables. Additionally, make sure the input data is
as expected: that it has the proper date range (usually yesterday), that it includes
all machines, and that it includes all data sources.

Review Revenue

Using data exploration, reports, or interactive SAS, review the distribution of
revenue across keys, across time, and across reporting groups. If this is performed
on a regular basis, you will come to recognize the normal distribution of revenue.
Any abnormalities will be immediately obvious to you. This enables you to start
investigations in a timely manner and have answers before anyone else asks
questions.

Unassigned Charges and Suspend Processing

In your Customer Key Identification Routine, it is prudent to create a default
bucket (key value) where you put input values that currently do not map to any
known key value. Because your identification routine is not able to assign a
"known" key name structure, these charges are not assigned to anyone for
invoicing. Investigate these values and update the Customer Identification
Routine. Add the necessary debits and credits for any charges already processed.

Suspend ReportsIf you have Suspend Processing turned on, Suspend Reports
are generated as part of the output from your process and reduce run. A quick
glance at these reports lets you know if any new data was put into the Suspend
File. If so, you can review the contents of the Suspend File, update your
identification routine accordingly, then run %ECPROCES to bring the data into
your PDB. (For more information, see the section on Suspend Processing in the
“Customer Identification Routine” on page 26.)

The following is an example of the Suspend Reports:

Reports from first %CxPROCES

Synopsis of new chargeback data 16:10 Tuesday, July 29, 1997

Table Name Charge Type Record Count
ETESTDT 00 50
ETESTDT 01 50

Reports from first $CxPROCES - Suspend Run

Synopsis of data suspended this run 16:10 Tuesday, July 29, 1997

Table Name Date Suspended Record Count
UTESTDT 29July97 00

Reports from second %CxPROCES

Synopsis of data suspended this run 16:10 Tuesday, July 29, 1997

Table Name Date Suspended Record Count
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Verify That Changes Took Effect

29July97
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If you made any changes to your parameters in SAS IT Charge Management,
verify that those changes are reflected in the next process and reduce run. It is
much easier to make a correction, restore one day from backups, and rerun with
the correct parameters, rates, and so on, than to try to deal with incorrect
modifications at the end of the month.

Update Profiles from New Values of Keys

After the collection of new data is completed (through the process and reduce
step), you can assign any new key values to Invoice Profiles. (For more
information, see “Customer Profile Information” on page 29.) SAS IT Charge
Management automatically detects new key value combinations and updates the
customer information table to reflect the additional values.

Invoice Period End Processing

This section discusses the administrative tasks that should be performed on a
periodic or monthly basis. Invoice Period End processing closes out an invoice period.
Invoice Periods are defined in the Maintaining Site Defaults and Accounting
Calendar task area. (See “Manage Site Defaults and Accounting Calendar” on page
18.) Invoice Period End processing is performed by using the Operations tab. Invoice
Period End processing does not necessarily include all steps on the Operations tab. For
example, if no Import Exits are defined in the Manage Open Interface area of the Site
Administration tab, then the Import Data step on the Operations tab is grayed out.
Selecting the Operations tab from the SAS IT Charge Management main menu displays

this window:

E‘Er SAS IT Charge Management ;IEIEI
ﬂ IT Charge Hanagement Demo 5’ &
§| {<w Swisot PEB. no POB svtive)
User: sasmoh
Site Administration Manage PDBs Operation I Reports Administrative Status l
I Manual Adjustments: Enter % 5 Currency Exchange: Enter exchange
debits/credits by customer key _ rates for multicurrency reports

fmperd Datal Eddit arad axe
the hDatoh {9norD YOoess

e 2
’w

Consolidate Data: Edit and

ﬁ@'\a

& -4 Edit Charges: Change rates or
K_ charges or apportion charges

execute the batch consolidation

&6 RBun Standard Invoices: Edit and
_ execute invoices by profile

ELF Export Datael Bdiv s exeouis
LA vhe batob swporboproo

8 Extract File Download: Copy the
Q _ cuwrrent extract file to yow PC

Close Help
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Manual Adjustments

Any final debits and credits should be entered at the end of the month or invoice
period. Debit and credit data entry is described in detail in the section on “Debits and
Credits” on page 40.

Import Data

You can submit the batch program to import data as specified in the data import exits.
Location:
From the SAS IT Charge Management main menu, select the Operations tab.
Then select Import Data.
Note: A Data Import Exit must be specified for this button to be active. A
Activation:

1 On the Operations tab, select Import Data. A generated job or script
appears.

2 A system-generated comment is added into the job or script showing the date
and time of generation. Find the date, and determine if it is current.

3 If the job or script is not current, you can regenerate it by selecting
Regenerate from the menu bar at the top of the window.

4 You can run the job or script by selecting one of the Submit options from the
menu bar.

5 Review the output to verify that it completed successfully.
See also “Import/Export” on page 42.

Consolidate Data

Description:

The Consolidation Data task generates a batch job or script that combines data
from all SAS IT Charge Management tables in all PDBs for the site whose status
is “Ready”. The consolidation job also performs proration if it is defined. If the
AccountView Extract File is enabled, this job also creates the Extract File. (For
more information, see “Extract Data Setup” on page 50.) The consolidation job can
be rerun any number of times without restoring. It is important to consolidate the
data for all PDBs at a site before attempting to generate an invoice.

At the end of the invoice period, run the consolidation. The consolidation run
creates the all-in-one file (the consolidation file) which is used as input for invoices.

If you run a consolidation to close out a period, then the run is referred to as
Consolidation. If you run a consolidation to create an invoice-period-to-date file,
then the run is called Partial Consolidation.

If you want to rerun the consolidation (for example, to add debits or credits) for
an already closed invoice period, the run is called Reconsolidation.

Consolidation has several input files. The Consolidation uses neither the profile
nor the budget information. The SAS IT Charge Management charge tables ("E"
tables) from all PDBs with a status of "Ready" in the SAS IT Charge Management
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client are used as input. (For information on variables in the PDB “E” tables, see
“Variables in the PDB "E" Tables Files” on page 120.) The month reduction level is
used. SAS IT Charge Management subsets the data using the EOINVSD variable.
Also, the debit and credit file is combined with the PDB tables. See also
“DATECHK Global Macro Variable” on page 68.

The consolidation combines all of the input files and summarizes the data to
create a consolidation file. Then the run creates additional data views. Finally, the
run updates SAS IT Charge Management internal formats. The date and time
that the consolidation ran is entered in the Detail Status field.

The consolidation can be rerun any number of times. It can even be run for an
open invoice period in order to produce a file that contains period-to-date
information. This enables you to test invoices or other reports before the invoice
period closes.

The consolidation can also be rerun for closed periods if the input data is still
available. For example, if you want to rerun the consolidation for an invoice period
8 months ago, the SAS IT Resource Management MONTH library must contain
data in the "E" tables from 8 months ago. Additionally, that data must be
available online. If the data is archived, then it must be brought back from
archive before the consolidation runs.

Note: Any edits made to the modified rates, modified charges, or modified
apportioned charges are lost if a consolidation is rerun. A

The output files of the consolidation are not part of any PDB. Because they
contain data from many PDBs, the consolidation files and the associated views are
stored in the ECDATA library. This library is a site-level SAS IT Charge
Management library.

The output files of the consolidation include:
the closed period consolidation file

the open period consolidation file
additional views of the consolidation files
the Account View extract (if enabled)

internal information

o 0o o o g

Internal information consists of the key values table and the invoice period
status format.

The key values table is used by the on the Customer Profile
and Supplemental Charges action items. This table includes all customer
name key values seen in data processed. You can use this table to ensure
that all values are assigned to a profile.

The Invoice Period Status format is an internal SAS IT Charge
Management format that lists each of the invoice periods and its status. The
status can be Open or Closed.

O An invoice period is open if it meets these criteria:

0 Data has been processed with a create date later than the most
recent invoice period start date in the internal table.

0 The consolidation job has not been run after a new invoice start
date has passed.

Note: Usually the open invoice period is the current invoice
period or the one just passed. If the open invoice period is the one
just passed, the consolidation job closes out that period and creates
a new open period. However, if you are backloading data, then the
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open period is the period that has not yet had a consolidation run
for it. 2

0 An invoice period is closed if it meets these criteria:
O A new invoice period start date is reached.

O A consolidation with the appropriate SYSPARM value is run after
the new invoice period start date is reached.

Note: The closed invoice periods are periods for which a
consolidation ran successfully. This means that the invoice period end
date must have elapsed. It also means that the appropriate SYSPARM
value had to be used when executing the consolidation in order to point
to the invoice period to be closed. (For more information, see “Use the
System SYSPARM Options” on page 84.) A

Note: If the Consolidation job or script fails, check the SAS log. If there is an
error message: "Cannot %include ECTABLST in aggregate ECPDBC02", look in
the log above the message. If there is a SAS NOTE indicating that the server host
has successfully allocated the SAS IT Charge Management PDB library as
ECPDBCO02, then there are two probable causes for the error message:

1

A

A defined PDB was later deleted through the file system and not through SAS
IT Resource Management, so SAS IT Resource Management has not deleted
the name of the PDB from SASUSER.CPUSROPT, which is the table SAS IT
Charge Management uses to determine the list of known PDBs for a Site.

There is more than one PDB but at least one PDB is not installed properly.
The following steps walk you through marking the PDB Inactive to SAS IT
Charge Management:

a Launch SAS IT Charge Management.

b Open the Site.

¢ Go to the Select PDB window by selecting at the top of one of the
SAS IT Charge Management windows, or by selecting the Manage PDBs
tab.

d Select status to mark the deleted PDB Inactive. A drop-down menu
will give you the option of marking the status Inactive.

e Select the site Administration tab.

f Select something to make site generation occur. This can be as simple
as re-selecting your Default Currency.

Location: From the SAS IT Charge Management main menu, select the
Operations tab. Select Consolidate PDB Data.

Activation:

1

On the Operations tab, select Consolidate PDB Data. A generated job or
script appears.

Verify that the generation date is current. A comment is created into the job
or script showing the date and time of generation. Find the date, and make
sure it is current.

If the job or script is not current, you can regenerate it by selecting
Regenerate from the menu bar at the top of the window.

You can run the job or script by selecting one of the Submit options from the
menu bar.

Review the output to verify that the job or script completed successfully.
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See also “DATECHK Global Macro Variable” on page 68.

Consolidation Messages

When the consolidation process is run, messages are generated in the SAS log. This
section reviews the various messages generated when the consolidation completes
successfully and when it fails.

When the consolidation process completes successfully, a series of notes are generated:

0 one NOTE: line for every PDB that adds data to the consolidation process

O one section of NOTE:s for the consolidation table name, observation count,
SYSPARM value used and the invoice period start date used

o0 one NOTE: line that says that the extract file was built or suppressed by option

0 one NOTE: line that says that the key table was built or suppressed by option
0 a NOTE: that the processed completed.

The following is a sample of these messages:

NOTE:
NOTE:
NOTE:
NOTE:
NOTE:
NOTE:
NOTE:
NOTE:

Contributing PDB: /u/itsv23/sapr3pdb/

Consolidated data table E_14670W is being

built for the invoice period you selected.

It will have 33 observations.

SYSPARM=02MAR2000 Invoice Start Date=01MAR2000

EC AccountView data extract has been suppressed by option.
Key assignment table being built.

Consolidation successfully completed.

If the consolidation fails, one of the following sets of error messages is generated:

0 If no PDBs are known to SAS IT Charge Management or none of the PDBs defined
have a status of Ready, the consolidation abends with U0095 and the following
error messages:

ERROR: There is no charge data for the invoice start date

ERROR: you selected because no ready PDBs containing charge

ERROR: data were found. This could be because PDB definition
ERROR: or maintenance application was incomplete.

ERROR: Check the PDB definition status in SAS IT Charge Management
ERROR: PDB administration.

ERROR: SYSPARM=02MAR2000

o0 If no data is available for consolidation, then the process abends with U0096. The
data for consolidation comes from the MONTH reduction level of the PDBs with a
Ready status in SAS IT Charge Management. Reasons there might not be data for
consolidation include:

0 There was no data for the selected invoice period.

0 The data has not been reduced to the MONTH reduction level.
o All charge quantities were missing.

o All charges were 0 (zero).

The following error messages are displayed:

ERROR: There is no charge data for the invoice start date

ERROR: you selected. Either that invoice period has had

ERROR: no source data processed into SAS IT Resource Management
ERROR: or no charges were applied to the source data.

ERROR: Check the contents of SAS IT Charge Management data in the
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ERROR: SAS IT Resource Management PDBs.
ERROR: SYSPARM=02MAR2000 Invoice Start Date=01MAR2000

Use the System SYSPARM Options

The SYSPARM option is used in SAS IT Charge Management by batch jobs that use
the consolidation file as input. The SYSPARM value specifies which consolidation file
you want to use. Currently the following action items use SYSPARM:

0 Consolidation

0 To-date consolidation
0 To-date reporting

O Simple invoices

0 Standard invoices.

The SYSPARM= option specifies a character string that can be passed to SAS
programs. The specified character string can be accessed in a SAS DATA step by the
SYSPARM() function and can be accessed anywhere in a SAS program by using the
automatic macro variable reference &SYSPARM.

These are variations of valid syntax for SYSPARM:

Options SYSPARM=autoinvc;
Options SYSPARM=-n;

Options SYSPARM="ddmmmyy";
Options SYSPARM="ddmmmyyyy";

In SAS IT Charge Management, the invoice period input is passed as a value of the
SYSPARM-= option. The value can be provided in several ways. "Autoinvc" is the
invoice period whose end of invoice period date is most recent. The "-n", where n is a
number, is a relative number. The value "-0" is the current invoice period. The value
"-1" is the same as autoinvc. The value "-2" is two invoice periods ago.

The last two values are dates. The difference is whether you specify the year as two
or four digits. "dd" is the day; "mmm" is the three character abbreviation for the month,
in uppercase; "yy" or "yyyy" is the year. If you choose to specify a date, the date must
fall sometime in the invoice period that you intend to use as input to consolidation. The
date can be the start of the invoice period, the end of the invoice period, or any date in
between. SAS IT Charge Management uses an internal table of invoice periods to
determine the invoice period into which the provided date falls.

Edit Charges

Description:

Edit Charges is an interactive facility that enables you to modify existing
charges and create zero balance charges. These charges are added to the
consolidation file. They do not replace the original charges created during daily
processing. They are kept on the consolidation file as additional variables. The
distributed invoice has selections to print these additional charges on the invoice.

Location:

From the SAS IT Charge Management main menu, select Operations » Edit
Charge

Activation:
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See SAS IT Charge Management Reports, “Edit Charges” on page 92.

Currency Exchange

Description:

Currency Exchange enables you to enter the exchange rates for charge

currencies and profile currencies. Invoice programs can thus use profile
information in order to convert currencies correctly. This feature is used for
multi-currency support only.

Location:

From the SAS IT Charge Management main menu, select Operations »

Currency Exchange.

Activation:

After all profiles are specified and a consolidation or partial consolidation is run,

enter the Currency Exchange window. A list of currencies is presented. This list is
determined by SAS IT Charge Management from data processed, rate model
definitions, and profile information. Provide exchange rates to the Euro from each
currency listed. The following steps guide you through this process:

1

3

From the SAS IT Charge Management main menu, select the operations tab.
Select Currency Exchange.

The Currency Exchange Rate Entry window appears.

E“'I_ SAS IT Charge Management Currency Exchange Ra B ;IEIII

Click on Invoice Start Date to display currencies for that invoice period
Highlighted dates have unspecified exchange rates

L el s Detail for 01DEC1998 Invoice Start Date:
01DEC1998 etall Tor nvoice >ta ate:
N1NOV1998 Currency Units per EURD ;I
EUR - European Economic and Monetary Union (EMU), Euro 2
3D - United States of America, TS Dollars 1]
=l
. A
Ok Cancel Help |

Invoice periods with missing exchange rates will be highlighted in yellow in the
list on the left side of the window.

Missing rates within invoice periods are highlighted in yellow in the list on
the right side of the window.

Verify the exchange rates for each currency from the approved rate reference
source. Move the cursor to the cell that represents the exchange rate for the
currency you wish to enter or correct. Enter the correct number of units of the
associated currency to equal one Euro.

Select to accept the change or to return to the Operations menu
without accepting any changes.

See “Edit Charges” on page 92.
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Run Standard Invoices

Description:

The Run Standard Invoices task generates a batch job or script that creates the
standard invoices. This report is available only if you use Invoice Profiles and
specify Invoice Formats for the profiles defined. (See “Customer Profile
Information” on page 29.) The generated JCL or script is created using the
information that you specified in Execution Controls. (For more information on
this topic, see “Execution Controls” on page 18.) For each customer, the invoice
will be printed as specified in the invoice format associated with that customer’s
Invoice Profile.

CAUTION:
No invoice will be printed for a customer if no invoice format has been specified for
that customer. There is no default invoice format. A
Location:

From the SAS IT Charge Management main menu, select Operations » Run
Standard Invoices

Activation:

1 On the Operations tab, select Run Standard Invoices. A generated job or
script appears.

2 A comment is created in the job or script showing the date and time of
generation. Find the date and determine if it is current.

3 If the job or script is not current, you can regenerate it by selecting
Regenerate from the menu bar at the top of the window.

4 You can run the job or script by selecting one of the Submit options from the
menu bar.

5 Review the output to verify that the job or script completed successfully.

See also “Simple Invoices” on page 97 and Invoice Formats in the section called
“Customer Profile Information” on page 29.

Export Data

Description:

Perform this step of Invoice Period End processing after you are satisfied that the
consolidation completed successfully. If you have other applications to which you
want to export SAS IT Charge Management data, such as Microsoft Excel or a
general ledger, now is the time to run the job or script to export the data to a file
in the required format. Export Data enables you to edit the job or script generated
via the Open Interface. Check the job or script, edit it if required, and save it.
Then, run the job or script to generate the export file.

Location:

From the SAS IT Charge Management main menu select Operations »
Export Data

Activation:
1 Select Operations » Export DataA generated job or script appears.

2 Verify that the generation date is current. A comment is created in the job or
script showing the date and time of generation. Find the date and make sure it
is current.
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3 If the job or script is not current, you can regenerate it by selecting Regenerate
from the menu bar at the top of the window.

4 You can run the job or script by selecting one of the Submit options from the
menu bar.

5 Review the output to verify that it completed successfully.

See also the Export Data Definitions topic in the section called “Import/Export”
on page 42.

Extract File Download

Description:

Perform this step of Invoice Period End after you are satisfied that the
consolidation and the extract creation have completed successfully. The download
job copies the selected extract file from the server to the client directory that is
specified in a dialog window.

The default directory is automatically used by the AccountView initialization
process. If a new extract file is found at the initialization of AccountView, it is
copied and processed into AccountView for you. If you decide to change the default
directory, you must also change the AccountView autoexec file. This file is located
in: drive:\[SAS Install Path]\cpe\chm\ec\ecav\ecautoav.sas. Edit this
file to point to the same path as specified in the Extract File download window.

For SAS 8.2 only, the default directory is used by the SAS IT Charge
Management for Enterprise Reporter samples that are provided with distribution
of SAS IT Charge Management. If you change the location, you must update the
Enterprise Reporter info center to point to the new location. For more information,
see the Enterprise Reporter documentation.

II'EI_ SAS IT Charge Management Extract File D ;Iglﬂ

MIMI-Help: This window is used to download data to add to or replace the local
Extract files for Account™iew or Enterprise Reporter usage. Data is only available
if Extracts are enabled prior to consolidation and consolidation has run. By default,
the extract from the last consolidation is downloaded. Using the default target
directories is recommended. The default target file names cannot be changed.

ficcountView target extract file:

:item 2.4%chm'\EC\ecdown'eiscon.sas7bdat | Download
Enterprize Reporter target extract file:
[c:'item 2.4%chm\EC\ecdown" i tcmextr .sas7bdat | Download
Close Help |
Location:

From the SAS IT Charge Management main menu, select Operations »
Extract File Download

Activation:

1 Go to the Extract File Download dialog box as described immediately above,
in Location.

2 Verify that the Target paths and PC files for extract data are correct. The
defaults are
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drive:\[SAS Install Path]\cpe\chm\ec\ecdown\eiscon.sas7bdat
and
drive:\[SAS Install Path]\cpe\chm\ec\ecdown\itcmextr.sas7bdat

3 If the path or PC file is not correct, overwrite the current value with the correct
one. (For AccountView, ensure that this path matches the one specified in
ecautoav.sas.)

4 If the path and PC file are correct, select [Download AV] or [Download ER] to
download the file from the server to the client.

5 Click to return to the previous window.
See also “Extract Data Setup” on page 50.
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Data Exploration and Reporting: Overview

This section describes the specifics about data exploration and reporting using SAS

IT Charge Management. The following topics are included:
“Report Access” on page 90

“Data Selection” on page 90

“Data Exploration” on page 92

“Simple Invoices” on page 97

“Ad hoc Reporting” on page 98.

Oo o o o o o

“Access Your Data with AccountView” on page 106
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Report Access

SAS IT Charge Management Reports can be selected from the main menu Reports
tab. When the SAS IT Charge Management Reports tab moves to the front, this
window displays:

= 5AS IT Charge Management [ 3]
ﬂl IT Charge Management Demo il@l
E c:hitem 2.4%chm'ec'ecdemo®,
User: sasmoh
Site: Adciminiztration l Manzge PDBs ] Cperation Reports Administrative Status ]
Drilldown Report: Examine charges To=-Date Reporting: TYear-to-date
by customer key and item =l charges by profile
=3 Gimple Invoices: Edit and wa Examine Aesults! Consolidated
33 execute invoices by keys ﬁ data brouse (mapped NT only)

e Edit Charges: Change rates or Site Configuration: Produce the
xcharges or apportion charges site configuration reports

)@ To-Date Consolidation: Edit and
it execute a partial consolidation

Close | Help |

Reports can be interactive or batch. Interactive reports are referred to as Data
Exploration. Both the brilldown Report and Edit Charges are supplied interactive
reports. The Ssimple Invoices are batch reports.

Data Selection

Some Data Exploration, Reporting, and Operational features of SAS IT Charge
Management software require that execution options be specified before the feature is
executed. There are several decisions to make:

0 Which invoice start date of consolidated data is to be examined or operated upon?
Select one by clicking a line in the Select Invoice Period list box.

0 Which currency of multiple possible currencies is to be examined or operated
upon? Select one by clicking a line in the Select Currency list box.

0 Which charges are to be reported; the original, modified or apportioned? Select one
by clicking the [Select type of charges to report| radio button.

0 Should rates or charges be edited in consolidated data? Select one by clicking the
[Select edit options| radio button.

0 Should batch work be executed immediately, presented in edit first? Select one
option by clicking the [Select process options] radio button.

These choices are made by the user from a window whose content changes based on
the selected tasks. The following window is an example:
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OF SAS IT Charge Management Batch Process Submit

Specify Selection Criteria

=1o]x]

Submit Options For Configuration Report

Select process option:

@ fpply Selections and Submit Immediately
 fipply Selections and Edit, Manual Submit
T Edit Previous Selections, Manual Submit

Ok

Cancel Help

Three choices are available:

0 Execute immediately. Do not show edit dialog box.

o Show edit dialog box after regenerating.

0 Show edit dialog box but do not regenerate.

As in the case of editing rates or charges, it might be that the invoice start date,
currency, and rate or charge edit must be selected. In this case, the frame presented

contains these selections:

= SAS IT Charge Management Consolidated D ata Selection

Specify Selection Criteria

=B

Data Selection For Simple Invoices by Custormer Key

Select Invoice P

Invoice Start Date 01JAN1999 (partial) B
Invoice Start Date 0IDEC139398
Invoice Start Date 0INOV13398
Invoice Start Date 010CT1998
Invoice Start Date 015EP1998
Invoice Start Date 01AUG1998
Invoice Start Date 01JUL1998
Invoice Start Date 01JUN1998
Invoice Start Date 01MAY1998
Invoice Start Date 01APR1998
Invoice Start Date 01MAR1998
Invoice Start Date O01FEB1998

£

Usp - 538,818.36

Select process option:

“ fApply Selections and Submit Immediately
 Apply Selections and Edit, Manual Submit
CEdit Previous Selections, Manual Submit

Select type of charges to report:

# 0Original Charges
C Modified Charges
" fApportioned Charges

(0]:9 | Cancel |

Help

As in the case of submitting a batch process to produce the Simple Invoices (by
customer key), the invoice start date, currency, charge type, and submit or edit options

must be selected. The frame presented looks like this:

91



92 Data Exploration A Chapter 6

L‘;EI_ SAS IT Charge Management Consolidated Data Selection =10l x|

Specify Selection Criteria

Data Selection For Simple lnvaices by Customer Key

Invoice Start Date 01JAN1999 (partial) = Usp - $36,983.16
Invoice Start Date 01DEC1998

Invoice Start Date 01NOV1998
Invoice Start Date 010CT1998
Invoice Start Date 015EP1938
Invoice Start Date 01AUG1938
Invoice Start Date 01JUL1938
Invoice Start Date 01JUN1938
Invoice Start Date 01MAY193938
Invoice Start Date 01APR1998
Invoice Start Date 01MAR1998
Invoice Start Date 01FEB1998 I

Select process option:

@ Apply Selections and Submit Immediately
“ Apply Selections and Edit, Manual Submit &~ 0Original Charges

" Edit Previous Selections, Manual Submit  Modified Charges

" Apportioned Charges

Select type of charges to report:

Ok | Cancel | Help |

In other cases, it might be necessary to select some combination of the items above.
For example, to execute the Drilldown Report, the invoice start date, currency, and
charge type selections are given.

Data Exploration

In SAS IT Charge Management, data exploration refers to the interactive viewing of
chargeback data. Data exploration enables you to view the data at different hierarchies,
summarization levels, and even with different rates applied. These interactive reports
are real time manipulations of copies of your data. The interactive reports do not use
batch facilities.

Edit Charges

Edit Charges enables you to modify the rates or charges of existing data. This
interactive report uses the consolidation file for a given invoice period. All invoice
periods that have been consolidated for this site are available for selection. From the
SAS IT Charge Management Reports menu, select [Edit Charges].

After selecting the invoice period to modify and the type of modification, either the
Rate Change Entry window appears:
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I SAS IT Charge Management Charge Edit =10l x]

[ tem | RateModel | Ouantity [ovigRate [ ~ OrigCharge [ ModRate | Mod Charge [ AppRate [A =
150000000 $5,871.50) 150000000 $5,871.50) 150000000 ***
2.00000000 $12,478.00| 2.00000000 $12,478.00| 2.00000000
0.40000000 $20,368.86 | 0.40000000 $20,368.86 | 0.40000000
0.00000000 $0.00) 0.00000000 $0.00) 0.00000000
0.00000000 $0.00) 000000000 $0.00) 0.00000000

or the Charge Change Entry window appears:

™ SAS IT Charge Management Charge Edit = o]

0.00000000 . 0.00000000 . 0.00000000
11.50000000 $6,192.00( 1.50000000 $6,192.00( 1.50000000
200000000 $14,078.00| 2 00000000 $14,075.00| 2.00000000
040000000 $20,535 24 | 040000000 $20,535.24| 040000000
0.00000000 $0.00) 0.00000000 $0.00) 0.00000000
0.00000000 $0.00) 0.00000000 $0.00) 0.00000000

Any fields that are displayed in white can be modified. SAS IT Charge Management
supplies the contents of all other fields. Scrolling to the right displays additional
information such as the charge item description, variable, and SAS IT Resource
Management table. Charges are shown by charge item for the selected invoice period
and currency only.

Note: If you press from this window, the modified and apportioned charges are
saved in the consolidation file and are available for reporting. Modified charges are
stored in the variable EICHRG. Apportioned charges are stored in the variable
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E2CHRG. For more information about variables in the consolidation file, see “Variables
in the Consolidation Files” on page 120. A

CAUTION:
Since charge and rate edits are only stored in the consolidation files, reconsolidating
removes any edits made using this window. »

Drilldown Report

Selecting the Drilldown Report from the SAS IT Charge Management Reports main
menu opens a drop-down selection of all invoice periods whose data was processed for
this site. Select the invoice period you want to report on. Then, you are prompted for
charge selection: original charges applied during processing, modified charges from
Edit Charges, or zero balance charges from Edit Charges. After these selections are
completed, the drilldown report is displayed.

The drilldown report shows the selected charges for the selected invoice period by the
customer name key variables. They are summarized to the first key value. If there are
charges for a lower key value, then an arrow appears next to the line. Click the arrow
to expand that section of the report to the next level.

=lolx|
Click to Expand or Collapse Entry. Selected Currency is USD.
[Invoice Start=01JUL1998. Grand Total Original Charges= $53,128.03 =
[+}{{Unspecified) : Total= $22,939.35]
[+}{ADVANCED TECHNOLOGY T Total= $8.42|
-IHDUﬁNCED VISUAL IZAT ION : Total- $7.96]
[+}{APD-AS1A/PACIF IC_OPERATIO : Total= $8.38]
-IﬂPPLIEﬁTIUNS . Total= $78.06]
-|BUSINESS SOLUTIONS DIVISI : Total= $331.12]
-|CDMPUTEH GRAPH ICS : Total= $7.67]
-|CIZIF|E DEVELOPHENT : Total= $45. 87|
-IDﬁTﬁ CENTER T Total= $1,123.26]
[+][DATA WAREHOUSE TECHNOLOGY : Total= $689.45|
-IDISPLm’ PRODUCTS DEVELOPM . Total= $10.23]
-|EDUCﬁT 10N : Total= $104.25]
-|EDUCﬁTIDN TECHNOLOG IES : Total= $8.16]
-|EXECUT IVE : Total= $653.74]
-IFﬁEILITIES T Total= $65.52 |
[+}{F 1N-F INANCE . Total= $686.44
-IHIZIST SYSTENS DEVELOPMENT : Total= $24.20]
[+}{HSR-ENTERPRISE SERVER TEC . Total= $5,351.98]
-|HSH-HDST SYSTEMS RED : Total= $1,160.29]
-|HSH-|JUHLITT ASSURANCE : Total= $207.75]
-|HSH-NDHKSTﬂTIDN TECHHOL DG : Total= $3.96]
;IE AL Aroconncro . Toa_ 1 CXT M. Y |>rd
Clase Help

AccountView

AccountView is a SAS/EIS application shipped with SAS IT Charge Management.
SAS IT Charge Management AccountView is installed on the same PC as SAS IT
Charge Management software during the installation process. It is shipped with
demonstration data so that you can launch it immediately after installation. This
enables you to review the product before deciding if you want to implement the
automatic extraction process during consolidation. Once the consolidation task has
extracted the data and you have downloaded it from the host using SAS IT Charge
Management, AccountView will automatically pick up the new data.
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Seven SAS/EIS applications are included with this version of the product. Three are
3D Business Graphs and four are Multi-dimensional Reports.

Note: If you have any suggestions for SAS/EIS applications, please contact SAS
Technical Support. A

How to Make AccountView Drilldown Definitions Reflect Your Customer Key Structure:

After the Extract file has been downloaded to the client and that data is selected
from the push button in AccountView (AV), you can report on the newly
consolidated data.

Note: When entering any of the report objects inside AccountView, you will see a
hierarchy that is not yours and is only two levels deep. For example, your definition
might have set 5 EOCUSTn levels, starting from Division going down through
Application Group. Instead of seeing your hierarchy, you see the definition from the
demonstration data. &

Note: Before you use the AccountView function, you must successfully complete
your daily data collections (with the process and reduce functions). A

To utilize the reporting features of AccountView, follow these instructions:

A. Download the Extract file to your client platform.

1 Launch SAS IT Charge Management.

2 Select a site from the Site Selection box and press [Open]. Activate the
PDB you want to work with.

3 From the Site Administration tab, select Manage Open Interface »
Extract Data Setup

4 Click the button so that it displays AV Extract Enabled.

5 Using the key with your cursor, highlight the customer keys you want
to explore. Click [OK].

6 From the Operation tab, select Consolidate Data: Edit and execute the
batch consolidation

7 Choose the invoice period you want to consolidate and click the process option
Apply Selections and Submit Immediately. Click [OK |. After the consolidation
job completes, view the log by pressing on the upper left corner and
check for a message to ensure that the file was successfully downloaded.

8 Close the window and return to the Operation tab. Select Extract File
Download: Copy the current extract file to your PC

Press the button next to the path for the AccountView target
extract file in order to download the file. If there is no problem with the
downloading, a message stating “Download completed successfully” will
display at the top of the window.

9 Exit ITCM.
B. Prepare the tables you want to work with.
1 Launch AccountView.
2 From the upper toolbar, select Window » Log

Verify that there is a message that says Extract file copied from
ecdown.EISCON to ECCON.Cnnnnnnn, where nnnnnnn is the numeric value
of the unformatted SAS date on which the table was copied from ITCM
Administrator to ITCM AccountView. Then, minimize the Log window.

3 In the AccountView window, click on [Select Table].
4 Use the arrow to the right of the Repository field to select ECCON as the path.
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5 Then, use the arrows in the middle of the window to select the table you saw
copied (eccon.cnnnnnnn) and move it from the Available list to the
Selected list. When you are satisfied with your selections, click [OK].

6 Select Window » Log and then verify that there is a message that says
"Note: Selected table copied from ECCON.Cnnnnnnn to ECCON.CONFILE".

C. Launch SAS/EIS (Enterprise Information System).

1 If you are running SAS 9.1.3 or later, select Solutions » Development and
Programming » EIS/OLAP Application Builder

2 From the SAS/EIS main menu, double-click on the icon.

3 Use the arrow to the right of the Repository field to select ECCON as the
path and then YTD Consolidation File from the list of available tables.

4 Select Columns » Add » Table Column

5 Move the additional customer keys from Available to Selected. (This
registers your additional customer key levels in the YT'D Consolidation File.)

6 Select OK » CLOSE to return to the Metabase dialog.

7 Highlight the YTD Consolidation File. Select HIERARCH attribute » Edit
» Nodes hierarchy

8 Move the additional customer key fields from Available to Selected.

9 When you are satisfied, click OK » CLOSE » CLOSE (or minimize) the
SAS/EIS main menu

D. Explore your reports.
1 Select Revenue by Customer
2 Double-click on a pie slice that you want to view in more detail.
3 Repeat this drilling down until you reach the level you want to explore, or
until you reach the lowest level.

Note: Use the arrows in the upper right portion of the window to move
back up through the reporting levels of the Revenue display. A

Batch Reports

SAS IT Charge Management provides a facility to run reports in batch mode. If there
is a large amount of data with many individual reports to generate, batch reporting is
more efficient than interactive reporting. The supplied batch reports include:

0 “Simple Invoices” on page 97 (uses customer name keys)
0 “Standard Invoices” on page 97 (uses customer profiles)

0 “To-Date Reporting” on page 97 (uses customer profiles)

o “Site Configuration Report” on page 98.

Execution Definitions and Destinations

For batch reporting, execution information and the destination of the output are
required.

For z/OS servers, JOB cards and JCL execution information must be specified.
For Open Systems servers, a script and login ID must be specified.
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For Windows servers, only the location of the SAS executable is required.

The report execution statements are specified underSite Administration »
Manage Site Defaults and Accounting Calendar » Execution Controls For more
information on this topic, see “Execution Controls” on page 18.

Simple Invoices

Description:

SAS IT Charge Management has one simple invoice. This is a batch report generated
by SAS IT Charge Management, and it is always available. The generated JCL, script
or bat file is created based on the contents of the consolidation file selected and what
you specify on the invoice by Customer Key Definition window. You cannot save the
layout of the simple invoice. Customer profiles and invoice format definitions are not
used in simple invoices. Simple invoices uses the customer name key fields
(EOCUST1-9) for invoicing.

Location:

From the SAS IT Charge Management main menu, select Reports » Simple
Invoices

Activation:

1 On the Reports tab, select Simple Invoices.

2 A window called Consolidated Data Selection appears. Make your selections and

press[OK].

3 The next window that opens is called Invoice by Customer Key. This window
enables you to specify the report layout. You cannot save the specifications.

4 After you fill in all required fields and you press [OK], a generated job or script
opens. You can edit the job or script.

5 You can run the job or script by selecting one of the Submit options from the menu
bar.

6 Review the output to verify that the report has completed successfully.

See also “Run Standard Invoices” on page 86 and “Site Configuration Report” on
page 98.

Standard Invoices

Standard Invoices are described in “Run Standard Invoices” on page 86.

To-Date Reporting

Description:

The To-Date Reporting task enables you to set up and run a batch report that is
generated by SAS IT Charge Management. It uses customer profiles, including budget
information. The generated JCL, script, or bat file is based on the execution control
statements specified under Site Administration. The report uses year-to-date
consolidation tables. If a partial consolidation has been successfully completed, the
report has data from the beginning of the year through the day the partial consolidation
was run. If a partial consolidation has not been run, the report shows data from the
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beginning of the year through the most recently closed invoice period. You must have
customer profiles and budgets specified in order to use this report.

Location:

From the SAS IT Charge Management main menu, select Reports » To-Date
Reporting.

Activation:

1 From the Reports tab, select To-Date Reporting.

2 The Consolidated Data Selection window opens. Make your selections and press

[OK].
3 A generated job or script appears. You can edit the job or script.

4 You can run the job or script by selecting one of the Submit options from the menu
bar.

5 Review the output to verify that the report has completed successfully.

Site Configuration Report

Description:

The Site Configuration task can be used to document your customizations to SAS IT
Charge Management. It can also pass information to SAS Technical Support. It
generates a report showing all specifications and customizations you have made using
the client interface. The report shows what SAS IT Charge Management is using on the
server when process, reduce, consolidation and invoices are run.

Location:

From the SAS IT Charge Management main menu, select Reports » Site
Configuration

Activation:

1 On the Reports tab, select Site Configuration.

2 The Consolidated Data Selection window opens. Make your selections and press

the [OK].
3 A generated job or script appears. You can edit the job or script.

4 You can run the job or script by selecting one of the Submit options from the menu
bar.

5 Review the output to verify that the report has completed successfully.

Ad hoc Reporting

The SAS IT Charge Management charges are collected and summarized daily so that
they can be reported from various perspectives. All SAS IT Charge Management files
begin with “E”. Each SAS IT Resource Management table in the PDB that is used for
charging also has a corresponding SAS IT Charge Management file in the PDB.

All of the variables are available for ad hoc query and reporting. SHIFT is available
within DETAIL and any of the above summarization levels. Each non-computed SAS IT
Charge Management Charge Item has a direct assignment from a SAS IT Resource
Management variable. To determine the charge item number assigned to a variable, see
“Manage Charge Item Definitions” on page 33.

The SAS IT Charge Management files are SAS data sets. The charges are collected
and summarized daily so that they can be reported from various perspectives. The
process and reduce steps collect data and create tables in the SAS IT Resource
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Management data warehouse (PDB). These tables begin with the letter "E". The rest of
the table name is the same as the SAS IT Resource Management name without the
leading "X" or "U". For example, the SAS IT Resource Management table XPRINT will
have a SAS IT Charge Management "sister" table called EPRINT. By default, all SAS
IT Charge Management tables in the PDB are kept in the DETAIL and MONTH level
libraries only. All SAS IT Charge Management tables in the PDB contain the same
variables. For more information on the variables in these tables, see “File Structures:
Overview” on page 118.

SAS IT Charge Management also has consolidation tables. These tables are not
located in the PDB. Instead they are located in a SAS IT Charge Management library
called siteprefixpath\EC\DATA. This library is located on the server. The
consolidation tables contain a summary of all month level tables for all PDBs in the
site. The consolidation tables contain many of the same variables as the "E" tables in
the PDB. They also contain additional variables such as Modified Charges, Modified
Rate, Apportioned Charges and Apportioned Rate.

Note: For more information on the variables in the consolidation files, see “Variables
in the Consolidation Files” on page 120.

For more information on the variables in the PDB “E” tables, see “Variables in the
PDB "E" Tables Files” on page 120. A

CAUTION:
Because observations in the tables represent various charge items, quantity cannot be
summarized across charge items, unless those charge items represent the same resource
and unit of measurement. For example, you cannot directly summarize quantities for
CPU time if one record stores CPU time in seconds and another stores it in
nanoseconds. A

All of the variables are available for ad hoc query and reporting. Each non-computed
SAS IT Charge Management charge item has a direct assignment from a SAS IT
Resource Management variable. To determine the charge item number assigned to a
variable, see “Manage Charge Item Definitions” on page 33.

Descriptions of variables include associations of any formats with those variables. To
refer to descriptions of the SAS formats used with SAS IT Charge Management, see
“SAS IT Charge Management Formats” on page 101.

How to Create Ad hoc Reports

At this time, there are three ways to create ad hoc reports using SAS IT Charge
Management data:

0O You can create your own reports by writing your own SAS code and using the SAS
IT Charge Management tables as input. You can assign the tables using a
LIBNAME statement and use SET or MERGE statements to use the data for your
report. Before writing reports, you might want to browse the tables to see what
your data looks like. You have the full suite of SAS System reporting procedures
available.

o You can use the templates and reports supplied in Enterprise Reporter. For
information on this topic, see “Use SAS IT Charge Management Data with
Enterprise Reporter” on page 100.

0 You can use the Manage Report Definitions action item in SAS IT Resource
Management. For information on this topic, see “Create Reports Using SAS IT
Resource Management” on page 105.
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Use SAS IT Charge Management Data with Enterprise Reporter

Note: The information in the following topics about Enterprise Reporter applies to
IT Charge Manager 2.3 (which is an earlier version of SAS IT Charge Management that
runs on SAS 8.2) and Enterprise Reporter 2.5 that runs on SAS 8.2 only.

Information about SAS IT Charge Management 2.4 with Enterprise Reporter 2.6 will
be available at the following location: http://support.sas.com/documentation/onlinedoc/
chargemanager/. A

Extract Data from SAS IT Charge Management - Overview

SAS IT Charge Management creates two data extracts: AV and ER. The AV extract
file is used as input to SAS IT Charge Management AccountView. The ER extract file is
used as input to an Enterprise Reporter infofolder. The following topics discuss the
creation, contents and use of the ER extract file. Basic knowledge of SAS IT Charge
Management and Enterprise Reporter is assumed.

SAS IT Charge Management creates an extract file that can be read by Enterprise
Reporter. The extract file is a SAS data set that is produced during the consolidation
process. It combines the data from the consolidation file with the information in the
invoice profiles. The extract file resides on the server and is replaced each time the
consolidation job runs. You can download the extract file from the server using the SAS
IT Charge Management client interface.

The following topics explain how you can create and download an extract file as well
as how to launch Enterprise Reporter and set up the report. In addition, there are
instructions on how to install the Enterprise Reporter InfoFolder for SAS IT Charge
Management data. It also discusses the data structure and the format of the extract file.

If you need any additional information about Enterprise Reporter, refer to the
Enterprise Reporter User’s Guide.

Set up the Extract File

To enable the ER extract file creation, complete the following steps:

1 From the SAS IT Charge Management main menu, select the Site Administration
tab.

2 Then select [Manage the Open Interface].

3 Next select |Extract File Setup].

4 Press the button that is to the right of the window labeled [ER Extract Enabled].
This button toggles between ER Extract Enabled and ER Extract Disabled. If you
want to create the extract file, select the button so that it shows ER Extract
Enabled. If you do not want to create the extract file, select the button so that it
shows ER Extract Disabled.

5 Press to save your specifications, or to return to the previous
specifications.

Extract File and Format Definitions

The ER Extract File is a SAS data set created during the consolidation process. It
combines the data from the consolidation file with the information in the invoice
profiles. This file is replaced on the server each time the consolidation is run.
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Create the Enterprise Reporter Extract File
To create the Enterprise Reporter extract file, complete the following steps:

1 Run one or more data collection jobs (%2CxPROCES, %CPREDUCE).
2 Run a partial or full consolidation. The consolidation job will create the extract file
on the server.

Variables in the ER Extract File

This section lists the variables available in the ER Extract File, contains definitions
of the variables, and discusses the SAS IT Charge Management Formats for ER.

The list below has links to descriptions of all the variables on the ER Extract File.

CHGFMT“CHGFMT” on page 121
CIDESC“CIDESC” on page 121
CUSFMT“CUSFMT” on page 122
CUSTOCHG“CUSTOCHG” on page 123
CUST1CHG“CUST1CHG” on page 124
CUST2CHG“CUST2CHG” on page 124
CUSTCURR“CUSTCURR” on page 122
CUSTORG“CUSTORG” on page 123
DATETIME“DATETIME” on page 125
EOCCURR“EOCCURR” on page 128
EOCHRGE“EOCHRGE” on page 130
EOCITEM“EOCITEM” on page 131
EOCQTY“EOCQTY” on page 131
EOCRATE“EOCRATE” on page 132
EOCTYPE“EOCTYPE” on page 133
EOCUSTn (where n=1 to 9)“EOCUSTn (where n=1 to 9)” on page 133
EOENDTM“EOENDTM?” on page 134
EOINVSD“EOINVSD” on page 135
EOMONTH“EOMONTH?” on page 135
EORMDL“EORMDL” on page 136
EOSTRTM“EOSTRTM?” on page 136
EOYEAR“EOYEAR” on page 137
E1CHARGE“E1CHRGE” on page 137
E1CRATE“E1CRATE” on page 138
E2CHRGE“E2CHRGE” on page 138
E2CRATE“E2CRATE” on page 139
MACHINE“MACHINE” on page 139
SHIFT“SHIFT” on page 140

SAS IT Charge Management Formats

SAS formats are built and used by SAS IT Charge Management. These formats are
created by the consolidation process and are rebuilt on the server each time you run the
consolidation. They are stored in ECSITE.ECUSER on the server. If you download the
extract file, the format catalog is downloaded, too. (For information on this topic, see
“Extract File Download” on page 87.) By default, the format catalog is downloaded to
drive: \[SAS install path]\cpe\chm\ec\ecdown\formats.sas7bcat.



102 SAS IT Charge Management Formats A Chapter 6

This table lists the format names and their descriptions.

Table 6.1 Table of Format Names and Descriptions

Format Name Format Description

$CIDESC Returns description of Charge Item when given the Charge Item
Number.

$CITAB Returns the SAS IT Resource Management table used for charging
when given the Charge Item Number.

$CURDESC Translates the 3-letter currency code into a description, that is,
'BRL’ = 'Brazil, Brazilian Real’.

$CURRFMT Translates the 3-letter currency code into a display format name.
SAS IT Charge Management distributed SAS formats include the
following:

'DEM’ = ’currdem.’
'EUR’ = ’eurol5.2’
"GBR’ = currgbr.’
IEP’ = ’curriep.’
'JPY’ = ’currjpy.’
'NZD’ = ’currnzd.’
'PTE’ = ’currpte.’
'USD’ = "dollar15.2’
other =’15.2".

$CURLONG Translates the 3-letter currency code into a composite string, that
is, 'BRL’ = 'BRL - Brazil, Brazilian Real’.

$ECTYPE Returns the description of the type of charges (EOCTYPE) within
SAS IT Charge Management:

0000= "Regular Charges’
0100="CPU Normalization Charges’
0200= ’Shift Differential Charges’
0400= "Direct Data Load Charges’
0500="Import Data Charges’

9800= "Credit Charges’

9900= ’Debit Charges’

$MNTHNM Month or Period names; defaults to Gregorian calendar month
names.

$SHIFT Shift Names as defined in SAS IT Resource Management.

CURRDEM Defines how to display charges when given the currency code of

DEM, Germany, Deutsche Mark:
low-<0="000.000.009,99DM’(mult=100 prefix="-")
0-high="000.000.009,99DM’(mult=100)
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Format Name Format Description

CURRGBR Defines how to display charges when given the currency code of
GBP, Great Britain, Pound Sterling:

low-<0="000,000,009.99-"(prefix="£")
0-high="000,000,009.99’(prefix="¢")

CURRIEP Defines how to display charges when given the currency code of
IEP, Ireland (Eire), Punt:

low-<0="000,000,009.99 IEP (prefix="-")
0-high="000,000,009.99 IEP’

CURRJPY Defines how to display charges when given the currency code for
JPY, Japan Yen:

low-<0="000,000,009.99- (prefix="¥")
0-high="000,000,009.99(prefix="¥")

CURRNZD Defines how to display charges when given the currency code of
NZD, New Zealand, dollar:

low-<0="000,000,009.99NZ’(prefix="-$")
0-high="000,000,009.99NZ’(prefix="$")

CURRPTE Defines how to display charges when given the currency code of
PTE, Portugal, Escudo:

low-<0="000,000,009$99-(mult=100)
0-high="000,000,009$99’(mult=100)

Get the Data and Formats to Enterprise Reporter

Download the Extract File and Formats

Download the extract files after you are satisfied that the consolidation and the
extract creation have completed successfully. The download task copies the extract file
from the server to the client directory that is specified in a dialog window.

Note: Before you can download the extract file, you must first install the Enterprise
Reporter InfoFolder. A

1 From the SAS IT Charge Management main menu, select the Operations tab.
2 Select [Extract File Download].

3 Verify that the target paths and PC files for extract data are correct. The defaults
are:

SAS 8.2

For AccountView:

drive:\[SAS install path]\cpe\chm\ec\ecdown\eiscon.sas7bdat
For Enterprise Reporter:

drive:\[SAS install path]\cpe\chm\ec\ecdown\itcmerxtr.sas7bdat

4 If either path or PC file is not correct, overwrite the current value with the correct
one.

5 If both the paths and the PC files are correct, select to download the file
from the server to the client.
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6

Click to return to the previous window.

Update the SAS IT Charge Management InfoFolder with Your Data

The following checklist shows how to use the Enterprise Reporter InfoFolder for SAS
IT Charge Management data. These instructions enable you to have multiple SAS data
sets using the same InfoFolder. All the files will have the same structure and can be
combined to create quarterly or year-to-date reports.

1

o Ol AW

8
9

Copy the extract file (itcmextr.sas7bdat or itcmextr.sd2) from drive: \[SAS
install path]\cpe\chm\ec\ecdown to drive: \[SAS install
path]\Business\.

Copy the format catalog (formats.sas7bcat or formats.sc2) from drive: \[SAS
install path]\cpe\chm\ec\ecdown to drive: \[SAS install
path]\Business\.

Launch Enterprise Reporter.

Click to close the Report Gallery and return to the previous window.
From the menu bar select Tools » Manage InfoFolders

From the User tab, select SAS IT Charge Management Data.

Note: This should be the only InfoFolder. A

Right click and select from the drop-down menu. The InfoFolder is now
updated with the new data.

Click on [Report Gallery).
Select the SAS IT Charge Management tab.

10 Select a report.

Instructions for Installing the ITCM 2.3-ER 2.5 files on SAS 8.2

The following checklist shows how to install the Enterprise Reporter InfoFolder for
SAS IT Charge Management data. These instructions allow you to have multiple SAS
data sets using the same InfoFolder. All the files will have the same structure and can
be combined to create quarterly or year-to-date reports.

Ensure that your SAS release is at SAS 8.2.

Use a text editor to edit drive: \[SAS install
path]\cpe\chm\ec\ER8\ER8COPY.BAT. At the top of the file, you will see three
locations to specify for your environment.

3 Specify the locations and save the changes.
4 Execute the batch file, ER8cOPY.BAT. It will copy the files from SAS IT Charge

Management to Enterprise Reporter. The table below lists the files and the
locations to which they are copied.

After ER8COPY.BAT completes, launch Enterprise Reporter using an administrator
logon id.

6 If the Report Gallery is displayed, click and then to close it.
7 From the menu bar select Tools » Manage InfoFolders
8 From the User tab, select the SAS IT Charge Management Data InfoFolder.

Note: This should be the only InfoFolder displayed. A
Right click and select update from the drop-down menu.

Note: This selection will be grayed out unless you used an administrator logon
id to access Enterprise Reporter. A
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10 Click [Report Gallery|.
11 Select the SAS IT Charge Management tab.
12 Select a report. You can now review reports. They will be populate with data from

the demonstration Enterprise Reporter extract file that is supplied with SAS IT
Charge Management.

The script, ER8COPY.BAT, copies SAS IT Charge Management 2.3 Sample Data and
Reports to Enterprise Reporter. It contains the three variables which must be updated
to point to your installation directories. The variables (listed below) are used in the
following table. The table shows the installation files and locations which they are
copied to.

_ITCMLOC is the directory where SAS IT Charge Management has been installed.

_ERLOC is the directory where Enterprise Reporter has been installed.

_USERLOC is the user directory for Enterprise Reporter InfoFolders.

Note: This user directory should be the same as the one found in the admin.ini
file under the Enterprise Reporter installation path. It should be similar to
drive:\[SAS install path]\Business\admin.ini. A

Table 6.2 Installation Files and Locations

Name: File or Folder: Is Copied To:

[_ ITCMLOCI\EC\ERS8SAS IT Charge Folder [ ERLOC]\Gallery\SAS IT Charge
Management Management

[_ ITCMLOCJ\EC\ER8\SAS IT Folder [_LUSERLOC]\SAS IT Charge
Charge Management Data Management
[_LITCMLOCI\EC\ERS8\SAS IT File [ USERLOC]

Charge Management Data.ERD

[_LITCMLOCI\EC\ERS\ITCM Folder [ ERLOC]\demodata\ITCM

[_ ITCMLOCI\EC\ERS8\autoexec.sas File [LERLOC]
[_LITCMLOC]J\EC\ER8\SAS.bmp File [LERLOC]\Demodata\Clipart

Create Reports Using SAS IT Resource Management

Because the SAS IT Charge Management tables in the PDB are SAS IT Resource
Management tables, SAS IT Resource Management reporting can be used with them.
Before you generate reports in SAS IT Resource Management, you have to determine
your report design:

Do you want a graph or tabular report?
What information should be included?

Once you have determined your design, you can go into the SAS IT Resource
Management client and select a PDB to report from. The PDB must be the active PDB.
The PDB can either be local to the client or on a remote server.

Go to the SAS IT Resource Management Manage Report Definitions tab. You can
customize a report definition based on a supplied report definition or you can create
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your own report definition. You can save the report definition in interactive form or
save the macro code for batch processing.

Access Your Data with AccountView

To utilize the reporting features of AccountView, follow the instructions to:

1
2
3
4

“Download the Extract File to Your Client Platform” on page 106
“Prepare the Tables You Want to Work With” on page 106

“Launch SAS/EIS (the Enterprise Information System)” on page 107
“Explore Your Reports” on page 107

Note: Before you use the AccountView function, you must successfully complete
your daily data collections (with the process and reduce functions). A

Download the Extract File to Your Client Platform

Launch SAS IT Charge Management.

Select a site from the Site Selection box and press [Open]. Activate the PDB
you want to work with.

From the Site Administration tab, select Manage Open Interface » Extract
Data Setup

4 Click the button so that it displays AV Extract Enabled.
5 Using the key with your cursor, highlight the customer keys you want to

explore. Click .

From the Operation tab, select Consolidate Data: Edit and execute the batch
consolidation

Choose the invoice period you want to consolidate and click the process option
Apply Selections and Submit Immediately. Click [OK |. After the consolidation job
completes, view the log by pressing on the upper left corner and check for a
message to ensure that the file was successfully downloaded.

Close the window and return to the Operation tab. Select Extract File
Download: Copy the current extract file to your PC

Press the button next to the path for the Accountview target
extract file in order to download the file. If there is no problem with the
downloading, a message stating “Download completed successfully” will display at
the top of the window.

Exit ITCM.

Prepare the Tables You Want to Work With

1
2

Launch AccountView.
From the upper toolbar, select Window » Log

Verify that there is a message that says Extract file copied from
ecdown.EISCON to ECCON.Cnnnnnnn, where nnnnnnn is the numeric value of the
unformatted SAS date on which the table was copied from ITCM Administrator to
ITCM AccountView. Then, minimize the Log window.
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3 In the AccountView window, click on [Select Table].
4 Using the arrow to the right of the Repository field, select ECCON as the path.

5 Then, using the arrows in the middle of the window, select the table you saw
copied (eccon.cnnnnnnn) and move it from the Available list to the Selected list.
When you are satisfied with your selections, click [OK].

6 Select Window » Log and then verify that there is a message that says "Note:
Selected table copied from ECCON.Cnnnnnnn to ECCON.CONFILE".

Launch SAS/EIS (the Enterprise Information System)

1 If you are running SAS 9.1.3 or later, select Solutions » Development and
Programming » EIS/OLAP Application Builder

2 From the SAS/EIS main menu, double-click on the icon.

3 Using the arrow to the right of the Repository field, select ECCON as the path and
then YTD Consolidation File from the list of available tables.

4 Select Columns » Add » Table Column

5 Move the additional customer keys from Available to Selected. (This registers
your additional customer key levels in the YTD Consolidation File.)

6 Select OK » CLOSE to return to the Metabase dialog.

7 Highlight the YTD Consolidation File. Select HIERARCH attribute » Edit »
Nodes hierarchy

8 Move the additional customer key fields from Available to Selected.

9 When you are satisfied, click OK » CLOSE » CLOSE (or minimize) the SAS/
EIS main menu

Explore Your Reports

1 Select Revenue by Customer

2 Double-click on a pie slice that you want to view in more detail.

3 Repeat this drilling down until you reach the level you want to explore, or until
you reach the lowest level.

Note: Use the arrows in the upper right portion of the window to move back up
through the reporting levels of the Revenue display. A
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Administrative Status: Overview

The Administrative Status tab enables you to determine the status of action items
that pertain to a PDB or to a site. You can also perform all administrative tasks for the
selected PDB or the site by selecting the task from a list that opens when you click on
the Administrative Status tab. After the task is selected, you are taken directly to the
windows needed to complete that task.

This section describes how to use the SAS IT Charge Management Administrative
Status window.

Note: All administrative tasks can be performed from the Administrative Status tab
of the SAS IT Charge Management client interface. A

Use SAS IT Charge Management Administrative Status

To use the Administrative Status window, select the Administrative Status tab from
the SAS IT Charge Management main menu.

=loix]
ﬂl IT Charge Management Demo ilﬁl

EI cilitem 2.4%chm'ec\ecdemo’,
User: sasmoh

Site Administration 1 hanage POBs ] Operation ] Reports Administrative Status
Click an Action Item to Administer the Site or PDB.
Action Iterns
Legend Status s
I SITE 1: Execution controls
® =Required 7 & SITE 2: Calendar definitions
7 =Specified v SITE 3: Default currency
v SITE 4: Customer Hame Key Structure
@ =Missing 2w SITE 5: Edit Customer ID Routine
_ £y SITE 6: Customer Profile Information
=R I SITE 7: Charge |tem Properties
£, =Uncerain status I SITE &: Charge |tem Groups
SITE 9: Import/Export definitions
v Doun v

Close Help
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The Action Items sub-menu displays a list of site-related tasks and PDB-related
tasks that you can perform. A performance data warehouse (PDB) must be selected to
use Administrative Status. After a PDB is selected, a list of action items is displayed.
This checklist shows the tasks that can be used to customize a SAS IT Charge
Management site. Select an action item with the left mouse button in order to go
directly to the specific task. The items are listed in sequence.

If a new site is being specified, a red "stop sign" appears next to the action item that
is labeled Execution Controls. When you select the first action item, Execution
Controls, the window that is used to make that specification appears. Once the entry
has been made and is pressed, you are returned to the list of action items to
perform the next task. A check mark appears next to the first action item indicating
that the execution controls have been specified.

There are additional action items that are PDB-specific. By following each of these
items in order, you can see the steps that need to be taken to ensure a successful
implementation. Each of these items can be found from other tabs on the SAS IT
Charge Management client interface, but Administrative Status provides a central
location that can be used to access the action items directly.

The Legend shows the possible status of action items that can be performed against
the site and PDB:

Table 7.1 Table of Legends

Legend Item Description

Required This Legend item is placed next to an action item that is required
for SAS IT Charge Management to work. There are no default
values for a required action item. A specification is mandatory.

Specified This Legend item shows which action items have been specified. It
does not indicate if the specification is valid, only that the
specification was made.

Missing This Legend item indicates that an action item is not specified.

N/A N/A means "Not Applicable" to this site or PDB. An example is the
specification of JCL statements for a site that uses UNIX or
Windows for the server host.

Uncertain Status Uncertain Status displays when SAS IT Charge Management
cannot determine whether an action item is specified.
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Maintenance: Overview

This section discusses maintenance issues and user modifications.

Periodic Maintenance Application

Maintenance for SAS IT Charge Management is available periodically. Maintenance
includes new features, enhancements, updates, and fixes. Late-breaking information on
SAS IT Charge Management, tips and hints, FAQs (frequently asked questions), and
customer feedback can be obtained from the SAS IT Management Solutions section on
the SAS Web site, www.sas.com.

SAS IT Charge Management maintenance is available on PC-readable media. An
overview of the maintenance along with the appropriate documentation accompanies
the shipment. The SETUP utility on the maintenance distribution medium prompts you
to fill in the required information for the maintenance software to be downloaded. It
also refers you to the checklist or README file as needed.

Run Setup for SAS IT Charge Management Maintenance

1 Start Windows.

2 Insert the SAS IT Charge Management distribution media into the appropriate
drive.

3 Start the SETUP program for SAS IT Charge Management by selecting START »
SETTINGS » CONTROL PANEL » Add/Remove Programs » Install
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4 Follow the prompts.

Related Software Maintenance Effects

SAS IT Charge Management works closely with several other products. Therefore,
updates to these products can have an effect on SAS IT Charge Management. The
following sections explain the relationships among the various products and offers
precautions where appropriate.

SAS Software

SAS IT Charge Management uses only Base SAS software products (including the
macro language facility) and SAS/CONNECT on the z/OS, UNIX and Windows servers.
In general, applying ZAPs to the server SAS libraries should not cause any problems for
SAS IT Charge Management. However, before you upgrade to an entirely new version
of Base SAS software, contact SAS Technical Support to verify that SAS IT Charge
Management has been tested with the new version.

0 The SAS System for Windows

SAS IT Charge Management uses many SAS products on the PC. Always
contact SAS Technical Support to verify the effect that changes to the SAS System
for Windows can have on SAS IT Charge Management.

SAS IT Resource Management

SAS IT Charge Management is an add-on to SAS IT Resource Management software.
Changes in SAS IT Resource Management’s exit points or processing macros are likely
to affect SAS IT Charge Management. Always contact SAS Technical Support to verify
the effects that changes to SAS IT Resource Management can have on SAS IT Charge
Management.

0 SAS IT Resource Management for z/OS

Changes to JCL or procedures for the process and reduce tasks or for
CPDDUTL can affect SAS IT Charge Management. In SAS IT Charge
Management, update Execution Controls; then, regenerate JCL.

0 SAS IT Resource Management for Open Systems

Changes to scripts for the process and reduce tasks or for CPDDUTL processing
are likely to affect SAS IT Charge Management. In SAS IT Charge Management,
update Execution Controls; then, regenerate your scripts.

0 SAS IT Resource Management for Windows

Changes to scripts for the process and reduce tasks or for CPDDUTL processing
are likely to affect SAS IT Charge Management. In SAS IT Charge Management,
update Execution Controls; then, regenerate your scripts.

SAS/CONNECT

To exchange data between the host and client, SAS IT Charge Management uses
SAS/CONNECT. Most often this is accomplished using PROC UPLOAD or PROC
DOWNLOAD. Changes to your network will probably require changes to your logon
script. Contact SAS Technical Support to verify how changes to SAS/CONNECT affect
SAS IT Charge Management.
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MXG

Changes to MXG can directly affect your charges. On z/OS, MXG processes the raw
SMF records into SAS files. Your charges are affected if MXG changes either the
staging or the location of the element being charged. If you are unsure of the MXG
element used for a charge item, open the SAS IT Charge Management Charge Item
Definitions and look at the charge items you use. (See “Manage Charge Item
Definitions” on page 33.) If the variable name for the charge item number begins with a
C_, then it is a computed charge item. Select the charge item, and edit the computation
routine to view all elements involved in the calculation of the charge. If the charge
item’s SAS IT Resource Management table is created by MXG, the element names are
the MXG element names. Check each charge item or its computation routine against
your list of MXG changed elements.

User Modifications

User modifications can be installed by the SAS IT Charge Management
Administrator or by a consultant. Be sure to keep thorough and accurate records of any
user modifications.

SAS IT Resource Management Exit Points

SAS IT Charge Management utilizes some of the SAS IT Resource Management exit
points that are available in the %CxPROCES macro. The %CxPROCES macro has an
EXITSRC= parameter whose value can be specified in the form libref.catalog_name,
where libref is a pointer to a SAS library and catalog_name is a SAS catalog in that
library. The catalog contains one or more modules that run at %CxPROCES exit points.
The name of each module matches the name of the exit point at which it runs.

The following table shows the names of the modules in ECSITE.ECEXITS and the
complete contents of each module:

Table 8.1 Table of Modules in ECSITE.ECEXITS

Module Contents Comments
PROC100 %EC_X100;

PROC135 %EC_X135 See note.
PROC200 %EC_X200;

PROC205 %EC_X205;

PROC230 %EC_X230;

Note: For more information on the use of semicolons, see “Trailing Semicolons” on
page 115. A

In the first call to %CxPROCES in the daily job, each call in ECEXITS is used at the
exit point in %CxPROCES that matches its name. Each macro call resolves to an exit
routine that is installed as part of SAS IT Charge Management. Logic in the SAS IT
Charge Management exit code invokes SAS macros. The macros load when the
following statement executes: $INCLUDE SCNTL (ECSTART) ;
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These macros resolve only if accounting is active for the table being processed. SAS
IT Charge Management activates accounting for a SAS IT Resource Management table
if a charge item in the Charge Item table is defined to use a variable from the SAS IT
Resource Management table and if the active (ACT) check box of the charge item is
checked.

This table shows the ECSITE.ECEXITS2 entries and their contents:

Table 8.2 Table of Modules in ECSITE.ECEXIT2

Module Contents Comment

PROC095 %ES_X095 No semicolon is used - see note below
PROC225 %ES_X225;

PROC230 %ES_X230;

Note: For more information on the use of semicolons, see “Trailing Semicolons” on
page 115. A

In the second call to %2CxPROCES in the daily job, each call in ECEXITS2 is used at
the exit point in %CxPROCES that matches its name. Each call resolves to an exit
routine that is installed as part of SAS IT Charge Management. The macros load when
the statement $INCLUDE SCNTL (ECSTART) executes. These macros only resolve when
SAS IT Charge Management tables are processed.

The setup at your site can fall into one of these three cases.

Note: The %CxPROCES macro call in the original (SAS IT Resource Management
only) daily job becomes the first of two %CxPROCES macro calls in the revised (SAS IT
Resource Management and SAS IT Charge Management) daily job. A

0 Case #1:

SAS IT Resource Management does not use any of the %2CxPROCES exit points.

To process data in a way that SAS IT Charge Management can also make use of it,
you or the IT Resource Management administrator needs to do the following.

1 In the first %CxPROCES macro call in the daily process and reduce job, set
EXITSRC=ECSITE.ECEXITS, where ECSITE is a predefined libref that points
to a IT Charge Management library and ECEXITS is one of the catalogs in
that library.

2 In the second %CxPROCES macro call in the daily process and reduce job, set
EXITSRC=ECSITE.ECEXITS2, where ECSITE is the same libref as above and
ECEXITS2 is another of the catalogs in that library.

3 You do not need to do anything more for the exit points.

Note: In the library to which ECSITE points, the modules in the catalogs
contain 8- or 9-character strings. The strings are macro calls, with or without
trailing semicolons. A

o Case #2:

SAS IT Resource Management uses some %CxPROCES exit points, but none of
them are the ones for which modules are supplied in ECSITE.ECEXITS.

1 Merge the IT Resource Management modules and the first set of IT Charge
Management modules (the ECEXITS modules) into the same catalog and set
EXITSRC= to point there.

Example: Suppose IT Resource Management uses the PROCO080 exit to
create derived variables (by the method in use in prior releases of the
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software). The (first) %CxPROCES macro has EXITSRC=mylibrary.myexits,
where mylibrary is a libref that points to a library that has a catalog named
myexits, which has an entry named PROCO080.

You need to combine the SAS IT Resource Management entries and SAS
IT Charge Management entries in the same catalog, because the EXITSRC=
parameter can have only one value. Because the EXITSRC= parameter
already points to mylibrary.myexits, you can create (copies of) the SAS IT
Charge Management entries in that library. You can use the SAS program
editor or any other text editor (such as ISPF edit) to create your entries.

Be sure to name the modules exactly as shown in the first table above,
the ECEXITS table, and type their 8— or 9—character contents exactly as
shown in that table.

2 Same as Case #1.
3 Same as Case #1.
o Case #3:

SAS IT Resource Management uses some %CxPROCES exit points, and at least
one of them is supplied in ECSITE.ECEXITS.
1 Merge the contents of the same-named entries and merge the SAS IT

Resource Management entries and the remaining entries in the ECEXITS
into the same catalog and set EXITSRC= to point there.

Example: Suppose there is a PROC200 entry in the catalog used by SAS
IT Resource Management and in the ECEXITS catalog. Other conditions
exist as described in Case #2.

You need to append the contents of the IT Charge Management entry to
the contents of the IT Resource Management entry.

Because you are going to use the IT Resource Management catalog, edit
the contents of the IT Resource Management entry: append the character
string $EC_X200; at the end of the IT Resource Management entry.

Create the remaining IT Charge Management entries from ECEXITS in
the IT Resource Management catalog, as described in Case #2.

2 Same as Case #1.

3 Same as Case #1.

Trailing Semicolons

Some macro references in SAS IT Resource Management exits do not have a trailing
semicolon and some others do have a trailing semicolon. Using a semicolon to delimit
the macro invocation is the most efficient way to code the invocation for the SAS macro
language compiler. However, omitting the semicolon results in satisfactory compilation,
but it might run a little slower. Some exit points require that macros referenced within
them do not use a delimiting semicolon.

IT Charge Management exit macros are invoked at different points in IT Resource
Management. Some are between DATA or PROC steps. Some are within DATA or
PROC steps. Some are within SAS statements. When the exit point exists within a
SAS statement, a semicolon would end the statement prematurely. In such a situation,
trailing semicolons must not be used.

For example, the PROC095 exit exists to add parameters inside a PROC SORT
statement, immediately before the NODUP operand. The IT Charge Management
PROCO095 macro call (%2ES_X095 without a semicolon) resolves to the following code:

e %
’
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Inserting these characters in the PROC SORT statement results in
PROC SORT ... ; * NODUP;

which comments out the NODUP operand.
If, by accident, you added a semicolon to the contents of PROC095, inserting the
characters shown above plus the accidental semicolon would result in

PROC SORT ... ; * ; NODUP;
which would result in an ERROR message (ERROR 180) and termination of the job.
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File Structures: Overview

This appendix provides details on data files and source and parameter libraries used
by SAS IT Charge Management. It includes information on

0 “Site Common Libraries” on page 118

0 “Variables in EC_SC (Debit and Credit File)” on page 119

O “Variables in the Consolidation Files” on page 120

O “Variables in the PDB "E" Tables Files” on page 120.

Site Gommon Libraries

This table lists the Site Common Libraries. Site Common Libraries are those related
to a specific SAS IT Charge Management Site. These libraries contain modules and files
common to all PDBs for one SAS IT Resource Management server installation used by
SAS IT Charge Management.

Table A1.1 Table of Site Common Libraries

Libref/Fileref Catalog or File Name Description
SITELIB - Modifiable SAS IT Resource Management
modules

- SAS IT Charge Management bootstrap source

member
SASAUTOS SAS IT Resource Management autocall library
ECSCNTL JCL and jobstreams for site-specific jobs
ECLIB ITCMGUI catalog SAS IT Charge Management software that is
not user modifiable
ECUSER catalog Site and PDB-related default specifications
EC_CI data table Default Charge Item Table
ECSITE SAS IT Charge Management SAS IT Charge Management software that is
catalog not user modifiable

(See Note 1)
SAS IT Charge Management - User-modifiable SAS IT Charge Management

software that is not user source
modifiable - Generated SAS IT Charge Management

(See Note 1) source and formats

EC_IN data table Invoice data table

EC_CA data table Accounting Calendar table

EC_CG data table Charge Item Grouping table

EC_RF data table Report Format table

EC_PR data table Customer Profile table

EC_SO data table Site Options of SAS IT Charge Management
(See Note 2)

EC_PO data table PDB Options (PDB Table) for SAS IT Charge

(See Note 2) Management
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Libref/Fileref Catalog or File Name Description
EC_CI data table User-modifiable Charge Item Table
ECAUTO SAS IT Charge Management autocall library
(SCP-sensitive format)
ECDATA - SAS IT Charge Management Budget data
- Non-PDB-specific data
E_nnnnn data table Consolidation data for Invoice Period starting
(See Note 3) on day nnnnn
E__COND data view View of all resident consolidation data
(See Note 3)
E__CONP data view View of the most recent consolidation period
(See Note 3)
EC__KEY data table Key Value file used by Key Fill in Debit/Credit
(See Note 3) and Profile edits
EC_SC data table Supplemental Charges (Debits/Credits)
(See Note 3)
ECXTRCT data table Extract data for AccountView from the last run
(See Note 3) of consolidation (only)
Note:

A

1 Populated during SAS IT Charge Management installation.

2 Populated during SAS IT Charge Management initialization or customization.

3 Populated during the first and subsequent Consolidation runs.

Variables in EC_SC (Debit and Credit File)

“DATETIME” on page 125
“DCDESC” on page 125
“DCEDATE” on page 126
“EOCCURR” on page 128
“EOCHRGE” on page 130
“EOCITEM” on page 131
“E0CQTY” on page 131
“EOCRATE” on page 132
“EOCTYPE” on page 133
“EOCUSTn (where n=1 to 9)” on page 133
“EOINVSD” on page 135
“EOMONTH” on page 135
“EORMDL” on page 136
“EOYEAR” on page 137
“MACHINE” on page 139

O 0ooooooooooo oo o
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o “SHIFT” on page 140
o “SWIT” on page 140.

Variables in the Consolidation Files

“DATETIME” on page 125
“EOCCURR” on page 128
“EOCHRGE” on page 130
“EOCITEM” on page 131
“E0CQTY” on page 131
“EOCRATE” on page 132
“EOCTYPE” on page 133
“EOCUSTn (where n=1 to 9)” on page 133
“EODAY” on page 134
“EOENDTM?” on page 134.
“EOINVSD” on page 135
“EOMONTH” on page 135
“EORMDL” on page 136
“EOSTRTM” on page 136
“EOYEAR” on page 137
“E1CHRGE” on page 137
“E1CRATE” on page 138
“E2CHRGE” on page 138
“E2CRATE” on page 139
“MACHINE” on page 139
“SHIFT” on page 140

Oo0Ooo0oDooooo0oooooooonoooaoaoad

Variables in the PDB "E" Tables Files

“DATETIME” on page 125

“EOAUDID” on page 126 (detail only)
“EOCCURR” on page 128

“EOCHRGE” on page 130

“EOCITEM” on page 131

“EO0CQTY” on page 131

“EO0CQTY_S” on page 132 (in higher reduction levels only)
“EOCRATE” on page 132

“EOCTYPE” on page 133

“EOCUSTn (where n=1 to 9)” on page 133
“EODAY” on page 134

“EOENDTM” on page 134

“EOMONTH” on page 135

“EORMDL” on page 136

“EOSTRTM” on page 136

“EOYEAR” on page 137

“MACHINE” on page 139

“SHIFT” on page 140

Ooooooooooooooooogao
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CHGFMT

Table A1.2 CHGFMT

Attribute Actual Default

Name CHGFMT CHGFMT
Label Charge Format Charge Format
Length 8 8

Type Character Character
Format $8 $8

By Variable No No
Description:

Charge Format contains the name of the display format for the Original Charges.
The contents of this field are used by the SAS IT Charge Management Standard Invoice
program to determine how to display the Original Charges. A similar field called
CUSFMT stores the name of the display format for the Profile Charges. This variable
exists on the extract file only.

Notes:

For information about using supplied formats in SAS IT Charge Management, see
“SAS IT Charge Management Formats” on page 101. See also: Multi-currency Support
in the Glossary.

CIDESC

Table A1.3 C1DESC

Attribute Actual Default
Name CIDESC CIDESC
Label Charge Item Description Charge Item Description
Length 32 32
Type Character Character
Format None None
By Variable No No
Description:

The CIDESC field is created by looking up the Charge Item Number against the
$CIDESC format. The format is created from the Description field of a Charge Item
Definition. The description field is a place to describe the resource associated with the
Charge Item Number. The Charge Item Description field is blank by default when you
add a new charge item definition. It is populated by the user when a definition is added
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or updated in the SAS IT Charge Management client interface. The field can contain up
to 32 characters, numbers, blanks and national characters. It can not contain percent

signs (%) or ampersands (&).

Notes:

See also: “Manage Charge Item Definitions” on page 33.

CUSFMT

Table A1.4 CUSFMT

Attribute Actual Default

Name CUSFMT CUSFMT

Label Organization Organization

Length 8 8

Type Character Character

Format $8 $8

By Variable No No
Description:

Customer Format contains the name of the display format for the Profile Charges.
The contents of this field are used by the SAS IT Charge Management Standard Invoice
program to determine how to display the Profile Charges. A similar field called
CHGFMT stores the name of the display format for the Original Charges. This variable
exists on the extract file only.

For information about using supplied formats in SAS IT Charge Management, see

“SAS IT Charge Management Formats” on page 101.

Notes:

See also: Multi-currency Support and Invoice Profile in the Glossary.

CUSTCURR

Table A1.5 CUSTCURR

Attribute Actual Default
Name CUSTCURR CUSTCURR
Label Organization Organization
Length 3 3

Type Character Character
Format None None

By Variable Yes Yes

Description:



File Structures /\ GCUSTOCHG 123

CUSTCURR is the currency of preference as defined in the Invoice Profile. The value
of currency depends on what was defined in the Currency action item and what was
defined in the Invoice Profile for the customer. The currency value selected in the
Currency action item is the default currency. The currency value selected in the
Customer Profile overrides the default currency. This variable exists on the extract file

only.
Notes:

For a list of acceptable values for CUSTCURR, refer to “EOCCURR” on page 128.

CUSTORG

Table A1.6 CUSTORG

Attribute Actual Default

Name CUSTORG CUSTORG

Label Organization Organization

Length 44 44

Type Character Character

Format None None

By Variable Yes Yes
Description:

CUSTORG is a variable that stores the name of the Invoice Profile associated with
the Customer Name Key structure for the observation. This variable exists on the

extract file only.
Notes:

See also: Invoice Profile in the Glossary.

CUSTOCHG

Table A1.7 CUSTOCHG

Attribute Actual Default

Name CUSTOCHG CUSTOCHG

Label Customer Original Charge Customer Original Charge
Length 8 8

Type

Numeric

Numeric
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Attribute Actual Default

Format None None

By Variable No No
Description:

The Customer Original Charge contains the charge converted from the EOCHRGE
field to the currency specified in the Invoice Profile. This charge is available only on the

extract file.
Notes:

See also: Multi-currency Support in the Glossary.

CUST1CHG

Table A1.8 CUST1CHG

Attribute Actual Default
Name CUST1CHG CUST1CHG
Label Customer Modified Charge Customer Modified Charge
Length 8 8
Type Numeric Numeric
Format None None
By Variable No No
Description:

The Customer Modified Charge contains the charge converted from the EICHRGE
field to the currency specified in the Invoice Profile. This charge is available only on the

extract file.
Notes:

See also: Multi-currency Support in the Glossary.

CUST2CHG

Table A1.9 CUST2CHG

Attribute Actual Default

Name CUST2CHG CUST2CHG

Label Customer Apportioned Charge Customer Apportioned Charge
Length 8 8

Type

Numeric

Numeric
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Attribute Actual Default

Format None None

By Variable No No
Description:

The Customer Apportioned Charge contains the charge converted from the
E2CHRGE field to the currency specified in the Invoice Profile. This charge is available

only on the extract file.

Notes:

See also: Multi-currency Support in the Glossary.

DATETIME

Table A1.10 DATETIME

Attribute Actual Default

Name DATETIME DATETIME

Label Date and Time Date and Time

Length 8 8

Type numeric numeric

Format datetimel9 datetimel9

By Variable no no
Description:

The DATETIME variable contains the date and time the record was created. This
variable is assigned directly from the record in the SAS IT Resource Management table

being processed.

DCDESC

Table A1.11 DCDESC

Attribute Actual Default

Name DCDESC DCDESC

Label Description of Entry Description of Entry
Length 32 32

Type Character Character

Format none none

By Variable No No
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Description:

The DCDESC field is a place to describe the reason for the debit or credit being
entered. The Description of Entry field is blank by default. It is populated by the user
when a Debit or Credit is entered in the SAS IT Charge Management client interface.
It can also be populated in an Import Template. The field can contain up to 32
characters, numerics, blanks and national characters. It can not contain percent signs

(%) or ampersands (&).

Notes:

See also Supplemental Charges (“Debits and Credits” on page 40) and Import
Template in “Import/Export” on page 42.

DCEDATE

Table A1.12 DCEDATE

Attribute Actual Default

Name DCEDATE DCEDATE

Label Effective Date Effective Date

Length 8 8

Type Numeric Numeric

Format date9 date9

By Variable Yes Yes
Description:

The DCEDATE variable contains the date the record should be used. This variable is
created during import processing or in the Supplemental Charges window of the SAS IT
Charge Management client. If you do not specify an effective date, the current system

date is used.
Notes:

See also Supplemental Charges (“Debits and Credits” on page 40) and the Import
Template in “Import/Export” on page 42.

EOAUDID

Table A1.13 EOAUDID

Attribute Actual Default
Name EOAUDID EOAUDID
Label user-defined Audit Id
Length 1-72, user-defined 1

Type character character
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Attribute Actual Default
Format user-defined none
By Variable yes yes
Description:

The Audit Identifier is kept only at the DETAIL level of the SAS IT Charge
Management PDB tables. The attributes for this variable are defined in the Customer
Name Key Structure in the SAS IT Charge Management Client. You do not have to
define or use the audit identifier field. If you choose not to use it, set the length to 1
and populate it with a single blank in the Customer Identification Routine. Otherwise,
set the length and label in the Customer Name Key Structure. The value of this
variable is populated in the customer identification routine. EOAUDID is used to audit
the detail observations. During %CSPROCES, the Customer Identification Routine code
is included in the processing. At that time all of the variables from the SAS IT
Resource Management table are available for use to populate the Customer Name Keys
and the Audit Identifier. Sometimes SAS IT Resource Management table variables
might be used to conditionally populate keys, but these variables are not retained on
the SAS IT Charge Management tables. For auditing purposes, it might be important
to know the value of these variables.

You can customize the LENGTH and DESCRIPTION attributes of EOAUDID. The
DESCRIPTION (label) of each field can have a length of 1 to 40. All descriptions are
character strings. Leading and trailing blanks are removed. Embedded blanks are
preserved. Some special characters are not enabled. These special characters are
translated into different characters if you use them. A double quote (") is translated to
a single quote (). An ampersand (&) is translated to a plus sign (+). A percent sign (%)
is translated to a forward slash (/). Any other special character is preserved.

Example:

You can have a variable on your SAS IT Resource Management table called "fieldA".
In the Customer Identification Routine you can check fieldA’s first two characters for
particular values and can conditionally populate customer name key 1. Depending on
the value found, a particular format is used with fieldA to derive the key value. In this
situation you could place the original value of fieldA and the name of the format in the
audit identifier field.

Note: Because key 1 contains the value returned from the format, the ability to find
the contributing record from the SAS IT Resource Management table is lost. However,
by using the audit id field to store the value of fieldA and the name of the format
associated with fieldA, then you have an audit trail. A

Notes:
See also “Customer Name Key Structures” on page 25 and “Customer Identification
Routine” on page 26.
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EOCCURR

Table A1.14 EOCCURR

Attribute Actual Default

Name EOCCURR EOCCURR

Label Currency Currency

Length 3 3

Type character character

Format none none

By Variable yes yes
Description:

EOCCURR is the currency of the incurred original charges. The value of currency
depends on what was defined in the Currency action item and what was defined in the
Customer Profile. The currency value selected in the Currency action item is the
default currency. The currency value selected in the Customer Profile overrides the
default currency.

EOCCURR can have the following values:

Table A1.15 Table of EOCCURR Values

Currency Symbol Currency Description
ARP Argentina, Peso

ATS Austria, Schilling

AUD Australia, Dollar

BBD Barbados, Dollar

BEF Belgium, Franc

BGL Bulgaria, Lev

BMD Bermuda, Dollar

BRR (BRL) Brazil, Brazilian Real
BSD Bahamas, Dollar

CAD Canada, Dollar

CHF Switzerland, Franc
CLP Chile, Peso

CNY China, Yuan Renminbi
CSK(CZK) Czech Republic, Koruna
CYP Cyprus, Pound

DEM Germany, Deutsche Mark
DKK Denmark, Krone

DZD Algeria, Algerian Dinar
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Currency Symbol

Currency Description

EGP
ESP
EUR
FIM
FJD
FRF
GBP
GRD
HKD
HUF
IDR
IEP
ILS
INR
ISK
ITL
JMD
JOD
JPY

LBP
LUF
MXP
MYR
NLG
NOK
NZD
PHP
PKR
PLZ
PTE
ROL
RUR
SAR
SDD
SEK
SGD

Egypt, Pound

Spain, Peseta
European Economic and Monetary Union (EMU), Euro
Finland, Markka
Fiji, Dollar

France, Franc

Great Britain, Pound Sterling
Greece, Drachma
Hong Kong, Dollar
Hungary, Forint
Indonesia, Rupiah
Ireland (Eire), Punt
Israel, Shekel

India, Rupee
Iceland, Krona

Italy, Lira

Jamaica, Dollar
Jordan, Dinar
Japan, Yen

Korea (South), Won
Lebanon, Pound
Luxembourg, Franc
Mexico, Peso
Malaysia, Ringgit
Holland (The Netherlands), Guilder
Norway, Krone

New Zealand, Dollar
Philippines, Peso
Pakistan, Rupee
Poland, Zloty
Portugal, Escudo
Romania, Leu
Russia, Ruble

Saudi Arabia, Riyal
Sudan, Dollar
Sweden, Krona

Singapore, Dollar
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Currency Symbol

Currency Description

SKK

Slovakia, Koruna

THB Thailand, Baht
TRL Turkey, Lira
TTD Trinidad and Tobago, Dollar
TWD Taiwan, Dollar
USD United States of America, US Dollar
VEB Venezuela, Bolivar
XAG Silver, Ounces
XAU Gold, Ounces
XCD East Caribbean Dollar
XDR IMF Special Drawing Right
XPT Platinum, Ounces
ZAR South Africa, Rand
ZMK Zambia, Kwacha

Notes:

See also “Customer Profile Information” on page 29 and Multi-currency Support in

the Glossary.

EOCHRGE

Table A1.16 EOCHRGE

Attribute Actual Default

Name EOCHRG EOCHRG

Label Original Charge Original Charge

Length 8 8

Type numeric numeric

Format none none

By Variable no no
Description:

The Original Charge contains the charge (rate*quantity) specified in the Charge Item
Edit table for this record’s rate model and charge item. This charge is calculated when
the raw data is being processed (%CxPROCES) into SAS IT Resource Management and
SAS IT Charge Management.

Notes:

See also “Manage Charge Item Definitions” on page 33 and Multi-currency Support

in the Glossary.
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EOCITEM

Table A1.17 EOCITEM

Attribute Actual Default
Name EOCITEM EOCITEM
Label Charge Item Charge Item
Length 6 6
Type character character
Format $CIDESC $CIDESC
By Variable yes yes
Description:

Charge Items define billable resources and services to SAS IT Charge Management.
There are distributed Charge Items that are assigned 6-digit numbers for Charge
Items. Additionally, you can define your own charge items in the Charge Item
Properties of the SAS IT Charge Management Client. You can also associate the Charge
Items with Charge Item Groups. These groups are used to summarize the data for
reporting purposes only.

Notes:

See also “Charge Item Properties” on page 35 and the “SAS IT Charge Management
Formats” on page 101.

EOCQTY

Table A1.18 EOCQTY

Attribute Actual Default

Name E0CQTY E0CQTY

Label Charge Quantity Charge Quantity

Length 8 8

Type numeric numeric

Format none none

By Variable no no
Description:

Charge Quantity is the amount of the resource units or service units consumed. At
higher reduction levels, the summarization variable EOCQTY_S is available. Quantities
can only be summarized when they represent the same resource or service and the
same unit of measure.

Notes:

See also “Charge Item Properties” on page 35.
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EOCQTY_S

Table A1.19 EOCQTY_S

Attribute Actual Default

Name E0CQTY_S E0CQTY_S

Label Charge Quantity Charge Quantity

Length 8 8

Type numeric numeric

Format none none

By Variable no no
Description:

Charge Quantity is the amount of the resource units or service units consumed. At
higher reduction levels, the summarization variable EOCQTY_S is available. Quantities
can only be summarized when they represent the same resource or service and the

same unit of measure.

Notes:

(in higher reduction levels only)

See also “Charge Item Properties” on page 35.

EOCRATE

Table A1.20 EOCRATE

Attribute Actual Default

Name EOCRATE EOCRATE

Label Original Rate Original Rate

Length 8 8

Type numeric numeric

Format none none

By Variable no no
Description:

The Original Rate contains the rate specified in the Charge Item Edit table for this
record’s rate model and charge item. This rate is used when the raw data is being
processed (%CxPROCES) into SAS IT Resource Management and SAS IT Charge

Management.
Notes:

See also “Manage Charge Item Definitions” on page 33 and Multi-currency Support

in the Glossary.
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EOCTYPE

Table A1.21 EOCTYPE

Attribute Actual Default

Name EOCTYPE EOCTYPE

Label Charge Type Charge Type

Length 4 4

Type character character

Format $ectype $ectype

By Variable yes yes
Description:

Charge Items define billable resources and services to SAS IT Charge Management.
There are distributed Charge Items that are assigned 6-digit numbers for Charge
Items. Additionally you can define your own charge items in the Charge Item
Properties of the SAS IT Charge Management Client. You can also associate the Charge
Items with Charge Item Groups. These groups are used to summarize the data for
reporting purposes only.

Notes:

See also “Charge Item Properties” on page 35 and the “SAS IT Charge Management
Formats” on page 101.

EOCUSTn (where n=1 to 9)

Table A1.22 EOCUSTn (n=1 to 9)

Attribute Actual Default
Name EOCUSTn (n=1-9) EOCUSTn (n=1 - 9)
Label user-defined unknown
Length 1-70, user-defined 1
Type character character
Format user-defined none
By Variable yes yes
Description:

The Customer Name Key variables (referred to as "keys") are parts of the
summarization structure of SAS IT Charge Management PDB and Consolidated tables.
The attributes are defined in the Customer Name Key Structure in the SAS IT Charge
Management Client. You must define at least 1 key. The values of these variables are
populated in the customer identification routine. These keys are used to assign
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resources or services consumed to the consumer. The consumers are then mapped to a
billable entity using Customer Profiles.

The nine variables are used collectively as the primary component of the variable list
on the CLASS statement during table summarization. Each of these customer keys is a
separate and distinct variable in the table summarization key and helps to identify the
customer. You can customize the LENGTH and DESCRIPTION attributes of the
customer keys.

The DESCRIPTION (label) of each field can have a length of 1 to 40. All descriptions
are character strings. Leading and trailing blanks are removed. Embedded blanks are
preserved. Some special characters are not enabled. These special characters are
translated into different characters if you use them. A double quote (") is translated to
a single quote (’). An ampersand (&) is translated to a plus sign (+). A percent sign (%)
is translated to a forward slash (/). Any other special character is preserved.

Notes:

See also “Customer Name Key Structures” on page 25, “Customer Identification
Routine” on page 26, and “Customer Profile Information” on page 29.

EODAY

Table A1.23 EODAY

Attribute Actual Default

Name EODAY EODAY

Label Fiscal Day Fiscal Day

Length 8 8

Type numeric numeric

Format none none

By Variable yes yes
Description:

The Fiscal Day contains the day of the fiscal period. Based on the Accounting
Calendar and Invoice Schedule, the fiscal day is derived from DATETIME.

Notes:

See also “Accounting Calendar” on page 21, “Invoice Schedule” on page 22, and
“DATETIME” on page 125.

EOENDTM

Table A1.24 EOENDTM

Attribute Actual Default

Name EOENDTM EOENDTM
Label End Date and Time End Date and Time
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Attribute Actual Default

Length 8 8

Type numeric numeric

Format datetimel9 datetimel9

By Variable No No
Description:

The EOENDTM variable contains the end date and time for the activity on the data
record. This variable is assigned directly from the record in the SAS IT Resource
Management table being processed.

EOINVSD

Table A1.25 EOINVSD

Attribute Actual Default
Name EOINVSD EOINVSD
Label Start Date of Invoice Period Start Date of Invoice Period
Length 8 8
Type numeric numeric
Format date9 date9
By Variable yes yes
Description:

The EOINVSD variable contains the date and time the record was created. This
variable is created during processing of the SAS IT Resource Management table. It is
determined by the value of DATETIME, the DATECHK parameter and the Invoice
Schedule.

Notes:

See also “Invoice Schedule” on page 22, “Accounting Calendar” on page 21, the
“DATECHK Global Macro Variable” on page 68, and “DATETIME” on page 125.

EOMONTH

Table A1.26 EOMONTH

Attribute Actual Default
Name EOMONTH EOMONTH
Label Fiscal Month Fiscal Month
Length 8 8

Type numeric numeric
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Attribute Actual Default

Format none none

By Variable yes yes
Description:

The Fiscal Month contains the month of the fiscal period. Based on the Accounting
Calendar and Invoice Schedule, the fiscal month is derived from DATETIME.

Notes:

See also “Invoice Schedule” on page 22, “Accounting Calendar” on page 21, and
“DATETIME” on page 125.

EORMDL

Table A1.27 EORMDL

Attribute Actual Default

Name EORMDL EORMDL

Label Rate model Rate Model

Length 16 16

Type character character

Format $16 $16

By Variable yes yes
Description:

The Rate Model variable contains the rate model name (up to 8 characters)
concatenated with the effective date (8 characters) of the rate model. The name and
effective dates are specified in the Charge Item Edit window of the SAS IT Charge
Management Client. EORMDL indicates which rate structure was used to derive the
charges for the observation.

Notes:

See also “Manage Charge Item Definitions” on page 33 and “Define Rate Models,
Charges, and Assignments” on page 57.

EOSTRTM

Table A1.28 EOSTRTM

Attribute Actual Default
Name EOSTRTM EOSTRTM
Label Start Date and Time Start Date and Time

Length 8 8
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Attribute Actual Default

Type numeric numeric

Format datetimel9 datetimel9

By Variable No No
Description:

The EOSTRTM variable contains the start date and time for the activity on the data
record. This variable is assigned directly from the record in the SAS IT Resource
Management table being processed.

EOYEAR

Table A1.29 EOYEAR

Attribute Actual Default

Name EOYEAR EOYEAR

Label Fiscal Year Fiscal Year

Length 8 8

Type numeric numeric

Format none none

By Variable yes yes
Description:

The Fiscal Year contains the year of the fiscal period. Based on the Accounting
Calendar and Invoice Schedule, the fiscal year is derived from DATETIME.

Notes:

See also “Accounting Calendar” on page 21, “Invoice Schedule” on page 22, and

“DATETIME” on page 125.

E1CHRGE

Table A1.30 E1CHRGE

Attribute Actual Default

Name E1CHRG E1CHRG

Label Modified Charge Modified Charge
Length 8 8

Type numeric numeric
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Attribute Actual Default

Format none none

By Variable no no
Description:

The Modified Charge contains the charge specified or calculated in the Edit/
Apportion Charges action item for this record’s charge item. This charge is available
only on the consolidation files.

Notes:

See also “Edit Charges” on page 84 and Multi-currency Support in the Glossary.

E1CRATE

Table A1.31 E1CRATE

Attribute Actual Default

Name E1CRATE E1CRATE

Label Modified Rate Modified Rate

Length 8 8

Type numeric numeric

Format none none

By Variable yes yes
Description:

The Modified Rate contains the rate specified in the Edit/Apportion Charges action
item for this record’s charge item. This rate is available only on the consolidation files.

Notes:

See also “Edit Charges” on page 84 and Multi-currency Support in the Glossary.

E2CHRGE

Table A1.32 E2CHRGE

Attribute Actual Default

Name E2CHRG E2CHRG

Label Apportioned Charge Apportioned Charge
Length 8 8

Type numeric numeric
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Attribute Actual Default

Format none none

By Variable no no
Description:

The Apportioned Charge contains the charge specified or calculated in the Edit/
Apportion Charges action item for this record’s charge item. This charge is available
only on the consolidation files.

Notes:

See also “Edit Charges” on page 84 and Multi-currency Support in the Glossary.

E2CRATE

Table A1.33 E2CRATE

Attribute Actual Default

Name E2CRATE E2CRATE

Label Apportioned Rate Apportioned Rate

Length 8 8

Type numeric numeric

Format none none

By Variable yes yes
Description:

The Apportioned Rate contains the rate specified in the Edit/Apportion Charges
action item for this record’s charge item. This rate is available only on the consolidation

files.
Notes:

See also “Edit Charges” on page 84 and Multi-currency Support in the Glossary.

MACHINE

Table A1.34 MACHINE

Attribute Actual Default
Name MACHINE MACHINE
Label Machine Machine
Length 8 8

Type character character
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Attribute Actual Default

Format none none

By Variable yes yes
Description:

The MACHINE variable contains the value of the machine or system identifier that
created the data record processed. When z/OS is the platform generating the data, the
MACHINE variable usually contains the SMFID or system id.

SHIFT

Table A1.35 SHIFT

Attribute Actual Default

Name SHIFT SHIFT

Label Operations Shift Operations Shift

Length 1 1

Type character character

Format $SHIFT $SHIFT

By Variable yes yes
Description:

The SHIFT variable contains the value of the SHIFT or zone from the SAS IT
Resource Management data record processed. When z/OS is the platform generating
the data and MXG is being used, the shift definitions for populating the variable might
be in MXG.

SWIT

Table A1.36 SWIT

Attribute Actual Default
Name SWIT SWIT
Label Switch Switch
Length 1 1

Type Character Character
Format none none

By Variable No No

Description:
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The SWIT variable is initialized to a single blank. It is an internal switch for SAS IT
Charge Management. This variable is only on the EC_SC (debit and credit) file. Only
supplemental charges and imported charges are in this file.

Notes:

See also the topic on the Import Template in the section called “Import/Export” on
page 42.

PDB-unique Libraries

This table lists the PDB-unique Libraries. There is one set of these libraries for each
PDB in the SAS IT Charge Management Site.

Table A1.37 Table of PDB-unique Libraries

Libref/Fileref Catalog or File Name  Library Content

DETAIL Exxxxxx SAS IT Resource Management DETAIL reduction-level
(See Note 2) PDB tables for SAS IT Charge Management
MONTH Exxxxxx SAS IT Resource Management MONTH reduction-level
(See Note 2) PDB tables for SAS IT Charge Management
ECWORK SAS IT Charge Management detail data generated
(See Note 2) during %CxPROCES to be used as staged data for the

second %CxPROCES in the process and reduce task for
SAS IT Resource Management and SAS IT Charge

Management.
ECCNTL JCL and Jobstreams for PDB-unique jobs
ECPDB ECUSER catalog - User-modifiable SAS IT Charge Management
(See Note 1) parameters

- Generated SAS IT Charge Management source and
formats

EC_C1 data table Table of user-selected Charge Items in this PDB
(See Note 1)

Notes:
1 Populated during first definition of the PDB under SAS IT Charge Management.

2 Populated during the first and subsequent Collect runs (process and reduce tasks).

User-unique Libraries

This table lists the User-unique Level Libraries. There is one set of these libraries
for each user of SAS IT Charge Management.
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Table A1.38 Table of User-unique Level Libraries

Libref/Fileref Catalog or File Name Library Content

SASUSER CPUSROPT data table List of known PDBs (one observation per PDB).

Updated by SAS IT Resource Management. SAS IT
Charge Management only reads this file.
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Interface to GA-MICS: Overview

This section describes how to use process exits in creating SAS IT Resource
Management derived variables to emulate CA-MICS account codes.

SAS IT Resource Management provides the capability of deriving data element
values from other elements of raw input data and storing those derived elements in
stored data. This is particularly necessary for duplicating the structure of certain
CA-MICS database files with equivalent SAS IT Resource Management tables.

This appendix demonstrates the methodology for adding derived variables to SAS IT
Resource Management (formerly, IT Service Vision 2.1 and later), specifically applied to
defining CA-MICS-like "account code" class variables.

The three basic steps involved in creating derived variables are:

1 “Define the Variable(s) to the Data Dictionary” on page 143

2 “Convert Your CA-MICS” on page 145

3 “Run the %CPDDUTL Task” on page 146.

In the following example, we will add derived variables called ACCTNO1 and
ACCTNO2 to tables XJOBS and XSMFINT. These variables take the place of the
CA-MICS SMF account code data elements called ACCTNO1 and ACCTNO2.

0 Because CA-MICS can have up to nine account codes per cost center structure on
any CA-MICS component, you can define up to nine (any number, really) such
fields. Therefore, to mimic CA-MICS ACCTNO1-9, you can define ACCTNO1-9 to
SAS IT Resource Management.

0 Most CA-MICS Data Integration components have account code structures. These
CA-MICS components include TSO, CICS, IMS, IDMS, SNT, VMS, VMC, and so
on. It would be convenient to pick similarly structured names for the account code
data elements on the equivalent SAS IT Resource Management tables. Thus, the
CA-MICS data elements TSOACT1-9 would suggest adding variables TSOACT1-9
to the SAS IT Resource Management tables for user activity under CA-TSO/MON.

Define the Variable(s) to the Data Dictionary

The value for a derived variable is stored in the PDB just like the data for any other
(non-formula) variable. When you define a derived variable, you will need to follow the
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SAS IT Resource Management conventions for specifying variables. Like all other
variables, the derived variables need to be defined to the PDB once per table.

The following is an example of the %CPDDUTL control statements to define
ACCTNO1 and ACCTNO2 to the XJOBS and XSMFINT tables:

set table name=XJOBS ;
delete variable name=ACCTNOl noerror ; /* delete if exists */
delete variable name=ACCTNO2 noerror ; /* delete if exists */
CREATE DERIVED NAME= ACCTNOl LENGTH=36
LABEL ='Department’ DESCRIPTION='Department’
KEPT =YES INTERPRET=STRING TYPE=CHARACTER
SOURCE={ $%ACCTSMF; /* ONLY ONE MACRO CALL IS NEEDED */
}
7
CREATE DERIVED NAME= ACCTNO2 LENGTH=24
LABEL ='Division’ DESCRIPTION='Division’
KEPT =YES INTERPRET=STRING TYPE=CHARACTER
SOURCE={ /* MACRO CALLED ONLY ON FIRST ACCOUNT CODE VARIABLE */
}
7
UPDATE TABLE NAME= XJOBS
DETAIL=(BYVARS= ’ MACHINE ACCTNOl ACCTNO2 TYETASK RAFUSER DATETIME SHIFT' )

DAY =(CLASSVARS= ' MACHINE ACCTNOl ACCTNO2 TYETASK RAFUSER DATETIME SHIFT'
WEEK =(CLASSVARS= ' MACHINE ACCTNOl ACCTNO2 TYETASK RAFUSER DATETIME SHIFT'
MONTH =(CLASSVARS= ' MACHINE ACCTNOl ACCTNO2 TYETASK RAFUSER DATETIME SHIFT’
YEAR =(CLASSVARS= ' MACHINE ACCTNOl ACCTNOZ2 TYETASK RAFUSER DATETIME SHIFT’

i
set table name=XSMFINT ;
delete variable name=ACCTNOl noerror ; /* delete if exists */
delete variable name=ACCTNO2 noerror ; /* delete if exists */
CREATE DERIVED NAME= ACCTNOl LENGTH=36

LABEL ='Department’ DESCRIPTION='Department’

KEPT =YES INTERPRET=STRING TYPE=CHARACTER

SOURCE={ %ACCTSMF; /* ONLY ON FIRST ACCOUNT CODE VARIABLE */

}

i
CREATE DERIVED NAME= ACCTNO2 LENGTH=24
LABEL ='Division’ DESCRIPTION='Division’
KEPT =YES INTERPRET=STRING TYPE=CHARACTER
SOURCE={ /* MACRO CALLED ONLY ON FIRST ACCOUNT CODE VARIABLE */
}

r

UPDATE TABLE NAME= XSMFINT
DETAIL=(BYVARS= ’' MACHINE ACCTNOl ACCTNO2 TYETASK RAFUSER DATETIME SHIFT’' )

DAY =(CLASSVARS= ' MACHINE ACCTNOl ACCTNO2 TYETASK RAFUSER DATETIME SHIFT'
WEEK =(CLASSVARS= ' MACHINE ACCTNOl ACCTNO2 TYETASK RAFUSER DATETIME SHIFT’
MONTH =(CLASSVARS= ' MACHINE ACCTNOl ACCTNO2 TYETASK RAFUSER DATETIME SHIFT’
YEAR =(CLASSVARS= ' MACHINE ACCTNOl ACCTNOZ2 TYETASK RAFUSER DATETIME SHIFT'

In the above example, the macro %2ACCTSMF is called only once. This macro will be
created in Step 2. The #ACCTSMF macro populates all the account code data elements
as does its CA-MICS counterpart.

After the variable has been defined to the data dictionary, you are ready to create
and use your exit.

_—~ — — ~—

~ — — ~—
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Convert Your CA-MICS

This step shows how to convert your CA-MICS account code determination exit to a
macro suitable for calling by SAS IT Resource Management. When you create your exit,
use the original CA-MICS routine that assigns values to the CA-MICS account code
data elements as a starting point. An example with two variables, ACCNO1 and
ACCTNO02, is shown in Step 1 and throughout this appendix. Store a copy of this logic
in the SAS IT Resource Management autocall macros library, MACROS, in a member
whose name is the same as the name of the macro that is referenced in the CREATE
DERIVED... > SOURCE={>...} parameter.

When you use this macro to populate account code elements that are processed with
one or more other tables, bracket the logic with a macro conditional that resolves the
logic only for those tables into which the account code variables are to be put. Also,
change the code to populate the account code variables from SAS IT Resource
Management variables rather than CA-MICS data elements. This involves changing
the names of some data elements and changing the expected values of others.

For our example, let us assume that variables ACCTNO1 and ACCTNO2 were
populated as follows in CA-MICS:

IF PGMTYPE EQ 1 THEN DO; /* BATCH JOB DATA */
ACCTNO1=SUBSTR(JOB,1,3); /* FIRST 3 CHARS OF JOB NAME */
ACCTNO2=SUBSTR (JOBPRGNM, 1,5) ;

END;

ELSE IF PGMTYPE EQ 2 THEN DO; /* TSO SESSION */
ACCTNO1=SUBSTR (RACFUSID,1,3);

ACCTNO2=SUBSTR (RACFUSID, 4,2);
END;
ELSE IF PGMTYPE EQ 3 THEN DO; /* STARTED TASK */
IF PROGRAM EQ: 'DFH’ THEN ACCTNOl='ONL’;
ELSE ACCTNOl='OHD’;
ACCTNO2=' ’;
END;

To install the same logic in SAS IT Resource Management, put the code in a macro
named ACCTSMF, change the CA-MICS data element names to SAS IT Resource
Management equivalent variable names, and adjust the program logic to use the
different values for decision variables. The converted exit might resemble this code:

Example Code A2.1 Contents of macro ACCTSMF:

gmacro ACCTSMF;
$if &CPTABLE=%upcase(XJOBS) or

&CPTABLE=%upcase (XSMFINT) %then %do;

IF TYETASK EQ 'JOB’ THEN DO; /* BATCH JOB DATA */
ACCTNO1=SUBSTR(JOB,1,3); /* FIRST 3 CHARS OF JOB NAME */
ACCTNO2=SUBSTR(PGRNAME, 1,5);

END;

ELSE IF TYETASK EQ ’'TSU’ THEN DO; /* TSO SESSION */
ACCTNO1=SUBSTR (RAFUSER,1,3);

ACCTNO2=SUBSTR (RAFUSER,4,2);

END;

ELSE IF TYETASK EQ ’'STC’ THEN DO; /* STARTED TASK */
IF PROGRAM EQ: ’'DFH’ THEN ACCTNOl1='ONL’;

ELSE ACCTNOl1='OHD’;
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ACCTNO2=" ';
END;
%end;
¢mend ACCTSMF;

An alternative exists to aid the conversion of the routine to SAS IT Resource
Management variable names. If there is no overlap of variable names, it is possible to
create a set of temporary variables in the exit that mimic the CA-MICS working data
element names. If such temporary variables are assigned, it can be possible to include
the original CA-MICS derivation logic. Consider this example:

Example Code A2.2 Contents of macro ACCTSMF:

gmacro ACCTSMF;
$if &CPTABLE=%upcase(XJOBS) or
&CPTABLE=%upcase (XSMFINT) %then %do;
JOBPRGNM=PGRNAME ;
RACFUSID=RAFUSER;
SELECT TYETASK;
WHEN ('JOB’) PGMTYPE=1;
WHEN ('TSU’) PGMTYPE=2;
WHEN ('STC’) PGMTYPE=3;
OTHERWISE PGMTYPE=.;

END;

IF PGMTYPE EQ 1 THEN DO; /* BATCH JOB DATA */
ACCTNO1=SUBSTR(JOB,1,3); /* FIRST 3 CHARS OF JOB NAME */
ACCTNO2=SUBSTR(JOBPRGNM, 1,5);

END;

ELSE IF PGMTYPE EQ 2 THEN DO; /* TSO SESSION */
ACCTNO1=SUBSTR (RACFUSID,1,3);

ACCTNO2=SUBSTR (RACFUSID, 4,2);

END;

ELSE IF PGMTYPE EQ 3 THEN DO; /* STARTED TASK */
IF PROGRAM EQ: ’'DFH’ THEN ACCTNO1l='ONL’;

ELSE ACCTNO1l='OHD’;
ACCTNO2=' ';
END;
%end;
gmend ACCTSMF;

Run the %CPDDUTL Task

Submit the job created in Step 1. Check the output for errors and warning messages.
Investigate any anomalies.

Note: These notes should be used as part of a complete conversion plan. Be sure to
test thoroughly as many logic paths as possible during the parallel test period. A
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Glossary

accounting
the act or process of quantifying and measuring the usage of IT resources.

accounting calendar
a feature that defines a fiscal calendar to SAS IT Charge Management.

AccountView
an enterprise information system (EIS) application that is used for reporting on SAS
IT Charge Management data. After downloading the performance data from the SAS
IT Charge Management server, you can use AccountView to view or print the data.

apportioning
the act or process of distributing fixed costs or credits to several customers in order
to perform zero balancing. See also zero balancing.

billing hierarchy
the structure of an organization as it has been defined for the purpose of charging
organizational entities for the IT resources that they use. For example, a billing
hierarchy typically includes divisions, departments, and individual users.

charge consolidation
the process of merging all summarized charge data in a PDB with all supplemental
charges in order to produce a single consolidated file.

charge currency
the currency that has been specified for a particular rate model. In SAS IT Charge
Management files, the EOCCURR variable contains the charge currency.

charge data
data that is added to the SAS IT Resource Management tables by SAS IT Charge
Management software and which consists of measurements, charges, and customer
keys. Charge data is stored in the PDB reduction levels DETAIL, DAY, WEEK,
MONTH and YEAR. (SAS IT Charge Management creates a copy of all SAS IT
Resource Management tables that are used for charging. These copies have names
that begin with 'EC’.)

charge item
any IT resource whose costs can be charged to users of the resource. In SAS IT
Charge Management, each charge item is represented by a six-digit numeric code
and is mapped either to a SAS IT Resource Management variable or to a calculation
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that is based on one or more SAS IT Resource Management variables. In SAS IT
Charge Management files, the EOCITEM variable contains the charge item.

charge type
a two-byte field that signifies the SAS IT Charge Management record type of each
particular observation. Record types include debits, credits, shift charges, and budget
data. In SAS IT Charge Management files, the EOCTYPE variable contains the
charge type.

chargeback
the process of recovering IT costs by charging departments or other organizational
entities for the IT resources that they use.

chargeback data model
a visual representation of a company’s accounting goals and chargeback goals.

collector
software that produces logs of performance data. Collectors track information such
as system utilization, network utilization, resource utilization, and the utilization of
services such as phones, fax machines, and Web servers.

collector support
a set of software components that provide a variety of functions that enable SAS IT
Resource Management to work with data from a particular collector. Each
collector-support component is identified by both a collector name and a tool name.

collector support
a set of software components that provide a variety of functions that enable SAS IT
Resource Management to work with data from a particular collector. Each
collector-support component is identified by both a collector name and a tool name.

consolidation
See charge consolidation.

CPU normalization
the act or process of taking CPU usage values that have been collected on CPUs that
operate at different speeds and multiplying those values by normalization factors so
that the charges assessed for CPU usage are equitable no matter what type of CPU
is used. The normalization factors are based on comparisons to one particular type of
CPU that has been specified as the standard for a particular site. CPU normalization
is sometimes referred to as processor normalization.

CPUSROPT table
a table in the SASUSER library that contains the name and location of all PDBs at a
particular site that have been accessed by SAS IT Resource Management. The
SASUSER library is shared by the remote SAS session, SAS IT Resource
Management, and SAS IT Charge Management.

credit
a charge that does not originate from regular PDB process steps and reduce steps
and which enables you to change a processed charge (for example, to add a one-time
discount). A credit is a type of manual adjustment that is deducted from the total
amount due on an account.

customer identification routine
a customized, site-specific routine that populates the customer name key variables
(EOCUST1-E0CUST9) with the customer name keys.

customer name keys
values that associate resources with the consumers of those resources. SAS IT

Charge Management provides a maximum of nine customer name keys, which are
stored in the EOCUST1-EOCUST9 variables in the table summarization key.
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customer profile
See invoice profile.

data collector
software that collects logged data that is related to IT services. The data collector
could be a facility of the operating system, a product that is provided by a third-party
vendor, or software that is written by consultants or by SAS IT Resource
Management customers.

data dictionary
See master data dictionary, PDB’s data dictionary.

data model
See chargeback data model.

debit
a charge that does not originate from regular PDB process steps and reduce steps
and which enables you to change a processed charge (for example, to add a one-time
surcharge). A debit is sometimes called a supplemental charge.

default currency
the currency that is used in the initial displays of the SAS IT Charge Management
client windows. You use the Manage Site Defaults function in SAS IT Charge
Management to specify the default currency.

discount
a reduction that is applied to a charge during period-end processing. The reduction is
based on some predetermined condition.

fiscal calendar
an annual period of time for which an organization plans the use of its funds. The
fiscal calendar does not necessarily match the Gregorian calendar.

Gregorian calendar
the 12-month, 365-day (except in leap years) calendar that was introduced by Pope
Gregory XIII in 1582 as a revision of the Julian calendar. Today the Gregorian
calendar is used in most countries.

identification routine
See customer identification routine.

invoice profile
a set of attributes (such as mailing information, contact name, and billing status)
that define an organizational unit to which an invoice is sent.

invoice schedule
a schedule that specifies how often and on which dates SAS IT Charge Management
invoices are generated.

manual adjustments
debits and credits that are entered by the user from the Operations tab of the SAS IT
Charge Management system.

master data dictionary
the master definitions of tables and their associated variables, as well as override
control statements, if any. Master copies of user-written definitions can be installed
in the data dictionary, too.

minimum charge
a charge for a resource that overrides any smaller charge that is calculated by the
system. You can use the Charge Item Properties feature of SAS IT Charge
Management to specify a minimum charge.
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month end
the end of the month, at which time charges are manipulated and consolidated,
reports and invoices are generated and distributed, and all applicable external files
and inputs to the general ledger are generated.

multi-currency support
a feature that enables multiple currencies to be used when charges are applied to
resources and for reporting. Each rate model definition can have a different currency.
Each customer profile also has a currency associated with it.

PDB
See performance data warehouse.

PDB’s data dictionary
in a performance data warehouse (PDB), a SAS library whose name and libref are
DICTLIB. The library contains metadata such as definitions of tables and variables
and status information for the data that the tables contain.

performance data warehouse (PDB)
logically, a data warehouse that contains detailed and summarized performance data,
as well as information (metadata) that is needed for managing the data. Physically,
each PDB consists of a coordinated set of nine SAS libraries that contain
performance data plus other information that is related to one or more IT services.

period end
the end of an accounting period, at which time charges for the period are
manipulated and consolidated, reports and invoices are generated and distributed,
and all applicable external files and inputs to the general ledger are generated.

profile
See invoice profile.

profile currency
the currency whose exchange rates are to be used for the charges that are associated
with it. The profile currency is specified in the SAS IT Charge Management customer
profile.

proration
the act or process of distributing charges proportionally. Charges that cannot be
directly assigned to a particular customer are typically prorated among all customers.

rate model
a structure that identifies individual customers (or a group of customers) and which
associates the customer(s) with a specific set of billing rates.

shift charges
charges for IT resources that are specific to a particular work shift. Shift charges can
be used to encourage or discourage the consumption of IT resources. For example,
shift charges can be increased in order to discourage the use of IT resources during
time periods when these resources are typically in high demand.

site
a single-server installation of SAS IT Resource Management, whose data is used by
SAS IT Charge Management as input for charging fees for the use of IT services.

supplemental charges
See debit, credit.

surcharge
an additional charge (or penalty) that is based on some predetermined condition. In
SAS IT Charge Management, surcharges are issued during processing that occurs at
the end of a period (for example, at month end).
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unassigned charge
a charge that has not yet been assigned to a particular customer.

user
a person who works with SAS IT Charge Management software or with SAS IT
Charge Management AccountView software. Users might include SAS IT Charge
Management administrators, SAS IT Resource Management administrators, and
managers or financial analysts who use AccountView.

zero balancing
a chargeback methodology that distributes a predetermined IT expense on the basis
of actual resource consumption, ensuring that neither a profit nor a loss is achieved.
Zero balancing is typically used in an organization in which the IT division is not a
profit-making business unit. One way to zero balance is to apportion the costs. See
also apportioning.
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Accounting Calendar
AccountView, for Data Exploration
AccountView Data Extract Setup
AccountView Download
Activate Chargeback
ad hoc query and reporting
creating reports
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porter
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formats for SAS IT Charge Management |101
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batch reports @
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Simple Invoices
To-Date Reporting
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Common Prorate Charges
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consolidation file variables [120
consolidation of PDB data
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CPTABLE macro variable
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Currency Exchange
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managing
Customer Identification Routine
Customer Key Identification Routine
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Customer Name Key assignments
Customer Name Key Structures
customer profiles

creating budgets
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editing budgets
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updating, from new values of keys @
customization
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adding a call to

exit points
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daily processing
daily tasks, for SAS IT Charge Management Ad-
ministrator
data entry charges
data entry person E
Data Exploration @
AccountView
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Drilldown Report
Edit/Apportion Charges
execution options
data export exits
data import exits @
Data Suspend Administration
Data Suspend Processing
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DATECHK global macro variable
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Debits and Credits @
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Define PDB Default Adjustments
Define PDB Discounts, Surcharges, and Prorat-
ing
Define Rate Models, Charges, and Assign-
ments
defining new sites
demo of SAS IT Charge Management E
derived variables |[143
Detailed Status window
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device definitions
PDB-unique
devices, mapping to functional groups @
dialog boxes
discounts
one-time
PDB-unique shift discounts @
shift discounts
downloading AccountView
drilldown definitions, reflecting customer key

structure @

Drilldown Report

E
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EC_DFMT global macro variable
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ECEXIT1 exit
ECLIBMOD global macro variable
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EC_SC variables |119
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exit points (SAS IT Resource Management)
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Import Data
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Run Standard Invoices
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